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Introduction

Thank you for purchasing the Force. At Akai Professional, we know how serious music is to you. That’s why we design
our equipment with only one thing in mind—to make your performance the best it can be.

Support

For the latest information about this product (documentation, technical specifications, system requirements,
compatibility information, etc.) and product registration, visit akaipro.com.

For additional product support, visit akaipro.com/support.

About This User Guide

This manual should help you get familiar with using the Force. For consistency, the terminology throughout is based on
the Force parameter names. We also used specific formatting to indicate particular topics of significance:

Important/Note/Tip: Important or helpful information on a given topic.

Names of buttons, controls, parameters, settings, and other options are written in bold characters throughout the manual.
Examples: Press the Play button.
Turn Knob 4.
Tap the Mute icon.
The Velocity ranges from 0 to 127.
Set the Sample Play selector to One Shot.

Tap BPM, and then use the numeric keypad to enter a 120 as the tempo.

Some parts of this manual refer to other relevant chapters or sections, which are cited in bold, italic blue characters.
Click the text to skip immediately to that section.

Examples: Read the Important Notes section before proceeding.
For more information about launching clips, see Tutorial > Launching Clips.

To learn more about using send effects, see General Features > Effects > Send/Return Effects.

Important Notes

Read the included safety & warranty manual before using Force.

Before getting started and connecting devices to Force or turning the hardware on/off, make sure all devices are
switched off.


http://akaipro.com
http://akaipro.com/support

Here is just an example of how to use Force in your setup. ltems not listed under Introduction > Box Contents of your
included Quickstart Guide are sold separately.
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Remember to remove the protective film from the Force touchscreen!

Note: We highly recommend checking akaipro.com for any available updates to the Force firmware and/or drivers.
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This chapter explains the features and functions of your Force.
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Display: This full-color multi-touch display shows information relevant to Force’s current operation. Touch the display
(and use the hardware controls) to control the Force interface. See Display to learn how to use some basic functions.

Menu: Press this button to open the menu. You can tap an option on the menu screen to enter that mode, view, etc.
Master Volume: Turn this knob to adjust the volume level of the Master L/R outputs.

Play: Press this button to start transport playback.

Press Shift and this button to start transport playback from the current playhead position.

Stop: Press this button to stop transport playback. Double-press this button to immediately stop all sound.
Press Shift and this button to stop transport playback and return the playhead to the beginning.

Record: Press this button to start or stop clip recording.

Press and hold this button to view the Start Recording window.

Press Shift and this button to start or stop arrangement recording.

Undo: Press this button to undo your last action.

Press Shift and this button to redo the last action you undid.

Load: Press this button to open the Browser, where you can load projects, clips, and more.

Save: Press this button to open the Save window, where you can save your project, tracks, clips and more. See
Operation > General Features > Save Window for more information.

Matrix: Press this button to open Matrix Mode, an overview of your project with an 8x8 view of your clips.

. Clip: Press this button to open Clip View, which gives you finer detail of a single clip.

Tip: While in any of the pad
modes, you can press and
hold the button for another
Mixer: Press this button to open Mixer Mode, where you can control each track's mode to momentarily switch
volume, pan and send controls, as well as add plugin insert effects. to that mode. You will return
to the previous mode when
you release the button.

Press Shift and this button to open Track Edit Mode, where you can edit
parameters of your drum kit, plugin, MIDI or CV tracks.

When using a drum track, press Shift and this button to open Pad Mixer View,
where you can control each pad's volume, pan and send controls, as well as add
plugin insert effects.

Navigate: Press this button to open the Navigate mode, which gives you an overview of the entire project. Tap a
section to jump the Matrix view directly to that section, or use the cursors to move the Matrix view.

Press Shift and this button to open the XYFX mode.

Cursors: Press these buttons to move the Matrix view and the pads by one row or column at a time.
Press Shift and press these buttons to move by eight rows or columns at a time.

Shift: Press and hold this button to access secondary functions on some buttons and display modes.

Data Dial: Turn this dial to scroll through the available menu options or adjust the parameter values of the selected
field in the display. Pressing the dial also functions as an Enter button.

Press Shift and turn this dial to adjust parameters in finer detail.
—/+: Press these buttons to increase or decrease the value of the selected field in the display.

Assign A/Assign B: Press one of these buttons and a Track Assign button to assign the corresponding track to
the crossfader A or B grouping.

Press Shift and press one of these buttons to clear all crossfader A or B assignments.
Crossfader: Use this crossfader to mix between clips assigned to the A or B grouping.

Assignable Knobs: Use these knobs controls track panning, track send levels, or other user-assignable
parameters. Use the Knobs button to change the active knob bank or mode (described below). The display strip
above each knob indicates the parameter it is controlling and its current value or setting.

Knobs Button: Press this button to cycle between up to two banks of knobs for the currently active mode. The
display strip above the knobs will indicate the currently active parameters.

Press and hold this button to quickly select one of several preset knob control modes.

Press and hold the Edit button and then press this button to open Macros Mode, where you can edit macro control
assignments.

Clip Launch Pads: Use the velocity-sensitive pads in this 8x8 to launch clips, play notes, and more, depending on
the active mode.

Use the Edit Buttons in conjunction with the clip launch pads to select, edit, copy or delete pads.
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Scene Launch Buttons: Press one of these buttons to launch the corresponding scene, represented by the row of
clips to its left.

Press the Edit button and one of these buttons to quickly insert a new row, capture the currently playing clip(s) as a
new scene or clear a row.

Launch/Config: Press this button to set the Clip Launch Pads to Launch mode. In Launch mode, each pad
represents a single clip slot. The eight columns represent eight tracks while the eight rows represent eight scenes.
You can launch the entire scene by pressing the Scene Launch buttons to the right of the row of clips.

Press Shift and press this button to configure the Launch mode settings.

Note/Config: Press this button to set the Clip Launch Pads to Note mode. In Note mode, you can use the pads to
play a configurable scale of MIDI notes.

When in Note mode and using a Keygroup, Plugin, MIDI or CV track, press and hold this button to select different
play modes, such as scales, chords, progressions and more. When in Note mode and using a Drum track, press
and hold this button to select a time division for note repeat.

Press Shift and press this button to configure the Note mode settings, such as scale and root note. You can also
press and hold this button to quickly select a mode.

Step Seqg/Config: Press this button repeatedly to cycle through the different pad views for using the Step
Sequencer.

When in Step Sequencer mode, press and hold this button to quickly select a step sequencer view, select a Step
Sequence page, or change the step size.

Press Shift and press this button to configure the Step Sequencer's settings.
Edit Buttons: Press and hold one of these buttons to edit a clip or track according to the following:

¢ Select: Press and hold this button to view the currently select clip. While holding, tap another Clip Launch Pad
to select another clip. This button can also be used to select a drum pad in a drum kit or select a note in the
Step Sequencer without sounding the note.

¢ Edit: Press and hold this button then tap a Clip Launch Pad or Track Selector button to edit a clip or track,
respectively.

Hold this button and press any Scene Launch button to open the Edit Row window, where you can quickly add
or clear rows in the Matrix.

e Copy: Press and hold this button to copy a clip or track. While holding, tap the Clip Launch Pad or Track
Selector button of the clip or track you would like to copy, then tap a new pad or button to copy it.

¢ Delete: Press and hold this button then tap a Clip Launch Pad or Track Selector button to delete it.

Arp/Config: Press this button to enable or disable the internal Arpeggiator, whose rate is based on the current
Tempo and Time Division settings.

Press Shift and this button to configure the Arpeggiator's settings.
Tap Tempo: Tap this button at the desired rate to enter a new tempo.
Press Shift and this button to open the Tempo window, where you can enter a new tempo.

Track Selectors: Press one of these buttons to select a track, represented by the column of clips just above it. The
right-most button (labeled Master) selects the Master track.

Press and hold Shift and then press one of these buttons to select a Global Quantization setting: None, 8 Bars, 4
Bars, 2 Bars, 1 Bar, 1/4, 1/8, or 1/16.
Master: Press this button to view the Master and Return channels.
Assign Mode Buttons: Press one of these buttons to set the function of the Track Assign buttons when pressed:
e Mute: Press this button to mute the track. . .
_ Tip: Hold Shift and press Mute or
e Solo: Press this button to solo the track. Solo to open the Mixer Config
¢ Rec Arm: Press this button to record-arm the track. window, where you can set the solo
o Clip Stop: Press this button to stop the clip that is playing in the track. button/and crossfader behaviors.

Track Assign: Press one of these buttons to apply an assignment to a track, represented by the column of clips just
above it. Use the Assign Mode buttons to set the assign function.

Press and hold Shift and then press one of these buttons to access secondary functions, printed below the buttons.

Stop All Clips: Press this button to stop all clips when they reach the end.



Display

Here is some general information about how to use the Force display:

Tap a button or option to select it. Use the data dial or —/+ buttons to change its
setting or value.

In Matrix View, tap a filled clip slot to launch the clip.

Double-tap a control to access advanced editing options. In some cases, this will
show a numeric keypad that you can use to enter a value (an alternative to the data
dial or —/+ buttons). Tap the upper-left part of the display to return to the previous
view.

In Matrix View, double-tap an empty clip slot in your track to create a new clip.

Spread two fingers to zoom in (into a section of a waveform, for example). Pinch two

fingers to zoom out. S eow e //m e eom
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Power Input: Connect the included power adapter (19 V, 3.42 A, center-positive) to this jack then into an electrical
outlet.

Power Adapter Restraint: Secure the power adapter cable to this restraint to prevent it from accidentally
unplugging.
Power Switch: Press this button to turn Force’s power on or off.

Link: Connect a standard Ethernet cable to this port to use Ableton Link and other compatible devices with Force.
See Operation > General Features > Menu > Preferences > MIDI / Sync for more information.

USB-B Port: Use the included USB cable to connect this high-retention-force USB port to an available USB port on
your computer.

USB-A Ports: Connect USB flash drives to these USB ports to access their files directly using Force.

Input 1/2 (XLR or 1/4” / 6.35 mm): Use standard XLR or 1/4” (6.35 mm) TRS cables to connect these inputs to audio
sources (microphone, mixer, synthesizer, etc.). When using a 1/4" cable, the Mic preamp is removed from the
circuit, and the Line/Inst switch can be used to set the impedance.

Turn the Gain knobs to set the input level of each one.

Gain: Use these knobs to adjust the gain of the incoming signal from Input 1/2 on the rear panel. Be careful when
setting this knob at higher levels, which can cause the signal to distort.

Line/Inst: Use these switches to set Input 1/2 to accept either a Line-level or Instrument-level sound source when
using a 1/4" (6.35 mm) connection.

Phantom Power (+48V): This switch activates and deactivates phantom power for Inputs 1/2 when using an XLR
connection. When activated, +48V of phantom power will be supplied to both inputs. Note that most dynamic
microphones do not require phantom power, while most condenser microphones do. Refer to your microphone’s
documentation to check if it needs phantom power.

Outputs (1/4” / 6.35 mm): Use standard 1/4” (6.35 mm) TRS cables to connect these outputs to your monitors,
mixer, etc. The Master L/R outputs are the same as Outputs 1,2.

MIDI Out: Connect compatible 1/8" (3.5 mm) MIDI devices to this output, or use the included 1/8"-to-MIDI adapter
to connect a standard 5-pin MIDI cable from this output to the MIDI input of an external MIDI device (synthesizer,
drum machine, etc.).

MIDI In: Connect compatible 1/8" (3.5 mm) MIDI devices to this input, or use the included 1/8"-to-MIDI adapter to
connect a standard 5-pin MIDI cable from this input to the MIDI output of an external MIDI device (synthesizer, drum
machine, etc.).

MIDI Thru: Connect compatible 1/8" (3.5 mm) MIDI devices to this thru-port, or use the included 1/8"-to-MIDI
adapter to connect a standard 5-pin MIDI cable from this input to the MIDI output of an external MIDI device
(synthesizer, drum machine, etc.). Incoming MIDI from the MIDI In port will be passed along to this output.

CV/Gate Out: Use standard 1/8” (3.5 mm) TS cables to connect these outputs to optional modular devices. Force
will send control voltage (CV) and/or Gate data over this connection.

Kensington® Lock Slot: You can use this slot to secure your Force to a table or other surface.
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SD Card Slot: Insert a standard SD/SDHC card into this slot to access its files directly using Force.
Phones (1/4” / 6.35 mm): Connect standard 1/4” (6.35 mm) stereo headphones to this output.
Phones Volume: Turn this knob to adjust the volume of the phones output.

Cue Mix: Turn this knob to adjust the balance between the Master and 3/4 signals in your headphones. Master is
the signal sent from the Master outputs. 3/4 is the signal sent from the Outputs 3/4.



This chapter describes how to get started doing basic tasks using your Force. We'll use one of Force's included Demo
projects to illustrate some of the most important concepts and features. To get the most out of this chapter, we
recommend reproducing each of the described steps.

Starting Up

Make sure you have connected your Force hardware to a power source using the included power adapter and powered
it on.

When you first power on your Force, you can select a demo project to help get you started, select Empty Project at the
bottom of the screen to load a blank template, or select User Template to load a saved custom template.

For this tutorial, tap the Deep House - Colors Demo project to load it.

Launching Clips

"2 e 7 s
Top Loop Classic Bass SFX Drum Kit

S g

> Clip-DeepHouse...

1
Kick Loop

P> Keygroup 0011

> Clip-DeepHouse... | B IbizaHouse-Kit-... > Cllp-DeepHouse.. B Plugin001 1 ---

> Plugin001 1 > Clip-DeepHouse...

> Clip-DeepHouse... | B> IbizaHouse-Kit-... [l SMUTTE. TN
P Clip-DeepHouse... | P IbizaHouse-Kit-.. P Cllp-DeepHouse.. P Keygroup0011

> Clip-DeepHouse... | P> IbizaHouse-Kit-... > Cllp-DaspHouse.. B Plugln0011 P Keygroup 0011

> Clip-DeepHouse... | B> IbizaHouse-Kit-... > Cllp-DeepHouse.. B Plugin001 1
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After loading the demo, Force will automatically open Matrix Mode. This display mode gives you an overview of your
project and mirrors the 8x8 layout of the clip launch pads. Use the cursor buttons to move the current view of the
matrix by one row or column at a time.

Each column in Matrix Mode represents a frack. Tracks can be used to hold audio samples, drum kits, instrument
plugins and more. On the display, you will see tracks labeled Kick Loop, Top Loop, Fill and more.

Each track is made up of clips, which are short sequences of audio or MIDI. Only one clip in a track can play at a time.
Let's try playing with a few clips to see how they work.

Matrix Mode can also be configured to show the Arrangement row, which is used to trigger linear arrangements
recorded in Force's Arrange Mode. To show or hide the Arrangement row in the matrix, press and hold Shift and press
the Launch/Config button to open the Launch Configuration window, and then check or uncheck Show arrangement
in clip matrix. See Operation > Modes > Arrange Mode for more information about Arrange Mode.



Press the Launch button to make sure the clip launch pads are in Launch Mode. In this pad mode, each pad
represents a single clip in a track. The lighted pads represent the clips shown on the display, and the dim pads are
empty clips.
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Tap the first clip in Track 8 — Drum Kit to begin playing it. The clip launch pad will slowly blink green to indicate it is
active, and the clip on the display will show the position of the playhead in the clip.

Now, while in Launch mode, press the clip launch pad below the pad that is currently playing. The second clip will start
playing after the next bar.

See Operation > General Features > Pad Modes > Launch Mode to learn more.

Clips will continue to play until another clip in the same track is launched, until playback is stopped or until the clip is
stopped while playback continues.

To stop playback, press the Stop button.

To stop the clip, first press the Clip Stop button to assign the Track Assign buttons to stop mode. Then, press the
Track Assign button for the track with the clip playing. You can also press the Stop All Clips button to stop clips in
all tracks.



In addition to launching clips in a track, you can launch multiple clips across tracks in the same row. Each row of clips is
called a scene, and these can be used to arrange different parts of a song.

Press the top-most Scene Launch button to launch the first row of clips, and then continue launching other scenes in
order.

While one scene is playing, try launching clips from other rows to experiment with different variations.
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You can also assign Tracks to Force's crossfader. This allows you to seamlessly transition between clips from multiple
tracks.

1. Press and hold the Assign A button and press the Track Assign button for Track 1 — Kick Loop. The track name at
the top of the display will now show an A icon.

2. Next, press and hold the Assign B button and press the Track Assign button for Track 4 - Hat Fill. The track name
at the top of the display will show a B icon.

3. Launch the third scene and then use the crossfader to blend from one clip to the other by moving it from the A side
to the B side and back.

To clear crossfader assignments, hold Shift and press the Assign A or Assign B button.

To edit the slope profile of the crossfader, open the Mixer Config window by tapping Settings when viewing the
Mixer, or by holding Shift and pressing Mute or Solo. Select Linear, Exponential or Logarithmic.



Editing Clips & Tracks

Now that you are familiar with the basics of launching clips, let's explore some of the modes and menus that let you edit
clips and tracks for even more customization of your project.

In Grid Mode, you can view and edit note events and their parameters, such as length, velocity
and transposition, for MIDI tracks and audio samples and their parameters, such as length,
volume and tuning, in Audio tracks.

For MIDI clips such as those in drum, keygroup or plugin tracks, use the toolbar at the top of the
display to add, erase, or select notes and move around the grid, and use the Edit menu to further

. GRID
edit the MIDI note events.

For Audio clips, use the toolbar at the top of the display to select, move, erase, cut and mute
parts of the waveform below. This page also contains Force's powerful Warp tool, which can be
used to adjust the tempo of any sample to match your project's tempo without changing the
pitch.

In Clip Mode, you can view and edit the parameters of the clip container itself, such as its length,
launch mode and quantization. When using an audio clip, this view will show the waveform of the
sample. When using a MIDI clip, such as a drum kit clip or a plugin clip, this view will show either
all available pads in a vertical view with their corresponding data or a vertical “piano roll”
keyboard.

CLIP

Additionally, MIDI clips can be edited using List Edit Mode. This mode gives you many of the
same features as Grid Mode, but in a list workflow. You can use this view to filter your MIDI
events by a particular type, for instance, Aftertouch messages or Track Automation.

LIST EDIT

In Arrange Mode, you can record your clip performance to a linear timeline and use Force's

powerful Arrange Edit commands to shape your song. See Addenda > Updates in Force 3.0.5 >
New Features > Arrange Mode to learn more.

ARRANGE

Force's Track Edit Mode is used to edit the parameters of the track itself. This mode is not available
for audio tracks.

For drum tracks, you can edit the parameters of the four layers as well as all synthesis
parameters and insert effect settings.

EEEE B

For keygroup tracks, you can set the keygroup note ranges and edit the parameters of each
keygroup and set their note ranges. You can also edit all synthesis parameters and insert effect
settings.

For plugin tracks, you can parameters of the plugin using the graphic interface for built-in plugins,
or an overview of all plugin parameters with a slider for each for other plugins.

Each of these sections is explained in further detail below and in the Operation > Modes chapter.



Clip Mode

First, let's look at Clip Mode, where you can view and edit clip information and parameters.

To enter Clip Mode, do either of the following:
e Press Clip.
e Press Menu and then tap Clip.

In Clip Mode, you can view and edit the parameters of the clip container itself, such as length, launch mode, and
quantization. The appearance of Clip Mode depends on what kind of track the clip belongs to:

For audio tracks, the waveform of the audio clip is shown:

(0] Global Trigger

T tegar0

For drum tracks, the left column shows you all available pads in a
vertical view with their corresponding events in the grid to the right:

0  Global Trigger

T tegar0

For keygroup, plugin, MIDI and CV tracks, the left column shows a
vertical “piano roll” keyboard with the corresponding events in the
grid to the right:

Velocity

(0] 4 0. 0 Global Trigger

SETSTART TRIM CLIP LEGATO




Clip-DeepHouse-FX-reverse

TRK: Volume

0: 0 Global Trigger

TRIM CLIP LEGATO LooP

Let's edit one of the clips in our demo project:

1.
2.
3.
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Make sure the clip launch pads are in Launch Mode by pressing the Launch button.
Press and hold the Select button, then press the first clip launch pad for Track 7 = SFX.

Now, try making some of the edits to the clip described below. At any time, press Undo to revert to the previous
state.

To adjust the length of the clip, use the Start, Loop Start and Loop Length fields. Alternatively, use the Set
Start and Set End buttons during playback. The start or end point will be placed at the position of the playhead
when the button was pressed.

To adjust the launch quantization setting, tap the Launch Quantization field, and then use the data dial or
—-/+ buttons to set the timing of how the clip is launched. This can be set separately from the global launch
quantization. For instance, you may keep the global launch quantization at 1 Bar to keep longer clips in sync,
but set sound effects or other "one shots" to a smaller launch quantization, such as 1/8 Bar.

To change the clip launch behavior, tap the Launch Mode field, and then use the data dial or —/+ buttons to
change the mode. Select Toggle for the clip to start or stop with each successive press. Select Trigger for the
clip to start at the beginning with each press. Toggle is useful for clips of full phrases, whereas Trigger is useful
for one shot sound effects.

To adjust the timing correction, tap the TC button to open the Timing Correct window. This window contains
various settings to help quantize the events in your clip (learn about this feature in Operation > General
Features > Timing Correct (TC)).

To trim an audio clip, use the Loop Length field to set the preferred length, then tap Trim Clip to trim the
whole clip to this size.

To carry the playhead position from one clip to another in the same track, tap the Legato button. When
active, the playhead will continue from the same position as it was in the previous clip of the same track when
switching between clips. This is useful for creating seamless fills in drum breaks, working with an acapella track
or other scenarios where you would like a clip to play across multiple scenes.

To enable or disable clip looping, tap the Looping button. Clips like sound effects, drum hits and other "one
shots" should usually have Loop set to Off. For longer melodic or rhythmic phrases, set Loop to On.

To adjust the loop, hold Shift and tap the <<Loop or Loop>> buttons to shift the loop left or right, or hold Shift
and tap the /2 or 2X buttons to halve or double the loop size.



Grid Mode

In Grid Mode (formerly Region View for audio and Event View for MIDI), you can edit parameters of the audio clip itself,
such as length, levels, tuning and BPM.

TRK: Volume

Clip-DeepHouse-Drum-KickLp 01

0 0.00dB 0 0

DON'T SNAP NUDGE EDIT START EDIT END DUPLICATE

Let's start by making some edits to an audio clip using Grid Mode.

1.
2.
3.

Launch the first clip in Track 1 - Kick Loop.
Press Menu and tap Grid.

Now, try making some of the edits to the audio clip described below. At any time, press Undo to revert to the
previous state.

To select part of the clip, tap the select box icon in the upper-right corner, then tap and drag in the lower-half
of the waveform.

To move all or part of the clip, tap the pointer icon in the upper-right corner, and then tap and drag at the top
part of the waveform.

To shorten or lengthen a clip region (or multiple selected clip regions), tap the select box or pointer icons in
the upper-right corner, and then tap and drag the lower third of it left or right.

To split the clip into multiple parts, tap the scissors icon in the upper-right corner, and then tap anywhere in
the waveform.

To mute all or part of a clip, tap the speaker icon in the upper-right corner, and then tap in the waveform.
Alternatively, select the part of the waveform you want to mute, and then press the Mute button.

To scroll through or change the zoom level of the waveform, tap the magnifying glass icon. Then, tap and
drag to scroll through the waveform, pinch with two fingers to zoom out, or spread with two fingers to zoom in.

To change the level of the clip, tap the Level field, and then use the data dial or —/+ buttons.
To change the tuning of the clip, tap Semi or Fine, and then use the data dial or —/+ buttons.
To reverse the clip (or a section of it), tap the Reverse button.

To rename the clip, tap the keyboard icon under the waveform, then use the keyboard on the display to enter
a new name.
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In Grid Mode, you can also use Force's powerful warp tool to adjust the tempo of any sample to match your project's
tempo without changing the pitch.

To sync an audio clip to the project tempo:

1. Load the desired sample to an empty clip launch pad using the

Browser.
2. With the clip launch pad selected, open Grid Mode by pressing
Menu and tapping Grid. T T T W\“lfx,,, lk‘l‘“‘\._ bl il m‘“ﬁ‘h T T
PpPINg i ‘mwh‘" .wlulu" '.Il,ﬁ,ﬂ" i WIJVI" “lhhyﬂ" mlwh" ' ‘mmhv"' %NNIHr q
3. If your sample is already cut to a set number of bars and beats, ‘w‘l"m,,., Wilb'l"“ wh\‘l‘}!;,.,_, '.lj;“‘u}"’ w,, lkllﬂ"\‘”' il“‘[‘Pl‘h,; wmlw;h‘ “\;“"‘Jﬁ,ﬁ, ml‘l‘l‘u-{, %Nl‘li"“@,,, .j
. i I i Il i il o i i i I
you can continue to the next step. Ll il i L I Al | lll i L I
TRK: Volume L
If your sample is not already evenly cut, you can use the Edit [y
Start and Edit End tools to isolate the section of the sample you
would like to use. Alternatively, use the scissors icon to cut the 0 000d8 0 0 2
audio. conTsuap eomsmar

4. Tap the Warp button to enable warping of the sample. This will
allow you to lengthen or shorten the selected clip region to the
desired loop length without changing the sample pitch.

B eomeem

5. To adjust the BPM of the sample, tap the Detect button to open
the Edit BPM window. From here, you can set the BPM in one of
three ways:

i. Press Detect to have Force analyze the BPM for you.

i. Play the clip and use the Tap Tempo button to input the
BPM.

TAP TEMPO

iii. Enter the BPM manually if you know it.

6. As the BPM of the sample is changed, the number of bars and
beats it covers will also change.

See Operation > Modes > Grid Mode to learn more about this feature.
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Grid Mode will appear differently when using a clip with MIDI data on a Drum, Keygroup, Plugin, MIDI or CV track.

Velocity

DON'T SNAP m EDIT START EDIT END TRANSPOSE VELOCITY

Velocity

DON'T SNAP m EDIT START EDIT END TRANSPOSE VELOCITY

Event View for a drum track Event View for a keygroup, plugin, MIDI or CV track

Now let's make some edits to a MIDI clip using Grid Mode.

1. Launch the first clip in Track 2 - Top Loop.
Press Menu and tap Grid to open Grid Mode.

3. Now, try making some of the edits to note events described below. At any time, press Undo to revert to the
previous state.

To add a note, tap the Pencil icon in the upper-right corner of the display. Then, in the grid, tap a square.
To erase a note, tap the Eraser icon in the upper-right corner. Then, in the grid, tap a note.

To select a note, tap the select box in the upper-right corner. Then, in the grid, tap a note. You can also drag
your finger to select multiple notes.

To move the selected notes, tap Nudge at the bottom of the screen, and then use the data dial or —/+ buttons
to shift the notes left or right. By default, you can position notes only by quantization values defined by the Time
Correct value (learn about this feature in Operation > General Features > Timing Correct (TC)).

To adjust the start point or end point of the selected notes (without changing their position), tap Edit Start
or Edit End at the bottom of the screen, and then use the data dial or -/+ buttons.

To transpose the selected notes up or down, tap Transpose at the bottom of the screen, and then use the
data dial or —/+ buttons.

To adjust the velocity of the selected notes, tap Velocity at the bottom of the screen, and then use the data
dial or -=/+ buttons. The numeric value will appear on the screen.

To show the automation lane, tap the up arrow (A) button in the lower-right corner of the screen to show the
automation lane below the grid. By default, the Velocity parameter is shown, with each note’s velocity
represented by a vertical bar. The higher and more red the bar is, the higher the velocity is. Double-tap the
Velocity field to add a new automation parameter. See Addenda > Updates in Force 3.0.3 > New Features >
Grid/Automation Lanes for more information.

When the automation lane is expanded, the up arrow (A) button will turn into a down arrow (v) button, which
you can then tap to hide the automation lane.

See Operation > Modes > Grid Mode to learn more about this feature.

23



List Edit Mode

Channel Pressure
C2(48)
C4(72)
Bb4 (82)
001:01:72 C2(48)
C4(72)

Bba4 (82)

Ca(72)

Bbs (82)

INSERT DELETE

List Edit Mode is similar to Grid Mode for MIDI tracks, but uses a scrolling list workflow to display MIDI note event
parameters. This allows you to quickly filter your MIDI events by a particular type using the View menu or by the current
playhead position using the time counter at the top of the display. You can also insert, delete, play and nudge note
events using the buttons at the bottom of the display.

See Operation > Modes > List Edit Mode to learn more about this feature.

24



Track Edit Mode

In addition to editing MIDI note events using the clip edit modes, you can edit the parameters of a track using Track
Edit Mode. This mode is not available for audio tracks.

To enter the Track Edit Mode, do either of the following:

e Press Menu and then tap Track Edit.
e Hold Shift and press Clip.

Drum Kit

MASTER

-4.35dB

SIMULTANEQOUS
PLAY

Off

MUTE

THRGET Off Off Off Off

SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

Now, let's make some simple edits to the sounds in a drum track. Try making these edits while a clip is playing to hear
the difference.

1.
2.

2R

In Matrix Mode, press and hold the Track Select button for Track 8 — Drum Kit to select the track.

Press the Note button to set the clip launch pads to Note mode. The lower left quadrant will now show a typical
16-pad drum kit.

Press the kick drum pad (A01) to select it.
In the Master tab of Track Edit Mode, adjust the Volume knob up or down.
Press the snare drum pad (A02) to select it.

Tap and drag the Pan knob up or down to adjust the stereo panning. We recommend spreading the panning of the
bright sounds (e.g., cymbals, snare drum) a little.

Press the hi-hat pad (A03) to select it.
Tap the Samples tab so the first square under it is lit.

Use the Semi and Fine fields to adjust the tuning of the sample.
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You can also apply effects to a track with Track Edit mode. Let's try
adding an effect to the bass track.

1. While in Track Edit Mode, press and hold the Track Select button
for Track 6 — Classic Bass to select the track. 1 NOEFFECT

Classic Bass

INSERTS

2. Tap the Effects tab at the bottom of the screen to view the Insert [Py—
Effects tab.

Double-tap the first effect slot. A list of effects will appear.

3  NOEFFECT

Swipe up or down to move through the list. & NOEFFECT

5. To load an effect’ doub|e_tap it. A|terna‘tive|y, tap it once and MASTER SAMPLES PANVELOCITY FITER/ENY LFO MODULATION EFFECTS
then tap Select or push the data dial. Let’s try adding the AIR »
Enhancer @ Classic Bass PAD A0S

6. To close the list, tap Close. AR Chamelstrip

AIR Compressor

Now that the effect has been added to the bass track, you can
adjust its parameters to your liking.

AIR Delay

AIR Diff Delay

To adjust the effect's parameters, tap the pencil icon. AR Distorton

To adjust a parameter's value, tap and drag your finger on

a slider. Alternatively, tap the parameter and use the data AitErsemdte
dial or -/+ buttons.

AIR Filter Gate

MANUFACTURER

To empty the effect slot, tap the trash can icon. Switch the
effect on or off by tapping the On/Off button for the slot.

Classic Bass

INSERTS

1 AREnhancer[2in 2 out]
2 NOEFFECT

3 NOEFFECT

4  NOEFFECT

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION

< AIREnhancer [ ] Refresh Bass

12.0dB I

-4.4 dB I

ENHANCER
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Hype Chords

pe

Osc Mix: 50 % 0sc2: Smooth Supersaw

0 o

0sc1: Saw Sync Sub: 25 %

o L

Sync-F: 0% Bend Time: 1 ms

MACRO FILTER / AMP EFFECTS 1

When a Plugin track is selected, Track Edit Mode shows the parameters of the loaded plugin.

Press Matrix to enter Matrix Mode.

Launch the first clip in Track 5 — Hype Chords.
Enter Track Edit Mode.

o & 0~

view different sets of parameters.

QOoh Choir

distortion

EFFECTS 2

Press and hold the track selector button for Track 5 - Hype Chords.

w B

MODULATION

HYPE

DELAY
REVERB
COMPRESSOR
PUMPER

LIMITER

While the clip is playing, try making edits to the various plugin parameters. Use the tabs at the bottom of the page to
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After making changes to clips and tracks, you may want to do some renaming and save your project before going

further.

TRACK SETTINGS

Top Loop

MIDI Routing

All Ports

<none>

Drum Settings

To rename a track:

P oD

Press Matrix to enter Matrix mode.
Double-tap the track name at the top of the display.
Under Name, tap the keyboard icon.

Use the virtual keyboard that appears to enter a new name (e.g., Synth Lead), and then tap Do It.

CLIP SETTINGS

General Settings

IbizaHouse-Kit-Rocks 1

Cyan

Launch Settings

Global Trigger

To rename a clip:

1.

s
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Press Matrix to enter Matrix mode.
Hold Edit press a clip launch pad.
In the window that appears, tap the keyboard icon next to Name.

Use the virtual keyboard that appears to enter a new name (e.g., Drum Fill), and then tap Do It.



Now that we've made changes to our demo, this would be a good time to save as a new project. You can save your
project by doing either of the following:

e Press Menu to show the Menu, and tap the folder icon at the top of the screen to open the Project window. Then,
select Save As.

¢ Press Save to open the Save window. Then, select Save As.

< Save [Internal]/Force Documents/Projects i D O =3

B PROJECT

v Tracks i IbizaHouse-Kick-IH Kick 16 Internal
* Kick Loop IbizaHouse-Perc-IH Perc 15
i Top Loop i IbizaHouse-Perc-IH Perc 16
» Fill v IbizaHouse-Snare-IH Snare 08

» HatLoop it IbizaHouse-Synth-IH Synth C 22

« Hype Chords IbizaHouse-Synth-IH Synth C 23

W Classic Bass v IbizaHouse-Synth-IH Synth C 24

» SFX i+ IbizaHouse-Vocal-IH Vox 15 DeepHouse - Colors

B NEW B SAVEAS.. ilg PURGE ALS EXPORT B3 NEW FOLDER

In the Save screen, do any of the following:
To select the storage device you want to view, tap it in the Storage column on the left.
Internal is the internal drive of Force.
Force Documents is a shortcut to the Force Documents folder on the internal drive of Force.

If you have storage devices connected to the USB ports or SD card slot of Force, they will appear in this
column, as well.

To enter a folder, double-tap it. Alternatively, turn the data dial or use the —/+ buttons to move through the list, and
press the data dial to enter a folder. You can also tap one of the five folder buttons in the upper-right to jump
immediately to those pre-assigned file paths (see Operation > Modes > Browser to learn how to do this).

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do It.
You will immediately enter the new folder.

To move up one folder level, tap the folder/1 icon in the upper-left corner.
To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears.
To save the file, tap Save.

To cancel and return to the Menu, tap Cancel. Alternatively, tap the € icon in the upper-left corner.
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Using the Browser

Force's Browser is where you can browse and load clips, samples, instruments and more from Force's internal library,
as well as the library of any connected devices.

O~ Search

Search

vl Clip-BassHouse-Bass-BassLp 01.WAV

B FXRacks uli Clip-BassHouse-Bass-BassLp 02.WAV

Insert Effect Strips i Clip-BassHouse-Bass-BassLp 03.WAV

Live Recordings uin Clip-BassHouse-Bass-BassLp 04.WAV

Midi Learn uii Clip-BassHouse-Bass-BassLp 05.WAV

Plugin Presets #iv Clip-BassHouse-Bass-BassLp 06.WAV

Plugin Skins i Clip-BassHouse-Bass-BassLp 07.WAV

PREVIOUS PREVIOUS

To open the Browser, do either of the following:

Press Menu to show the Menu, and tap Browser.

Press Load.

Let's try creating a new drum track and loading samples to it.

1.
2.

11.

Press Matrix to open Matrix view.

Use the right cursor to scroll the Matrix view all the way to the right, until the last column shows a + sign above the
clips.

Tap the + symbol to open the Add Track window. Alternatively, you can press and hold the Track Selector button
under an unused track to open the Add Track window.

Select Drum to create a new drum track.
Set the pads to Note mode by pressing the Note button.

Tap a pad to select it. While in the Browser, the selected pad will be lit bright white. Since we are creating a drum
kit, start by tapping the bottom-left pad.

To search for drum samples, first open the Content tab, then select Samples.

Start by searching for a kick drum sound. Tap in the Search bar, then use the keyboard that appears to type "kick"
and tap Do It to perform the search. A list of all kick drum samples will now appear.

To load a sample, tap the Load button.

. You can browse and preview samples in two ways:

Turn the data dial to scroll through the list, and tap the Play button to preview the sample. You can enable auto-
preview by tapping the Speaker icon and tapping the Auto button so it is highlighted.

You can also quickly audition samples by using the Previous and Next buttons on the display, or the — and +
buttons on Force. When you move to a new sample, it will automatically be loaded to the selected pad. If you
decide to not use the sample, the old sample will automatically be deleted when a new one is loaded to the same
pad.

Repeat this process to add a snare, hi-hat or anything else you can think of to your drum kit.

You can use this same general process for browsing and loading other files such as audio or MIDI clips, instruments,
kits and projects.
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Mixing Tracks

Force's mixer allows you to adjust parameters such as level, stereo panning and routing the same way you would with a
traditional mixer or digital audio workstation.

To open the Mixer, press Mixer. Alternatively, press Menu and tap Mixer.

w1 "2 We »7 HE:]
Kick Loop Top Loop Classic Bass SFX Drum Kit

VOLUME PAN & VOLUME EFFECTS B SETTINGS

The Mixer contains four tabs of pages that let you control different settings for the tracks and master. Tap and drag your
finger to scroll through available tracks, or use the cursor buttons.

Let's start with the Pan & Volume tab. Tap the tab at the bottom of
the display to select it. Launch a scene in your project and try making
a few of the following adjustments to the tracks:

To adjust the track volume, tap and drag your finger on the
volume slider, or tap it and then use the data dial or
-/+ buttons.

To adjust the track panning, tap and drag your finger on the Pan
slider, or tap it and then use the data dial or -/+ buttons.

To mute or solo the track, tap the M or S buttons, respectively.

1B SETTINGS

To give a track a crossfader assignment, tap the A or B buttons
at the bottom of the display.
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Next, tap the Effects tab. Let's try adding an insert effect to a track:

1. Tap the Inserts button in Track 4 - Hat Loop to open the Inserts
window. Empty insert slots below this button are marked with a +
sign.

2. Double-tap the first effect slot. A list of effects will appear.
Swipe up or down to move through the list, or turn the data dial.

4. To load an effect, double-tap it. Alternatively, tap it once and
then tap Select or push the data dial. Let’s add the Reverb Small
effect.

VOLUME PAN & VOLUME EFFECTS B SETTINGS

To close the list, tap Close.

6. Now that the effect has been added to the track, you can adjust

X < :jlﬂ;tLoup
the settings to your preference.

INSERTS

To adjust the effect’s parameters, tap the pencil icon.

1 Reverb Small [2in 2 out]

To empty the effect slot, tap the trash can icon. Switch the
effect on or off by tapping the On/Off button for the slot. NO EFFECT

NO EFFECT

See Operation > Modes > Mixer to learn more about this feature.

NO EFFECT

Reverb Small L] Small Reverb

re) (o)

20
DRY / WET DIFFUSE

(o)

50
PRE-DELAY

(o).

50
EARLY REF

REVERB SMALL
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Cueing Tracks

In addition to using the Solo button to isolate a track, you can use it to cue tracks. This allows you to preview the sound
of a track using the Phones output or Outputs 3/4 before sending it to the main mix for your audience to hear.

To cue tracks:

1. Connect headphones to the Phones output, or connect Outputs
3/4 to your monitors, mixer, etc. HER CONFE

SOLO Button Behavior

2. Open the Mixer Config window, either by pressing Settings while
viewing the Mixer, or by holding Shift and pressing Solo or Mute. Cue Tracks

Crossfader

Set the Solo Button Behavior to Cue Tracks.

Adjust the Cue Mix knob so that it is between 3/4 and Master.
You can adjust the exact mix to your preference. Turn the Cue
Mix knob toward 3/4 for more of the cued track audio, or more i Rz A Ty
toward Master for more of the master mix audio.

Linear

MIDI Track Input Metering

Press the Solo button.

6. Press the Track Assign button for the track you would like to
assign to the cue mix.

When viewing certain pages of the Mixer, the S icon in the
channel strip will become a Headphones icon that is highlighted
when enabled.

When viewing the Matrix, a Headphones icon will be added to the
track heading.

7. Launch a clip in the track you have cued. You should hear both
the master mix and the audio of the cued track.

8. Using headphones attached to the Phones Output on Force's
front panel, and/or speakers connected to Outputs 3/4, listen to
the cued audio to make sure it is in sync with your main mix.

9. When you are ready to send the track audio to the main mix,
press the Solo button and the Track Assign button for the track
to disable cueing.
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Recording Clips

Now that you're more familiar with the basics of clip launching and editing, let's try recording new clips to add to the
project.

Before recording, let's create a new scene and an empty clip to

record into: EDIT ROW

1. Press Matrix to open Matrix Mode on the display. +

=
S,

r=n
i,

=

SO,
L - - -

2. Hold Edit and press the top Scene Launch button (below the
Arrange scene launch) to open the Edit Row window.

Insert8 Insert & Capture Clear
3. Tap the Insert icon. A new row will be created at the top of the
Matrix.

4. On the display, double-tap an empty clip slot in your new scene to [ =
create a new clip. New clips are always created at the default
length, which can be set by holding Shift and pressing the second
Track Assign button.

2

Alternatively, you can create an empty clip using the clip launch
pads. First, press the Launch button to enter Launch mode.
Then, hold the Select button and double-tap an empty pad.

Recording with Note Mode

In addition to using the clip launch pads for launching clips, you can use them to record notes chromatically as you
would use a MIDI keyboard. This is enabled by pressing the Note button to enter Note Mode.

In the Deep House - Colors project, select Track 6 — Classic Bass and press Note to view Note Mode in action. In
Note Mode, the appearance of the pads will change. The root note or chord will be lit in one color, and the notes or
chords in between will be lit white.

e e e e e e e e
o JL__JL__JL_JL__J_J__JL_J
— e e ———
o JL__JL_JL_JL__J_JL__JL__J
— e e e —— ———
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To configure the pads in Note Mode, hold Shift and press Note to
open the Note Config window. In this window, you can set the
function of the pads, from playing notes in a scale to playing full chord
progressions. For now, let's leave Type set to Scales and set Pad
Rows to Start on root.

See Operation > General Features > Pad Modes > Note Mode to
learn more.

Now, let's prepare the clip and track for recording:

1.

Create an empty clip in Track 6 - Classic Bass following the
directions above.

Launch the clip to make sure it is playing.

Press the Rec Arm button, then press the sixth Track Select
button to record enable the track. A record symbol will appear
under the track name.

Finally, when you are ready to record, press the Rec button. On
the display, the selected clip will turn red and show Overdub.

Try recording a simple bassline using the clip launch pads in Note
mode. Press Undo at any time to undo any recorded note events.

You have finished recording, press the Rec button again to stop
recording.

You can also change the recording configurations to suit your
preferences.

1.
2.

Press Matrix to open Matrix Mode on the display.

Press and hold Record, and in the window that appears, tap
Settings to open the Record Configuration window. Alternatively,
hold Edit and press Record.

Check the Write automation when recording box to capture
automation while recording.

Use the Record Launch field to set how recording is initiated.
When set to Pad, tap any pad while the track is armed to begin
recording. When set to REC Button or Pad, tap any pad while the
track is armed to begin recording, or press the Record button to
begin recording on the highlighted clip slot. When set to REC
Button then Pad, first press the record button, then tap any pad
to begin recording. This is the default mode when Force is
powered on.

Use the Clip Record To field to set the behavior when recording
is completed, entering either Overdub or Play.

Use the Record Arm field to set whether the Track Assign buttons
can be used to arm a Single track at a time, or Multiple tracks.

Check the Fixed Length Recording box to stop recording after
the clip length set in the Fixed Length (Bars) field. Leave
unchecked to record for any desired clip length.

When you are finished, tap Close to close the Record
Configuration window.

NOTE CONFIG

Chromatic

RECORD CONFIG

Automation

Recording

REC Button then Pad Overdub

Single
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Recording with the Step Sequencer

When sequencing drums, you can use Force's built-in Step Sequencer to quickly enter note events by using the clip
launch pads as "step buttons," simulating the experience of a traditional step-sequencer-style drum machine.

When using the Step Sequencer, you can assign the clip launch pads to a number of different modes depending on the
type of track. These include:

Drum: In this mode, the top four rows of pads represent each
step in the clip. The bottom four rows of pads are split into two
4x4 quadrants: the left quadrant is used for selecting and
triggering drum sounds, while the right quadrant is used to select
the velocity of the note events. This mode is most useful for
recording drum parts with the step sequencer.

Melodic: In this mode, the top four rows of pads represent each
step in the clip. The bottom four rows of pads are notes in the set
scale, which can be adjusted by holding Shift and pressing Step
Seq. This mode is most useful for recording melodic parts such as
a bassline with the step sequencer.

Lanes: In this mode, each column of clip launch pads represents
a step in the clip. The eight rows represent eight different pads.
You can set the base pad by holding Shift and pressing Step
Seq.
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See Operation > General Features > Pad Modes > Step Sequencer to learn more about the other Step Sequencer
pad modes.

To cycle between these modes, press the Step Seq button. You can also press and hold the Step Seq button while in
any Step Sequence mode to quickly select another mode.
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Top Loop

A01

1 Velocity

Let's use the Drum mode to sequence a drum pattern using the Step Sequencer.

Select Track 2 - Top Loop and add a new empty clip as described above.

Make sure the clip you are recording into is playing, otherwise you won't hear the pattern you are creating.
Press Menu and then tap Step Sequencer on the display.

Press the Step Seq button until Drum is shown on the display. The pads will now be in Drum mode.

o 0D~

Select the bass drum sound by pressing its pad (A01).
Tip: Press and hold the Clip Select button and then press a pad to select it without sounding the sample.
6. Use the top four rows of clip launch pads to sequence a simple bass drum pattern.

You can also change portion of the clip you are viewing and editing by pressing and holding the Step Seq button
and using the top row(s) of clip launch pads. The number of pages available depends on the selected step size and
the number of bars in the clip.

Next, select a snare drum sound (A02) and sequence a pattern.

8. Finally, select a hi-hat sound (A03) and sequence a pattern. Try using the velocity pads to vary the velocity of the hi-
hat sounds to make the clip sound more realistic.

See Operation > General Features > Pad Modes > Step Sequencer and Operation > Modes > Step Sequencer to
learn more about this feature.
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Operation

This chapter explains the complete features and functions of your Force hardware.

Important:

General Features

When the left-most button at the bottom of the screen shows an upward arrow (#), it means there are
additional buttons you can use when you press and hold Shift. Press and hold Shift to show the
secondary buttons, and any of them, if desired. Release Shift to return to the previous buttons.

Many modes shown on the screen have 1-6 buttons at the bottom. Each of these buttons select a
different tab in that mode or perform a specific function in that mode.

As an alternative to double-tapping an item on the screen to “enter” it, you can press the data dial.

When a parameter is highlighted and has a red outline, this means that it is selected. You can then
change it by turning the hardware’s data dial or using the —/+ buttons. If the parameter is a number,
double-tap it to show a numeric keypad on the screen to enter a specific value.

Control Types

The Force touchscreen uses the following types of control elements:

Knobs

To set the value for a knob, do any of the following:

38

e Tap and drag the knob up or down.

o Tap the knob to select it, and then use the data dial or —/+ buttons to
adjust the value.

e Double-tap the knob to show it in a larger screen. Alternatively, press
data dial when the knob is selected.

Tap and drag the larger version that appears, or use the data dial or
—/+ buttons to adjust the value.

Drum Kit
If the knob is bipolar (has positive and negative values with the center
as the default position), double-tap the larger version to reset it to the
center/0 position.

-3.63dB -10.85dB

Tap anywhere else to return to the previous screen.

e Press and hold Shift while turning the data dial to adjust a value by
smaller increments.




Parameter Values

To set the value for a parameter, do either of the following:

Tap the field to select it, and then use the data dial or —/+ buttons to
adjust the value.

When the value has decimal places, you can sometimes press and hold
Shift and then use the data dial or —/+ buttons to adjust the value by
smaller increments.

Double-tap the field or hold your finger on it for a second. In the
screen that appears, type in a value using the number pad, or use the
data dial or the —/+ buttons to adjust the value. Alternatively, tap and
drag the value up or down.

You can also tap /2 to halve the value or x2 to double it.
To confirm the value and remain on this screen, tap Apply.
To confirm the value and return to the previous screen, tap Do It.

To return to the previous screen, tap the gray area in the upper-
left corner of the screen. Unsaved changes made using the number
pad will not be applied. All other changes will be saved.

Drop-Down Menus / Lists

To select an option for a drop-down menu, do any of the following:

FILTER
ENVELOPE

[ aHDs O

AMP
ENVELOPE

gx 11

297036

124.00

Tap the field to select it, and then use the data dial or —=/+ buttons to select an option.

Double-tap the field. In the list that appears (examples below), tap the desired option. Alternatively, use the data

dial or the =/+ buttons to select an option.

In some windows, tap the relevant button at the bottom of the screen to confirm your selection or to cancel

without changing anything.

INSERTS
Start on root

Gypsy

2  ReverbSmall [2in 2 out]

3 NOEFFECT

SCALE
4  NOEFFECT
Aeolian

Locrian

Blues
& Drum Kit PAD AO3

Flamenco
LP Filter Sweep

Gypsy LP Filter Sync

LP Filter

Hungarian Gypsy
LP Shelving Filter

1 Compressor Vintage [2in 2 out]

Persian MPC  2in2out

) MPC60
Major Bebop
Mother Ducker Input
Whole Tone Mother Ducker
PEQ 2-Band, 2-Shelf

MANUFACTURER
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Selectors

Selectors show all available options. One of them is always selected. The
selected option is highlighted while the others are dark.

To select an option, tap it.

Buttons

Buttons usually have two states: selected and deselected (active or inactive,
respectively). Some may have more than two states.

To switch between or cycle through a button’s states, do either of the
following:

e Tapit.
e If it is outlined in red (and is not a mute button), use the data dial or
—/+ buttons.
Checkboxes

Checkboxes have two states: checked and unchecked (enabled or disabled,
respectively).

To check or uncheck a checkbox, tap it.

Tabs

Some modes have buttons at the bottom of the screen that let you cycle
through several similar tabs. For instance, you could view the send level that -
is routed to each of four returns—each level is shown on a separate tab. With

each tap, you will move to the next tab, indicated by the squares below it. CHoP

To select a tab, tap it. Each time you tap it, it will select the next tab.

SAMPLES
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Sliders
To adjust the position of a slider, do any of the following:
e Tap and drag the slider to the desired position.
e Tap the desired position (this works only on some sliders).

e Tap the slider to select it, and then use the data dial or —/+ buttons
to adjust the position (this works only on some sliders).

e Double-tap the slider, and then tap and drag the larger version that
appears, or use the data dial or —/+ buttons to adjust the value. Tap
anywhere else to return to the previous screen.

Envelopes
To set the stages of an envelope, do either of the following:
Tip: Tap the expand-rectangle icon above the envelope to show a close-up view.
e Tap and drag a “handle” of an envelope stage in the desired direction. D

e Set the numeric value of an envelope stage by adjusting or entering it as a parameter value (described
earlier).

Drum Kit

FILTER

Low2 ~

MODULATION
SOURCES

FILTER
ENVELOPE DECAY FROM

AMP
ENVELOPE

125 127 34

SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

The Filter/Envelope tab in Track Edit Mode.

& FILTER ENVELOPE ‘ & AMPENVELOPE

Close-up of an AD-type filter envelope. Close-up of an AHDS-type amp envelope.
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Grid Mode Tools

When viewing a MIDI clip in Grid Mode, these four icons enable you to use different functions in the grid.

Tap one to select its mode:

Pencil: Draw Mode:
% To enter a note in an empty grid square, tap the grid square.
To select a note, tap it.
To move a note, tap and drag it to another grid square.
To erase a note, double-tap it.

To edit velocity or draw automation, open the velocity/automation lane and tap and drag.

Eraser: Erase Mode:

To erase a note, tap it. You can also tag and drag to erase multiple notes in the same row.

Select Box: Select Mode:

Note: Notes will remain selected if you switch to another mode. The selection will change, however, if you
press a pad while Hitting Pad Selects All Events is set to On.

To select a note, tap it.

To select multiple notes, tap and drag across the grid to create a box around them.
To move a note, tap and drag it to another grid square.

To move multiple notes, select them as described above, and tap and drag them.

To erase multiple notes, select them as described above, and then select the eraser tool and tap any of
the selected notes.

Magnifying Glass: Navigation Mode:
®\ To move to another part of the grid, tap and drag it.

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically,
horizontally, or both at the same time.
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When viewing an audio clip in Grid Mode, these seven tool icons enable you to use different functions in the waveform.

%

Tap one to select its mode:

Marquee: Marquee Mode:
To select a track region, tap the upper third of it.

To select multiple track regions, tap and drag across the grid to create a box that highlights them.

To move a track region (or multiple selected track regions), tap and drag the upper third of it left or right.

To split the track at two specific points (creating a track region on either side and between them), tap and
drag across the middle third of it to create a translucent white box, and then tap the upper third of that box.

To shorten or lengthen a track region (or multiple selected track regions), tap and drag the lower third of it
left or right.

Arrow: Selection Mode:

To select a track region, tap it.

To move a track region (or multiple selected track regions), tap and drag the upper third of it left or right.

To shorten or lengthen a track region (or multiple selected track regions), tap and drag the lower third of it
left or right.

Pencil: Draw Mode:

To draw automation, open the velocity/automation lane and tap and drag.

Eraser: Erase Mode:

To erase a track region (or multiple selected track regions), tap it.

Scissors: Split Mode:

N To split the track at a specific point (creating a track region on either side), tap that point in the track.

To select a track region, tap its left-most edge.

Mute: Mute Mode:

To mute or unmute a track region (or multiple selected track regions), tap it.

Magnifying Glass: Navigation Mode:

To move to another part of the track, tap and drag it.

*

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically,
horizontally, or both at the same time.
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Pad Modes

In addition to the various control functions used in the display, Force features three different control modes for the 8x8
grid of clip launch pads: Launch Mode, Note Mode, and Step Sequencer Mode. You can also control Launch and
Note Modes at the same time using Launch & Note Mode.

These modes are accessed by pressing their respective Launch/Config, Note/Config, and Step Seq/Config buttons
on the Force hardware. At any time, you can also temporarily view any of the pad modes by pressing and holding the
Launch, Note, or Step Seq buttons. This allows you to quickly make changes such as launching a different clip or
editing the step sequencer.

Launch Mode

Launch Mode is used for launching and working with clips. The image = I I | IC__
to the right shows the pads in Launch Mode. The brightly lit pads each (| I I [ [
represent clips in the respective track columns. ﬂ I I I I I I I
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To enter Launch Mode, press the Launch button. In Launch Mode
you can do any of the following:

To launch a clip, press the clip launch pad.

To select a clip, hold Select and press a pad.
To create a new clip, hold Select and double-press an empty pad.

To copy a clip, hold Copy and press the pad you want to copy. Keep holding Copy and press the pad where you
want to copy the clip.

To delete a clip, hold Delete and press the pad you want to delete.

To set the quantization of launching clips, hold Shift and press one of the Track Select buttons. The time
division values are printed beneath them.

Launch Configuration

Press and hold Shift and press the Launch/Config button to open the
Launch Configuration window.

Use the Default Length (Bars) field to set the default length of
new clips in bars.

LAUNCH CONFIG

Use the Empty Slots field to set the appearance of the clip
launch pads that do not have a clip loaded.

Check Tapping a clip selects it to automatically select a clip for
editing when tapped. When unchecked, tapping a clip will only
launch it.

Check Show arrangement in clip matrix to enable the
Arrangement row at the top of the clip matrix.
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Note Mode

Note Mode is used for playing drum kits or melodic tracks like keygroups or plugins.

To enter Note Mode, press the Note button while a drum, keygroup, plugin, MIDI or CV track is selected. The
appearance of the clip launch pads will change depending on the type of track selected. When a drum track is selected,

the clip launch pads will appear in Drum Note Mode; when a keygroup, plugin, MIDI or CV track is selected, the clip
launch pads will appear in Melodic Note Mode.

Drum Note Mode

In Drum Note Mode, each quadrant of clip launch pads can be used
like a traditional 4x4 drum pad layout to play samples. The image to [
the right shows a traditional layout when using Drum Note Mode.

In Drum Note Mode, you can do the following:

To play a sample, press any of the lit clip launch pads.

To change pad banks, hold Shift and press the Track Assign
buttons labeled Oct- and Oct+.

To select a pad, hold Select and press it.
To edit a sample in Track Edit Mode, hold Edit and press a pad.

To create a keygroup from a sample, hold Shift+Edit and press
a pad. The keygroup will be created on a new track automatically.

To copy a sample, hold Copy and press the pad you want to
copy. Keep holding Copy and press the pad where you want to
copy the sample.

To delete a pad, hold Delete and press the pad you want to
delete.

To mute a pad, hold Mute and press the pad you want to mute.
To solo a pad, hold Solo and press the pad you want to solo.

To set the quantization of launching clips, hold Shift and press
one of the Track Select buttons. The time division values are
printed beneath them.

Drum Note Configuration

Press and hold Shift and press the Note/Config button to open the
Drum Note Configuration window, where you can adjust the settings
of the drum pads.

NOTE CONFIG

Use the Velocity field to set the velocity level of the drum pads.
Select As Played for responsive velocities, or select Half level or As played
Full level for fixed level velocities.

Use the Bank field to select the drum bank currently in view in the
bottom left quadrant.
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16 Levels Drum Note Mode

In 16 Levels Drum Note Mode, the bottom-left quadrant of clip launch
pads can be used like a traditional 4x4 drum pad layout just like Drum
Note Mode. The other three quadrants, however, can be set to control
a selectable parameter that is fixed at values that increase as the pad
numbers increase (e.g., Pad 1 is the minimum, Pad 16 is the
maximum), regardless of how hard you press them.

To enter 16 Level mode, select a drum track and press Note
until 16 Level appears on the screen.

16 Level Drum Note Configuration

While in 16 level mode, press and hold Shift and press the
Note/Config button to open the Drum Note Configuration window.
In addition to the standard Drum Note Configuration settings
mentioned above, you can use this to adjust what the 16 level
quadrants control.

Use the Top Left, Top Right, and Bottom Right fields to set what
type of 16 Level control is used in each quadrant:

Velocity: The sample velocity increases from lowest (7) to
highest (127).

Tune: The sample tuning increases from the lowest pitch to
highest pitch. By default, the first pad in the quadrant is the
base pitch and the next 12 pads increase by one semitone
each. Use the Transpose field to transpose the original
sample down up to 12 semitones for increased range.

Filter: The cutoff value for the filter increases from lowest to
highest. You can set the filter type for the pad in Track Edit
mode.

Layer: Each row of four pads covers a range of velocity from
lowest to highest: 0-31, 32-64, 65-96 and 97-127. Pads with
multiple samples will play back each layer according to the
Velocity Start and Velocity End settings for each layer.

Attack: The attack envelope of the sample increases from
lowest to highest.

Decay: The decay envelope of the sample increases from
lowest to highest.
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Melodic Note Mode

In Melodic Note Mode, the clip launch pads can be used like a C O I 1 =
traditional keyboard controller to play melodic notes and chords. For r ﬂ I I I I I I I
instance, the image to the right shows the clip launch pads set to play ]l I C_ C I

a scale in Melodic Note Mode. The pads with bright colors are the C I I T ) l
CIC I I ]

root notes of the scale, and the white pads in between are the other
degrees of the scale.

To play a note, press a clip launch pad.

To change the starting octave, hold Shift and press the Track =)
Assign buttons marked Oct-/Oct+. ==

Melodic Note Configuration

Press and hold Shift and press the Note/Config button to open the
Melodic Note Configuration window, where you can adjust the
settings of how the notes or chords are laid out on the clip launch
pads . Start on 4th

NOTE CONFIG

Gypsy

Use the Type selector to determine what will be mapped over the ) Ao
pads:

Snap to Scale

e Chromatic: Each pad is assigned a note, ascending by one
semitone with each pad.

e Scales: Each pad is assigned a note, ascending by one scale
degree with each pad.

e Harmonize: Each pad is assigned a chord, with the root note ascending by one scale degree with each pad. All
available chords will play in the key determined by the Scale.

e Chords: Each pad is assigned a chord, with the root note ascending by one scale degree with each pad. You
can play any chord type regardless of the key determined by the Scale. Essentially, this is like the Harmonize
setting but with more options to play chords out of the set key.

e Progressions: Each pad is assigned a chord in a chord progression. You can play the pads in (or out of) order
to construct songs quickly. The available chords are determined by the Progression field.

e Tonnetz: Each pad is assigned a note, ascending by a perfect fifth (7 semitones) going left to right along each
row of pads, and ascending by a minor third (3 semitones) going from bottom to top along each column of
pads.

e Guitar: The bottom six rows of pads are organized like a six-
string guitar, with notes ascending E-A-D-G-B-E from bottom
to top in the first column of pads, and ascending by one
semitone with each pad in each row.

Note: For Guitar, Bass and Piano types,
changing the Root Note or Scale will not
affect the layout of notes on the pads, but
will change the highlighted root and scale
e Bass: The bottom six rows of pads are organized like a six- notes according to the selection.
string bass, with notes ascending B-E-A-D-G-B from bottom
to top in the first column of pads, and ascending by one

semitone with each in pad in each row. NOTE MODE
e Piano: Every two rows of clip-launch pads are organized like m F
the traditional white-and-black keys layout of a piano, with . ‘ 4
the |OW€I’ row representlng the Whlte keys and the upper row Chromatic Scales Harmonize Chords Progressions
representing the black keys.
Note: You can also press and hold the Note button while in Note W ﬂ

Mode to quickly select a Type on the display.

Guitar Tonnetz
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Use the Pad Rows field to determine how the notes are laid out on Force's 8x8 pad grid:

Continuous Start on 5th Start on 3rd
Start on root Start on 4th Start on 2nd

Use the Base Note and Octave fields to set the starting point of the scale (pitch and register). The available notes are all
chromatic notes across the range of the pads. The pad that’s assigned the root note will be lit differently to indicate
where the scale starts in each octave.

Use the Scale field to set the scale or mode based on the root note (this is disabled when Type is set to Progressions).
The available scales are:

Major Blues Major Bebop Lydian
Natural Minor Flamenco Whole Tone Mixolydian
Harmonic Minor Gypsy Chromatic Aeolian
Pentatonic Major  Hungarian Gypsy  Dorian Locrian
Pentatonic Minor ~ Persian Phrygian

Use the Velocity field to set the velocity of the pads when played:

As played 26% 53% 80%
6% 33% 60% 86%
13% 40% 66% 93%
20% Half 73% Full

Use the Scale Chord and Chromatic Chord fields to determine what chord type will play when pressing a pad. The chord
will use those scale degrees based off of the pad’s root note. You can use this only when the Type is set to Harmonize or
Chords.

When set to Harmonize, the available Scale Chords are:
1-3-5 (major/minor) 1-3-5-7 (major7/minor7)
1-4-5 (sus4) 1-3-5-7b (dominant)
1-2-5 (sus2)

When set to Chords, the available Chromatic Chords are:

Major Major7 Augmented
Minor Minor7 Diminished
Sus2 Major9
Sus4 Minor9

Use the MIDI Input field to restrict the recorded notes to a set scale. See Addenda > Updates in Force 3.0.3 > New
Features > MIDI Input Snap to Scale to learn more.
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Launch & Note Mode

In addition to using the entire 8x8 pad matrix for Launch Mode or Note Mode, you can split the rows of clip launch pads

into half Launch Mode and half Note Mode.

To enter Launch & Note Mode, press the Launch and Note buttons [~

at the same time.

The top four rows of pads can be used for launching clips, and the

bottom four rows of pads can be used for melodic or drum note &=

playing, depending on the track selected.

In this mode, you can perform any of the same actions that you would
in either Launch Mode or Note Mode.

Press and hold the Note button to adjust the Timing Correct value
(for Drum tracks) or Note Mode scale type (for Plugin, MIDI and
Keygroup tracks).

Hold Shift and press the Launch or Note button to open its [*=

respective settings.
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Step Sequencer
The Step Sequencer pad mode is used to create or edit clips by using the pads as "step buttons," simulating the

experience of a traditional step-sequencer-style drum machine. This pad mode is often used in conjunction with the
Step Sequencer mode on the display, but can be used while any mode is on the display.

To enable Step Sequencer pad mode, press the Step Seq button. Each time you press this button, the pads will cycle
through the different modes. See below for more details.

STEP SEQ MODE

—

Melodic anes a ) Mono Steps 8x4  Poly

Press and hold the Step Seq button to do any of the following:
Quickly select a Step Sequencer Mode using the Step Seq Mode window that appears.

Use the top row(s) of pads to select the active page of the step sequencer. The number of pages available depends
on the selected step size and the number of bars in the clip.

Use the bottom row of pads to select the beat division for the Step Size. The right-most pad can be used to enable
or disable Triplet beat divisions.

Hold Shift and press Step Seq/Config button to open the Step
Sequence Configuration window. In addition to these common
settings, some Step Sequencer modes have additional settings
available in this window, described below. piesiiteke

Step Settings

Use the Mode field to set the Step Sequencer pad mode: Drum,
Melodic or Lanes. Drum

Use the Velocity field to set the velocity of new steps being As played
entered. Select As Played for responsive velocity, or select one of
the preset levels for fixed velocity of all steps.

Use the Step Size field to set the beat division for each step.



Drum Mode

In Drum Step Sequencer Mode, the lower-left quadrant of pads is B ]
used like a traditional 4x4 drum pad layout to play samples. ﬂ Il Il Il ]

Press a clip launch pad to select it. Doing so will also play back SN [ N N

the pad's sample. If you would like to select a pad without e e JE O JEEIL

sounding the sample, hold Select and press the pad. ﬂ I III ]]l[ }ﬁﬂﬁ

Hold Shift and press the Track Assign buttons marked Oct-/ B ) e

Oct+ to change the active pad bank. BT C CC ]
I JjeeJje Jjes e Je s Jee g

The lower-right quadrant of pads is used to quickly set the velocity of
new steps.

Press the lower-left pad to select As Played for responsive
velocity, or press the other pads to set a fixed velocity from low
(6%) to high (Full), going left-to-right.

The top 4 rows of pads represent the steps in the clip. The number of pads available depends on the Step Size setting.

Press a pad to insert a step at that beat for the selected drum sample. The top 4 rows will be lit dimly with the color
of the selected drum sample.

Press and hold Clip Select and tap one of the pads containing an event to select a step event.

Press and hold Shift and Clip Select at the same time, and then tap the pads containing events to select multiple
step events.

Hold Shift and press Step Seq while in Drum Step Sequencer Mode to configure its settings. These are the same as
mentioned above.

Melodic Mode

In Melodic Step Sequencer Mode, the bottom 4 rows of the pads are
used like Melodic Note Mode, with the pads representing notes in a
scale.

Jo JC e
| B | A I |
N | O |

Press a clip launch pad to select a note. The currently selected CC 0 I C
note will be lit bright white. I |

ﬂ J

Hold Shift and press the Track Assign buttons marked Oct-/ (N | | I |

Oct+ to change the octave. (N | |
o

The top 4 rows of pads represent the steps in the clip. The number of
pads available depends on the Step Size setting.

Press a pad to insert a step at that beat for the selected note.
Press and hold Clip Select and tap one of the pads containing an event to select a step event.

Press and hold Shift and Clip Select at the same time, and then tap the pads containing events to select multiple
step events.

Hold Shift and press Step Seq to open the Configuration window. In addition to the fields mentioned above:

Use the Note Settings fields to set configure the Root Note, Scale, starting Octave, and Filter Input.
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Lanes Mode

In Lanes Step Sequencer Mode, each column of pads represents one 0l

beat division, and each row of pads represents one drum sample in a

drum bank or one note in a scale, depending on the type of track ]

selected.

the respective drum sample or note.

Hold Shift and press the Track Assign buttons marked Oct-/

Oct+ to change the octave or starting pad.

I
I
I
Press a clip launch pad to insert a step at that beat division for |
I
I
I
|

Press and hold Clip Select and tap one of the pads containing an
event to select a step event.

Press and hold Shift and Clip Select at the same time, and then
tap the pads containing events to select multiple step events.

Hold Shift and press Step Seq to open the Configuration window. In addition to the fields mentioned above:
e When a drum track is selected:
Use the Base Pad field to set the starting pad for the 8 rows of clip launch pads.
¢ When a keygroup, plugin, MIDI or CV track is selected:
Use the Base Note field to set the starting note for the 8 rows of clip launch pads.

Use the Note Settings fields to set configure the Root Note, Scale, and Filter Input.

Lanes (Mono) Mode

Similar to Lanes Mode, in Lanes (Mono) Mode, each column of pads [ ]

represents one beat division, and each row of pads represents one

drum sample in a drum bank or one note in a scale, depending on the )

type of track. Unlike Lanes mode, however, only one note may be

entered at a time.

Press a clip launch pad to insert a step at that beat division for the

respective drum sample or note. If you press another clip launch

pad in the same column, the previous note will be removed.

N\
—

Hold Shift and press the Track Assign buttons marked Oct-

/Oct+ to change the octave or starting pad.

Press and hold Clip Select and tap one of the pads containing an
event to select a step event.

Press and hold Shift and Clip Select at the same time, and then
tap the pads containing events to select multiple step events.

Hold Shift and press Step Seq to open the Configuration window. In addition to the fields described above:
e When a drum track is selected:
Use the Base Pad field to set the starting pad for the 8 rows of clip launch pads.
¢ When a keygroup, plugin, MIDI or CV track is selected:
Use the Base Note field to set the starting note for the 8 rows of clip launch pads.

Use the Note Settings fields to set configure the Root Note, Scale, and Filter Input setting.
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Mono Steps 8x4 Mode

In Mono Steps 8x4 Mode, the lower-left quadrant of pads represents
notes in a scale.

Press a clip launch pad to select a note. The currently selected o ]

ﬂ I

ﬂ I

ﬂ I

note will be lit bright white. (N | N O |

Hold Shift and press the Track Assign buttons marked Oct- I ” ” ” “/ }HHI-]
/Oct+ to change the octave or starting pad. | I I I I I I I |
: . . . L) JC JC JE 0 JC I ]
The lower-right quadrant of pads is used to quickly set the velocity of | S | a | S | S| B | B | B
new steps. =3

Press the lower-left pad to select As Played for responsive
velocity, or press the other pads to set a fixed velocity from low
(6%) to high (Full), going left-to-right.

The top 4 rows of pads represent the steps in the clip. The number of pads available depends on the Step Size setting.
Press a pad to insert a step at that beat for the selected note. Only one note can be added per step.
Press and hold Clip Select and tap one of the pads containing an event to select a step event.

Press and hold Shift and Clip Select at the same time, and then tap the pads containing events to select multiple
step events.

Hold Shift and press Step Seq while in Mono Steps 8x4 Sequencer Mode to configure its settings. These are the same
as mentioned above.

Poly Notes 8x4 Mode

Similar to Melodic Step Sequencer Mode, in Poly Notes 8x4 Mode, B I JC C 1C 1 ]
the bottom 4 rows of the pads are used like Melodic Note Mode, with (I { D I 0 | O |
the pads representing notes in a scale. SN | I

Press a clip launch pad to select a note. The currently selected %%%%%%%%

Hold Shift and press the Track Assign buttons marked Oct-/ C ) JC JCaC JC JC ]
Oct+ to change the octave. (| O I |
(R [ | I e | Moy | S S|

The top 4 rows of pads represent the steps in the clip. The number of
pads available depends on the Step Size setting. Poly Notes 8x4
Mode differs from Melodic Mode in that only steps for the selected
note are shown in these rows, rather than all steps with any note.

Press a pad to insert a step at that beat for the selected note.

Press and hold Clip Select and tap one of the pads containing an
event to select a step event.

Press and hold Shift and Clip Select at the same time, and then
tap the pads containing events to select multiple step events.

Hold Shift and press Step Seq to open the Configuration window. In addition to the fields mentioned above:

Use the Note Settings fields to set configure the Root Note, Scale, starting Octave, and Filter Input.
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Mono 8x8 Mode

In Mono 8x8 Mode, the entire 8x8 pad grid represents one beat
division in the current clip. Like Mono Lanes mode, however, only one

note may be entered at a time. This mode can also be useful for ]

inputting step automation.

Press a clip launch pad to insert a step at that beat division for the
respective drum sample or note. If you press another clip launch
pad in the same column, the previous note will be removed.

Press and hold Note to temporarily switch the pad launch matrix
to Note mode. While holding, press a pad to select a new note.

Press and hold Clip Select and tap one of the pads containing an
event to select a step event.

Press and hold Shift and Clip Select at the same time, and then
tap the pads containing events to select multiple step events.

Hold Shift and press Step Seq to open the Configuration window. In
addition to the fields described above:

Use the Note Settings fields to set configure the Root Note,
Scale, and Filter Input setting.

Poly 8x8 Mode

In Poly 8x8 Mode, the entire 8x8 pad grid represents one beat division
in the current clip. Unlike Mono 8x8 mode, however, multiple notes
may be entered at a time.

Press a clip launch pad to insert a step at that beat division for the
respective drum sample or note. If you press another clip launch
pad in the same column, the previous note will be removed.

Press and hold Note to temporarily switch the pad launch matrix
to Note mode. While holding, press a pad to select a new note.

Press and hold Clip Select and tap one of the pads containing an
event to select a step event.

Press and hold Shift and Clip Select at the same time, and then
tap the pads containing events to select multiple step events.

Hold Shift and press Step Seq to open the Configuration window. In
addition to the fields mentioned above:

Use the Note Settings fields to set configure the Root Note,
Scale, starting Octave, and Filter Input.
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Tracks

About Tracks

Each clip you create within a project is routed through a track. There are six PR
types of tracks, each of which determines how the clip sounds or what it is used
for. A single project can hold up to 128 tracks. it

Audio

This chapter covers how to create each track type.

To learn about editing your tracks to your preference, see the Modes > Track
Edit Mode chapter.

An Audio track lets you record audio from an external source or by resampling another track to create a clip.
See Audio Tracks for more information.

A drum track uses one or more samples as its sound source. It contains (1) a list of samples and (2) the
settings for each sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum tracks are used
mostly for creating drum parts and quickly and easily assigning samples to pads. See Drum Tracks for more
information.

A plugin track contains an instance of a plugin through which you can send your track’s MIDI data. See
Plugin Tracks for more information.

A keygroup track uses one or more samples as its sound source. It contains (1) a list of samples and (2) the
settings for each sample (i.e., pitch tuning, effects, etc.). Keygroup tracks are used to play samples
chromatically with a MIDI keyboard or the Force pads. See Keygroup Tracks for more information.

Keygroup

A MIDI track lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine.
See MIDI Tracks for more information.

A CV track lets you send your track’s MIDI data to an external device that uses control voltage (CV), like a
synth. See CV Tracks for more information.
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Audio Tracks

An audio track uses recorded or imported samples as its sound source.

To create an audio track:

1.
2.

Press Matrix to enter Matrix Mode.
At the top of the screen, press the + icon to add a new track.

If you cannot see the + icon, press the right cursor to move the matrix
view until it is shown.

Tap Audio to instantly create a new track. For more track options, tap the
Advanced button and then select Audio as the track type in the window
that appears.

Use the Input field to select which inputs the audio track will use.

Check the Ascending box to determine if the channel numbers of the
input sources will ascend across the new audio tracks you create. When
checked, the first new audio track will use the input source you set above
(e.g., Input 1), the second new audio track will use the next input source
(e.g., Input 2), etc. When unchecked, all of the new audio tracks you
create in this instance will use the same input source. This feature is
relevant only if you are creating more than one new audio track
(determined by Number of Tracks below).

Check the Record Enable box to set the new track to be automatically
record enabled.

Use the Input Monitoring field to set the monitoring behavior: Off, On, or
Auto.

If you would like to create more than one audio track at once, use the
Number of Tracks field to select how many tracks you would like to
create.

Tap Do It to confirm, or tap Close, the X or outside the window to go
back. A new drum track will be created and appended with a number
(e.g., Audio 002).

{3 NEWTRACK

Audio

Input 1,2

Alternatively, press and hold the track select button of an unused track, then tap Audio.
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TRACK SETTINGS

Kick Loop

Audio Settings

Off

General Settings

Neon

Include in row launch

To edit the track settings, double-tap the track name at the top of the screen to open the Track Settings window.

To set the monitoring behavior of the track, tap the Monitor field and use data dial or -/+ buttons to scroll through
the three available states:

When set to Auto, you will hear incoming audio while the track is record-enabled only.
When set to In, you will hear incoming audio whether or not the track is record-enabled.
When set to Off, you will never hear any incoming audio.

To rename the track, tap the track name field and use the virtual keyboard that appears to enter a new name, and
then tap Do It to confirm or the gray bar at the top of the screen to cancel.

To change the track color, tap the color field and use the data dial or -/+ buttons to scroll through the options. You
can also double-tap the color field and then swipe up or down, or use the data dial or -/+ buttons to scroll through the
options.

To change the launch behavior of clips in the track, tap the Row Launch field and use data dial or -/+ buttons to
scroll through the options:

When set to Include in row launch, clips from this track will be triggered when launching the entire row using the
scene launch buttons.

When set to Exclude from row launch, clips in this track will not be launched with the rest of the row when
triggering a scene. This is useful when using an a capella track, for example.
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Drum Tracks

A drum track uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for each
sample (i.e., pad assignments, loop points, pitch tuning, effects, etc.). Drum tracks are used mostly for creating drum
parts and quickly and easily assigning samples to pads.

To create a drum track:
1. Press Matrix to enter Matrix Mode.

2. At the top of the screen, press the + icon to add a new track.

{3 NEWTRACK

If you cannot see the + icon, press the right cursor to move the matrix
view until it is shown.

3. Tap Drum to instantly create a new track. For more track options, tap the Drum
Advanced button, and then select Drum as the track type in the window
that appears.

If you would like to create more than one drum track at once, use the
Number of tracks field to select how many tracks you would like to
create.

4. Tap Do It to confirm, or tap Close, the X or outside the window to go
back. A new drum track will be created and appended with a number
(e.g., Drum 002).

Alternatively, press and hold the track select button of an unused track, then tap Drum.
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TRACK SETTINGS

Top Loop

MIDI Routing

All Ports

<none>

Drum Settings

To edit the track settings, double-tap the track name at the top of the screen to open the Track Settings window.

To rename the track, tap the track name field and use the virtual keyboard that appears to enter a new name, and then
tap Do It to confirm or the gray bar at the top of the screen to cancel.

To edit the MIDI routing for the track, use the MIDI Input Port, MIDI Input Channel, MIDI Send fields and use data
dial or -/+ buttons to scroll through the options.

MIDI Input Port: Select the MIDI port to receive MIDI data from. When set to All Ports, the track will receive all
incoming MIDI Data from any connected port. To view and edit the available ports, go to Preferences > MIDI / Sync.

MIDI Input Channel: Sets the MIDI Channel to receive MIDI data from. Select All to receive from all MIDI channels,
or select 1-16.

MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to another
track.

To set the monitoring behavior of the track, tap the MIDI Monitor field and use data dial or -/+ buttons to scroll
through the four available states:

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is useful
when using keyboards with Local Control active.

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from
recorded events will not be heard.

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will be
heard.

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard.

To edit the pad colors, uncheck the Pads follow track color field, then tap the Edit Pad Colors button that appears.
(See Modes > Pad Color Mode to learn more about editing pad colors).

To change the track color, tap the color field and use the data dial or -/+ buttons to scroll through the options. You
can also double-tap the color field and then swipe up or down, or use the data dial or -/+ buttons to scroll through the
options.

To change the launch behavior of clips in the track, tap the Row Launch field and use data dial or -/+ buttons to
scroll through the options:

When set to Include in row launch, clips from this track will be triggered when launching the entire row using the
scene launch buttons.

When set to Exclude from row launch, clips in this track will not be launched with the rest of the row when
triggering a scene. This is useful when using an a capella track, for example.

To load a kit into a drum track:

1.

Press Load or press Menu and tap Browser to show the Browser.

2. Find and select a kit, and then tap Load to load it to the track. Repeat this for any other kits or samples you want to

load into the project. (See Modes > Browser to learn more about using the Browser specifically.)

Tip: Remember that a drum kit has 128 pads total—16 pads across eight banks.
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Alternatively, assign samples in a drum track in Track Edit Mode in one of these two ways:

Drum Kit

BassHouse-Kick...

Pad

© 100%

SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

1. Press Menu, and then tap Track Edit to enter Track Edit Mode. Alternatively, press and hold Shift and press Clip.

2. Tap the Samples tab. This lets you view the samples assigned to all four layers of the current pad as well as tuning
and level parameters for each layer.

Tap a pad to select it (and play its assigned samples, if any).

Tap one of the Layer fields under the sample waveform to select a layer. Tap the Sample field, and then use the
data dial or —/+ buttons to select a sample. Alternatively, double-tap the field for a layer, and then tap a sample to

select it.

Drum Kit

BassHouse-Kick-BH Kick 3

BassHouse-Kick-BH Kick 4

C

SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

1. Press Menu, and then tap Track Edit to enter Track Edit Mode. Alternatively, press and hold Shift and press Clip.

2. Tap the Pan Velocity tab. This lets you view the samples assigned to all four layers of the current pad as well as
panning and velocity ranges of each layer.

Tap a pad to select it (and play its assigned samples, if any).

Tap one of the Layer fields to select a layer, and then use the data dial or -/+ buttons to select a sample.
Alternatively, double-tap the field for a layer, and then tap a sample to select it.
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Keygroup Tracks

A keygroup track uses one or more samples as its sound source. It contains (1) a list of samples and (2) the settings for
each sample (i.e., pitch tuning, effects, etc.). Keygroup tracks are used to play samples chromatically with a MIDI
keyboard or the Force pads.

To create a keygroup track:
1. Press Matrix to enter Matrix Mode. {3 NEWTRACK
2. At the top of the screen, press the + icon to add a new track.

If you cannot see the + icon, press the right cursor to move the matrix Keygroup
view until it is shown.

3. Tap Keygroup to instantly create a new track. For more track options, tap
the Advanced button and select Keygroup as the track type in the
window that appears.

If you would like to create more than one keygroup track at once, use the
Number of tracks field to select how many tracks you would like to
create.

4. Tap Do It to confirm, or tap Close, the X or outside the window to go
back. A new keygroup track will be created and appended with a number
(e.g., Keygroup 002).

Alternatively, press and hold the track select button of an unused track, then tap Keygroup.
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TRACK SETTINGS

Classic Bass

MIDI Routing

All Ports

<none>

General Settings

Lime

To edit the track settings, double-tap the track name at the top of the screen to open the Track Settings window.
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To rename the track, tap the track name field and use the virtual keyboard that appears to enter a new name, and then
tap Do It to confirm or the gray bar at the top of the screen to cancel.

To edit the MIDI routing for the track, use the MIDI Input Port, MIDI Input Channel, MIDI Send fields and use data
dial or -/+ buttons to scroll through the options.

MIDI Input Port: Select the MIDI port to receive MIDI data from. When set to All Ports, the track will receive all
incoming MIDI Data from any connected port. To view and edit the available ports, go to Preferences > MIDI /
Sync.

MIDI Input Channel: Sets the MIDI Channel to receive MIDI data from. Select All to receive from all MIDI channels,
or select 1-16.

MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to another
track.

To set the monitoring behavior of the track, tap the MIDI Monitor field and use data dial or -/+ buttons to scroll
through the four available states:

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is useful
when using keyboards with Local Control active.

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from
recorded events will not be heard.

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will be
heard.

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard.

To change the track color, tap the color field and use the data dial or -/+ buttons to scroll through the options. You
can also double-tap the color field and then swipe up or down, or use the data dial or -/+ buttons to scroll through the
options.

To change the launch behavior of clips in the track, tap the Row Launch field and use data dial or -/+ buttons to
scroll through the options:

When set to Include in row launch, clips from this track will be triggered when launching the entire row using the
scene launch buttons.

When set to Exclude from row launch, clips in this track will not be launched with the rest of the row when
triggering a scene.

To transpose the keygroup track, tap the transpose field and use the data dial or -/+ buttons to set the transposition
amount.



Classic Bass

Inst-DeepHause-Bass-Cr...

BassHouse-Bass-BH Bas...

BassHouse-Synth-BH Syn...

0

SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

To assign samples in a keygroup track:
1. Press Menu, and then tap Track Edit to enter Track Edit Mode. Alternatively, press and hold Shift and press Clip.

2. Tap Samples. This lets you view the samples assigned to all four layers of the current keygroup as well as tuning
and level parameters for each layer.

3. Tap the Number of KG field, and then use the data dial or —/+ buttons to set the number of keygroups in the track (1-
128). Alternatively, double-tap the Number of KG field, and then use the numeric keypad on the screen.

4. Tap the Keygroup field, and then use the data dial or —/+ buttons to select a keygroup. Alternatively, double-tap the
Keygroup field, and then tap a keygroup to select it.

5. Tap the field for a layer, and then use the data dial or =/+ buttons to select a sample. Alternatively, double-tap the
field for a layer, and then tap a sample to select it.

To create complex keygroup track, you can add more keygroups (up to 128). This is useful when working with multi-
samples (e.g., when programming a real piano).

Tip: Remember that a keygroup track offers up to 128 keygroups, and each keygroup can hold up to four samples
(Layers 1-4). This is a total of 512 samples.
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Plugin Tracks

A plugin track contains an instance of a plugin through which you can send your track’s MIDI data.

To create a plugin track:
1. Press Matrix to enter Matrix Mode.
2. At the top of the screen, press the + icon to add a new track.

If you cannot see the + icon, press the right cursor to move the L3 NewTRAck
matrix view until it is shown.

Plugin

3. Tap Plugin to instantly create a new track. For more track options,
tap the Advanced button and then select Plugin as the track type
in the window that appears.

If you would like to create more than one plugin track at once, use
the Number of tracks field to select how many tracks you would
like to create.

4. Tap Do It to confirm, or tap Close, the X or outside the window to
go back. A new drum track will be created and appended with a
number (e.g., Plugin 002).

Alternatively, press and hold the track select button of an unused track, then tap Plugin.
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TRACK SETTINGS

Hype

MIDI Routing

All Ports

<none>

General Settings

Coral

To edit the track settings, double-tap the track name at the top of the screen to open the Track Settings window.

To rename the track, tap the track name field and use the virtual keyboard that appears to enter a new name, and then
tap Do It to confirm or the gray bar at the top of the screen to cancel.

To edit the MIDI routing for the track, use the MIDI Input Port, MIDI Input Channel, MIDI Send fields and use data
dial or -/+ buttons to scroll through the options.

MIDI Input Port: Select the MIDI port to receive MIDI data from. When set to All Ports, the track will receive all
incoming MIDI Data from any connected port. To view and edit the available ports, go to Preferences > MIDI /
Sync.

MIDI Input Channel: Sets the MIDI Channel to receive MIDI data from. Select All to receive from all MIDI channels,
or select 1-16.

MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to another
track.

To set the monitoring behavior of the track, tap the MIDI Monitor field and use data dial or -/+ buttons to scroll
through the four available states:

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is useful
when using keyboards with Local Control active.

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from
recorded events will not be heard.

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will be
heard.

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard.

To change the track color, tap the color field and use the data dial or -/+ buttons to scroll through the options. You
can also double-tap the color field and then swipe up or down, use the data dial or -/+ buttons to scroll through the
options.

To change the launch behavior of clips in the track, tap the Row Launch field and use data dial or -/+ buttons to
scroll through the options:

When set to Include in row launch, clips from this track will be triggered when launching the entire row using the
scene launch buttons.

When set to Exclude from row launch, clips in this track will not be launched with the rest of the row when
triggering a scene.

To transpose the plugin track, tap the transpose field and use the data dial or -/+ buttons to set the transposition
amount.
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To load a plugin to the track:

1.

Double-tap the track name at the top of the screen to open the Track
Settings window.

Double-tap the Plugin field. In the list that appears, tap the desired
plugin. Alternatively, use the data dial or the —/+ buttons to select a
plugin.

To sort your plugins by type or maker, tap Type or Manufacturer.

Tap Select to select the plugin, or tap Close to cancel.

To select the MIDI channel the track will use, double-tap the MIDI Ch
field. In the list that appears, tap the desired channel. Alternatively, use
the data dial or the —=/+ buttons to select a channel.

To select a preset in your plugin (if any), double-tap the Preset field. In
the list that appears, tap the desired preset. Alternatively, use the data
dial or the —/+ buttons to select a preset.

Alternatively, use the Browser to load a plugin:

1.
2.
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Press Load or press Menu and tap Browser to show the Browser.

& PLUGIN Plugin 002 X

Electric
Hype

TubeSynth

Find and select a plugin preset, and then tap Load. A new plugin track will be created if no other tracks exist,
otherwise the currently selected track will be converted into a plugin track. Repeat this for any other plugins you
want to load into the project. (See Modes > Browser to learn more about using the Browser specifically.)



MIDI Tracks

A MIDI track lets you send your track’s MIDI data to an external MIDI device like a synth or drum machine.

To create a MIDI track:
1. Press Matrix to enter Matrix Mode. {3 NEWTRACK
2. At the top of the screen, press the + icon to add a new track.

If you cannot see the + icon, press the right cursor to move the matrix Midi
view until it is shown.

3. Tap MIDI to instantly create a new track. For more track options, tap the
Advanced button and then select Midi as the track type in the window
that appears.

If you would like to create more than one MIDI track at once, use the
Number of tracks field to select how many tracks you would like to
create.

4. Tap Do It to confirm, or tap Close, the X or outside the window to go
back. A new MIDI track will be created and appended with a number (e.g.,
Midi 002).

Alternatively, press and hold the track select button of an unused track, then tap MIDI.
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TRACK SETTINGS

Midi 001

MIDI Routing

All Ports

<none>

Hype Chords

Program Change

To edit the track settings, double-tap the track name at the top of the screen to open the Track Settings window.
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To rename the track, tap the track name field and use the virtual keyboard that appears to enter a new name, and then
tap Do It to confirm or the gray bar at the top of the screen to cancel.

To edit the MIDI routing for the track, use the MIDI Input Port, MIDI Input Channel, MIDI Send fields and use data
dial or -/+ buttons to scroll through the options.

MIDI Input Port: Select the MIDI port to receive MIDI data from. When set to All Ports, the track will receive all
incoming MIDI Data from any connected port. To view and edit the available ports, go to Preferences > MIDI / Sync.

MIDI Input Channel: Sets the MIDI Channel to receive MIDI data from. Select All to receive from all MIDI channels,
or select 1-16.

MIDI Output Port: Select the MIDI port to send MIDI data to. To view and edit the available ports, go to
Preferences > MIDI / Sync.

MIDI Output Channel: Sets the MIDI Channel to send MIDI data to. Select All to receive from all MIDI channels, or
select 1-16.

MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to another
track.

To set the monitoring behavior of the track, tap the MIDI Monitor field and use data dial or -/+ buttons to scroll
through the four available states:

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is useful
when using keyboards with Local Control active.

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from
recorded events will not be heard.

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will be
heard.

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard.

To select a MIDI program change value for the track to send, check the Program Change box to enable
program changes, and then double-tap the MIDI Program Change field. Use the number pad that appears to enter
a value from 1-127, then tap Do It. Alternatively, use the data dial or the —/+ buttons to select a value. All clips in
the track will send this value when launched. Once enabled, you can also select a MIDI bank change value by
checking the Bank Change box to enable bank changes, and then use the MIDI Bank MSB and MIDI Bank LSB
fields to set the bank change values.

To change the track color, tap the color field and use the data dial or -/+ buttons to scroll through the options. You
can also double-tap the color field and then swipe up or down, use the data dial or -/+ buttons to scroll through the
options.

To change the launch behavior of clips in the track, tap the Row Launch field and use data dial or -/+ buttons to
scroll through the options:

When set to Include in row launch, clips from this track will be triggered when launching the entire row using the
scene launch buttons.

When set to Exclude from row launch, clips in this track will not be launched with the rest of the row when
triggering a scene.

To transpose the MIDI track, tap the transpose field and use the data dial or -/+ buttons to set the transposition
amount.



CV Tracks

A CV track lets you send your control voltage (CV) signals to an external device like a synth or drum machine that uses CV.

To create a CV track:

1. Press Matrix to enter Matrix Mode.

{3 NEWTRACK

2. At the top of the screen, press the + icon to add a new track.

If you cannot see the + icon, press the right cursor to move the matrix oY
view until it is shown.

3. Tap CV to instantly create a new track. For more track options, tap the
Advanced button and then select CV as the track type in the window that
appears.

If you would like to create more than one CV track at once, use the
Number of tracks field to select how many tracks you would like to
create.

4. Tap Do It to confirm, or tap Close, the X or outside the window to go
back. A new CV track will be created and appended with a number (e.g.,
CV 002).

Alternatively, press and hold the track select button of an unused track, then tap CV.
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TRACK SETTINGS

General Settings

CV 001 Lemon

0

CV Settings

To edit the track settings, double-tap the track name at the top of the screen to open the Track Settings window.
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To rename the track, tap the track name field and use the virtual keyboard that appears to enter a new name, and
then tap Do It to confirm or the gray bar at the top of the screen to cancel.

There are five additional settings to configure for a CV track: the CV Port, the Gate Port, the modulation wheel port
(Mod Wheel Port), Velocity Port and Note Priority. Tap each field and use the data dial or -/+ buttons to edit the
setting.

To edit the MIDI routing for the track, use the MIDI Input Port, MIDI Input Channel, MIDI Send fields and use
data dial or -/+ buttons to scroll through the options.
MIDI Input Port: Select the MIDI port to receive MIDI data from. When set to All Ports, the track will receive all
incoming MIDI Data from any connected port. To view and edit the available ports, go to Preferences > MIDI /
Sync.
MIDI Input Channel: Sets the MIDI Channel to receive MIDI data from. Select All to receive from all MIDI
channels, or select 1-16.
MIDI Send: Sets where the MIDI data is sent. You can use this to send the MIDI data from one track to another
track.

To set the monitoring behavior of the track, tap the MIDI Monitor field and use data dial or -/+ buttons to scroll
through the four available states:

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is
useful when using keyboards with Local Control active.

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback from
recorded events will not be heard.

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events will
be heard.

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard.

To change the track color, tap the color field and use the data dial or -/+ buttons to scroll through the options. You
can also double-tap the color field and then swipe up or down, use the data dial or -/+ buttons to scroll through the
options.

To change the launch behavior of clips in the track, tap the Row Launch field and use data dial or -/+ buttons
to scroll through the options:
When set to Include in row launch, clips from this track will be triggered when launching the entire row using
the scene launch buttons.

When set to Exclude from row launch, clips in this track will not be launched with the rest of the row when
triggering a scene.

To transpose the CV track, tap the transpose field and use the data dial or -/+ buttons to set the transposition
amount.



Menu

The Menu lets you select any of the 14 modes or save your project. You can also use it to set your preferences, save

your project, set sync behavior or view your system resources.

To open the Menu, press Menu, or tap the icon in the upper-left corner of the screen while on the normal page of your

current mode.
When viewing the Menu, do any of the following:

To enter a mode, tap it.

To return to the previous mode, tap the gray area in the upper-left corner, or press Menu again.
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Save

To save the project, tap the folder icon at the top of the screen to open the Project window. The Project window
shows an overview of all samples and tracks in the current project.

To open a new project, tap New.

To save a project, tap Save or Save As. If a project has not been saved before, both options will open the Save
window, described below. If a project has been saved before, tapping Save will automatically overwrite the most
recently saved version.

To delete samples from the project (to create more free RAM space for sampling time, audio recording, etc.), tap
Purge. In the screen that appears, tap Unused Samples to delete all unused samples from the project, tap All
Samples to delete all samples from the project (from all kits and audio or MIDI tracks), or tap Cancel to return to the
previous screen.

To export your project as an Ableton Live Set, tap ALS Export. See Addenda > Updates in Force 3.0.3 > New
Features > Ableton Live Set Export for more information.

Save [Internall/Force Documents/Projects o = = =

Project 01.x

Internal Project 02.x
Project 03.x
Project O4.xpj

Project 05.x|

Project 06.xpj

B Project 07.xpj

FILE NAME DFDJECt 08 = 7| SAVE AS TEMPLATE

3 NEW FOLDER CANCEL

To select the storage device you want to view, tap it in the Storage column on the left.
Internal is the internal drive of Force.
Force Documents is a shortcut to the Force Documents folder on the internal drive of Force.

If you have storage devices connected to USB ports or SD card slot of Force, they will appear in this column, as
well.

To enter a folder, double-tap it. Alternatively, turn the data dial or use the -/+ buttons to move through the list, and
press the data dial to enter a folder. You can also tap one of the five folder buttons in the upper-right to jump
immediately to those pre-assigned file paths (see Modes > Browser to learn how to do this).

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do It.
You will immediately enter the new folder.

To move up one folder level, tap the folder/L icon in the upper-left corner.
To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears.
To save the file, tap Save.

To save the file as a project template file, tap the Save as Template checkbox to check it before tapping Save.
(This file will be shown in the Template File field in the Preferences’ Project Load/Save tab.)

To cancel and return to the Menu, tap Cancel. Alternatively, tap the € icon in the upper-left corner.



Undo History

To open the Undo History window, tap the clock icon at the top of the screen. In the Undo History window, you can
view a list of recent actions along with a detail about the action if applicable.

4O UNDO HISTORY

Clear Audio Region Selection

Split Audio Region
Set Audio Region Fade Out

Select Events (with Pointer)
Modify Events

Draw Events

To undo an action, tap Undo.
To redo an action, tap Redo.

Alternatively, tap and drag the red line in the action list to quickly undo or redo multiple actions. Actions below the red
line in grey have been undone.

To close the Undo History window, tap Close or the X.
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Preferences

To open the Preferences, tap the gear icon at the
top of the screen.

& Preferences

To return to the Menu, tap the € icon in the upper- [l

left corner. Changes to the Preferences are saved
automatically.

To restore your Force hardware’s default settings,
tap Reset. In the screen that appears, tap OK to
continue or Cancel to return to the Preferences. In the
next window, tap Save to save your current project
before restoring the default settings; tap Cancel to
return to the Preferences; or tap Don’t Save to
restore the default settings without saving your
current project.

(11)111111111111111

LEGAL INFO RESET PREFERENCES

Info

This screen shows current information about your Force hardware: its current firmware version, which includes its
standalone operating system (Force Firmware); its hardware Serial Number; and its current firmware for the Control
Surface.

To view legal information relevant to Force, tap Legal Info. For complete legal information, visit
akaipro.com/product-legal.

To enter Update Mode, press and hold Shift and tap Update. In the screen that appears, tap Save to save your
current project before entering Update Mode; tap Cancel to return to the Preferences; or tap Don’t Save to enter
Update Mode without saving your current project.

Wi-Fi

The settings on this screen will determine how your Force hardware’s wireless connection works, so you can use
Ableton Link, a new technology that synchronizes beat, phase and tempo of Ableton Live and Ableton Link-enabled
applications over a wireless or wired network. These settings are available only for Force when used in Standalone
Mode.

To activate or deactivate wireless connectivity on your Force hardware, tap the On/Off selector. The available
wireless networks will appear in the panel below it.

To select a wireless network, tap it.

To connect to a selected wireless network, tap Connect. If the Wi-Fi network is password-protected, use the
virtual keyboard that appears to enter the correct password to connect to it.

To view the information of a selected wireless network, press and hold Shift and tap Info. The Network
Information window that appears will show the network name, IPv4/IPv6 address (including the subnet mask and
gateway), type of security, and signal strength (as a percentage).

To disconnect from a connected wireless network, tap Disconnect.
To clear the connection information (e.g., the password) from a selected wireless network, tap Forget.

Ethernet

The settings on this screen will determine how your Force hardware connects to a wired network using an Ethernet
cable connected to the Link port. This allows you to maintain a tighter network connection when using Ableton Link or
the Akai Network Driver.

To activate or deactivate Ethernet connectivity on your Force hardware, tap the Enabled box.

To determine how your Force hardware connects to the network, use the Address Method dropdown. Select
Automatic to have your Force hardware set the Ethernet connection, or Manual to set it yourself.

When setting the Ethernet connection manually, tap the IP Address, Subnet Mask, Gateway, and DNS fields to
input the values.
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Bluetooth

The settings on this screen will determine how your Force hardware’s Bluetooth connection works, so you can use
Bluetooth MIDI controllers (e.g., LPD8 Wireless or LPK25 Wireless) or a Bluetooth computer keyboard with it. These
settings are available only when used in Standalone Mode.

To activate or deactivate Bluetooth connectivity on your Force hardware, tap the On/Off selector. The available
Bluetooth devices will appear in the panel below it under Available Devices. The Bluetooth devices that have
already paired to your Force hardware will appear under Paired Devices.

To select a Bluetooth device, tap it.

To pair a selected Bluetooth device (in the Available Devices section), tap Pair.

To connect to a selected Bluetooth device (in the Paired Devices section), tap Connect.

To disconnect from a connected Bluetooth device (in the Paired Devices section), tap Disconnect.

To return an available Bluetooth device to its original state, tap Remove.

Sequencer
The settings on this screen determine how sequencing works in the Event View and in the Step Sequencer.

Rec Arm: This determines the behavior of the Record Arm buttons. In Single mode, selecting a different track will
automatically arm that track and disarm all other tracks. In Multi mode, you can tap any track's record button to add it
to the group of armed tracks.

Record Pad Aftertouch Events: When enabled, pad aftertouch data (from the Force hardware’s pressure-sensitive
pads) will be recorded. When disabled, pad aftertouch data will be ignored.

Place Events Recorded During Count-In at Start Point: When enabled, pressing a pad during the recording’s
pre-count will record that note event at the start of the recording (this is how the MPC3000 worked). When disabled,
no notes will be recorded until the pre-count is finished and recording has begun.

Note: This setting is ignored when recording with the Arpeggiator active.

Recording Note Length: This determines if/how events are cropped if they exceed the length of the current Clip when
recording:

Truncate to Clip Length: If the length of an event exceeds the length of the clip, it will be truncated. This
ensures that the event will not overlap itself when the clip loops.

Truncate to Clip End: If an event exceeds the length of the clip, it will be truncated to the end of the current
clip. In other words, the event will stop playing when the clip ends or loops.

As Played: Events will play back exactly as they were recorded, even if they overlap themselves when the clip

loops. Bart |2 s |4 |5 s |1 |8
lII|III|III|III|III|III|III|III‘
For example, if you record a note starting on the second bar of a 4-bar loop and S A oy
hold it for 5 bars, the note would end: at bar 7 (As Played), at bar 6 (To Clip IS T Ciip Length
Length), or bar 4 (To Clip End). See image for details. I o Ciip End

Playback Note Length: This determines if/how events are cropped if they exceed the length of the current Clip during
playback:

As Recorded: Events will play back exactly as they were recorded, even if they overlap themselves when the clip
loops.

Truncate to Clip Length: If the length of an event exceeds the length of the clip, it will be truncated. This
ensures that the event will not overlap itself when the clip loops.

Knob Swing Control Applies TC Settings on Release: When enabled, turning the knob assigned to Swing and
then releasing it will immediately apply that Swing setting. When disabled, you must use the Timing Correct window
to apply the Swing setting.

Display Resolution: This is the display resolution (in PPQN—pulses per quarter note) of pulse values in certain
areas of the operating system. Please note that this setting affects the display resolution, not the timing.
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MIDI / Sync

The settings on this screen determine how your Force hardware uses and synchronizes with connected USB and MIDI
devices.

Input Ports: This displays all available MIDI input ports in a list. Tap the keyboard icon to rename a port to a
custom name. When Master is enabled, MIDI data from this port will always go to the current track. When Track is
enabled, this MIDI port will appear in the list of available MIDI Inputs. Click the revert icon to reset the MDI Port
settings.

Output Ports: This displays all available MIDI output ports in a list. Tap the keyboard icon to rename a port to a
custom name. When Sync is enabled, the MIDI output port will send MIDI sync messages according to the type set
under Sync Send, below. When Track is enabled, this MIDI port will appear in the list of available track MIDI
outputs. Click the revert icon to reset the MDI Port settings.

Enable MIDI Ports When Discovered: This determines whether the Track option is automatically enabled when any
MIDI device is plugged in, enabling the ports to be selected as an available MIDI input or output immediately.

Receive: This determines whether your Force hardware receives MIDI Clock information (MIDI Clock), MIDI Time Code
information (MIDI Time Code (MTC)), communication from Ableton Link (Ableton Link), or none of these (Off).

Receive MMC: When enabled, your Force hardware will be able to receive MIDI Machine Control (MMC) information.
When disabled, your Force hardware will not receive this information. See Appendix > MIDI Machine Control
(MMC) to learn about this.

Send: This determines whether your Force hardware sends MIDI Clock information (MIDI Clock), MIDI Time Code
information (MIDI Time Code (MTC)), or neither (Off).

Send MMC: When enabled, your Force hardware will be able to send MIDI Machine Control (MMC) information. When
disabled, your Force hardware will not send this information. See Appendix > MIDI Machine Control (MMC) to learn
about this.

MTC Frame Rate: This determines the frame rate used by MIDI Time Code (MTC), which is important for correct
timing, especially when working on film scoring projects. In most cases, you should select 25.

Start Time: This is the starting time that will be sent when Send MIDI is set to anything other than Off. The time is
formatted in hours : minutes : seconds : frames.

Filter ‘All Notes Off’ CC: When enabled, “All Notes Off” (“MIDI panic”) messages will be ignored. This is useful if
you are using an external MIDI device that can send these types of messages but you want to filter them out. When
disabled, “All Notes Off” messages will be received normally.

Program Change: This determines whether incoming MIDI Program Change messages will change the Sequence,
Track, or be ignored (Off).

Hardware
The settings on this screen determine the behavior of your Force hardware’s pads and touchscreen.
Pad Brightness: This determines the overall brightness of Force's clip matrix pads.
Empty Slots: This determines how the clip launch pads appear when no clip is loaded.
Track Select Buttons: This determines the behavior of the Track Select buttons
Pad Threshold: This determines how much force is required to strike the pads for them to trigger.

Pad Sensitivity: This determines how the pads respond to touch. At lower values, you u

. . . o ; MIDI o
need to use more force to generate a high-velocity note. At higher values, it is easier to Velocity
generate high-velocity notes, even if you do not use much force while pressing a pad.
Pad Curve: This determines how striking the pads translates into velocity values. The A
curve is essentially linear, while the B, C, and D curves are exponential (see graphic here). A BC D',
Velocity & Aftertouch: View these meters when striking and pressing the pads to help
gauge the force and pressure you are applying to them. These meters are useful when ’/,A i
adjusting the Pad Threshold and Pad Sensitivity parameters (above). ::'»j:—'_’,, ’ i%lriz

Screen Dimming: This determines how much time must pass before your Force hardware
automatically dims its screen.
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Screen Brightness: This determines the brightness of the screen during normal operation: normal brightness (Day)
or dimmed (Night).

Date: This is the current date, formatted as Month / Day / Year. When saving files on Force in Standalone Mode,
the file will include the current date in its metadata.

Time: This is the current time, formatted as Hour : Minute. When saving files on Force in Standalone Mode, the file
will include the current time in its metadata.

Time Zone: This is the current time zone, formatted as Continent / City, which you can change here.

Project Defaults
The settings on this screen determine various default values for any new project that you create.

New Project Dialog: This determines what options you see when you start a new project. When set to Off, a new
project will be empty with no preconfigured settings except for the project defaults shown here. When set to Demo,
you can choose to load a demo project (from several different genres) as a starting point or an empty project. When
set to Demo/Template/Recent, you can choose to load a demo project, a project template file, or an empty
project. You must have a project in the Template File field of the Project Load/Save tab to select a template in this
window.

Default Tempo: This is the default tempo in BPM.
Default Arrangement Bars: This is the default number of bars in a new project arrangement.

Default Arrangement Loop Enabled: This determines whether loop is activated when a new project is created or
not.

Default Pad Slice: This determines how new samples will play when you load them or record them into a project.
When set to Pad, the Slice menu in Track Edit Mode will be set to Pad, which lets you set the start point, end point,
etc. for the layer. When set to All, the Slice menu in Track Edit Mode will be set to All, in which the entire sample

plays.

Default Drum/Keygroup Filter: This determines the default type of filter that drum and keygroup tracks will use.
See Appendix > Glossary > Filter to learn about this.

Default Plugin Synth: This determines the default instrument plugin that a new plugin track will use. Use the
window that appears to select it.

Project Load/Save
The settings on this screen determine if (and how) projects are automatically saved.

Auto Save Enabled: When enabled, your project will automatically save after each Timeout interval. When
disabled, your project will not be automatically saved; you may save only manually.

Timeout: Use this field to select how often your project will automatically save.

Template File: Use this field to select a project template that will load automatically when you select User
Template in the New Project Dialog window. (If you select the Save as Template box when saving a file, it will be
shown in this field.) In order for the User Template option to be available, New Project Dialog (in the Project
Defaults tab) must be set to Demo or Demo/Template/Recent.

Record/Export
The settings on this screen determine the settings for recording and exporting audio.
Recording Bit Depth: This determines the bit depth of recorded audio.

Bounce/Extract Bit Depth: This determines the bit depth of audio bounced or extracted.
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General

The settings on this screen determine how other features work in the hardware and operating system.

Tap Tempo: This determines how many times you have to press the Tap button before the new tempo is
recognized.

Flash Tap Tempo Light: When enabled, the Tap button’s light will flash in time with the tempo. When disabled, the
Tap button’s light will be off.

Vintage Mode: This determines the type of emulation applied to the audio output. You can apply the particular
sonic qualities of, for example, the MPC3000 or MPCG60, or of course no emulation (None).

Audition Auto Play: This determines how long a sample will sound when auto-previewing it.

Audition Outputs: This determines which pair of outputs will play any auditioned sounds. These sounds include:
samples, tracks, and projects in the Browser; sample playback, Cue Preview, and Slice Preview in Sample Edit
Mode; and sample playback in the Keep or Discard Sample window in the Sampler.

Cue Preview: This determines if/how audio is played as you move the cue playhead. As you move the cue playhead
through a sample waveform, you can set it to play the small part of the sample before the cue playhead (Before),
play the small part of the sample after the cue playhead (After), or not play at all (Off). You can also set this in
Sample Edit Mode (see Modes > Sample Edit Mode > Settings).

Slice Preview: This determines if/how audio is played as you move a slice marker. As you move the slice marker
through a sample waveform, you can set it to play the small part of the sample before the slice marker (Before), play
the small part of the sample after the slice marker (After), or not play at all (Off). You can also set this in Sample Edit
Mode (see Modes > Sample Edit Mode > Settings).

Audio Warp Algorithm: This determines how a sample is “warped” when you adjust the length of a sample without
changing its pitch (e.g., the Warp function in Audio Region Edit Mode for audio tracks or in Track Edit Mode for clip
tracks).

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by
using the Basic warp algorithm, which is less CPU-intensive.

Audio Track Auto Warp: This determines how recorded audio track regions are warped. When set to On, any audio
track region that you record will be warped automatically to match the current project tempo. You can then adjust
the project tempo while the audio track region remains in time.

Note: When you record an audio file, the current project tempo will be embedded with it. This information is stored
within the sample file when you save the project. When you warp an audio track region, the warping algorithm uses
this project tempo and the current value in the BPM field to generate the “stretch factor.”

BPM Auto Detection: This enables automatic detection of BPM from loaded samples.

BPM Detection Range: This defines the range of detectable BPM values when you use any automatic BPM
detection function in the software or when you press the Tap button to enter a new tempo.

Splice

Use this screen to connect a Splice account and download samples to your device via a network. See Addenda >
Updates in Force 3.0.2 for more information.
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Sync

Tap the Sync field (in the center of the top of the screen) and then turn
the data dial or use the -/+ buttons to set whether your Force
hardware receives MIDI Clock information (MIDI Clock), MIDI Time
Code information (MTC), communication from Ableton Link, or none
of these (Off). Alternatively, double-tap Sync and tap the desired
option to select it.

This is the same setting as the Receive menu in the MIDI / Sync tab of
your Preferences. See Preferences > MIDI / Sync for more information.

Note: Ableton Link is a new technology that synchronizes beat, phase
and tempo of Ableton Live and Ableton Link-enabled applications over
a wireless or wired network. See Preferences > Wi-Fi or Preferences
> Ethernet to learn how to connect to a network.

MIDI Monitor

Tap the 1/0 icons to open Force's MIDI monitor. You can use this to
view incoming and outgoing MIDI data from devices connected to
Force.

To view incoming MIDI data, tap the In button.

To view outgoing MIDI data, tap the Out button.

To clear the list of MIDI data, tap the Clear button.

To close the MIDI Monitor, tap the Close button or the X.

Mode

Tap this icon to switch Force to Computer Mode. In the screen that
appears, select whether you want to continue to Computer Mode or
Cancel and return to your current mode and project. It is recommended
to save your project before switching to Computer Mode since you
cannot freely switch between Standalone and Computer Modes without
also closing your current project.

See Standalone vs. Computer Mode to learn more.
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System Resources

Tap one of these icons to show the System Resources window for Force.

£ SYSTEM RESOURCES

hilg PURGE

The indicators in this window show current usage statistics:
CPU: The CPU indicator shows the current CPU as a percentage.
RAM Usage: The Mem indicator shows your Force hardware’s current RAM usage.

Important: If you encounter a warning that there is not enough memory to complete an action while using your
Force hardware, do the following to make more memory available:

Make sure all audio tracks in your project are not record-armed.
Delete samples from your project’s sample pool that were there before the warning appeared.
If you are still seeing the warning, do the following:
1. Manually undo the last action you performed before seeing the warning (you may not be able to use the Undo
button for this due to how the undo history is stored in RAM).
2. Save your project.
3. Do one of the following, and then load your saved project again.
¢ Inthe Menu, tap the folder icon at the top of the screen, and then tap New at the bottom of the screen.
e Power your Force hardware off and then on again.
e Press Menu and then tap the gear icon to open the Preferences. In the Preferences, tap Reset at the
bottom of the screen, tap OK, and then tap Restart to reset the Preferences.
e Enter Computer Mode and then reenter Standalone Mode.

Important: Although you can load multiple files at once, any samples you load into a project will be automatically
converted to full-quality uncompressed audio files, so they may use more storage space than they do on your
external storage device. If you are unable to load multiple files at once due to this, select fewer files and try again.

Drives: The Drives indicator shows the available storage space on any detected external storage devices or the internal
drive of Force.

To delete samples from the project (to create more free RAM space for sampling time, audio recording, etc.), tap
Purge. In the screen that appears, tap Unused Samples to delete all unused samples from the project, tap All Samples
to delete all samples from the project (from all kits, audio or MIDI tracks), or tap Cancel to return to the previous screen.

To close the System Resources window, tap OK, the X in the upper-right corner, or anywhere outside the window.
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Project Menu

The pull-down Project Menu can be accessed from any Force mode, giving you quick and easy access to a variety of
commonly used tools and information.

To open the project pull-down menu, tap and drag from the middle-top of the screen. The menu can be set to two
sizes depending on how far down you drag your finger.

To close the menu, simply swipe it back upwards to the top of the screen.

The project pull-down menu contains the following controls when
pulled partway down:

Tap the Global Automation button to toggle between Read and
Write. To disable global automation entirely, hold Shift and tap
this button.

Tap the Loop button to toggle the arrangement loop on or off.

Use the Momentary button to set the behavior of a macro control.
See Macros for more information.

Use the Learn button to learn a parameter to a macro control. See
Macros for more information.

When the project pull-down menu is fully opened, the following
additional controls are available:

124.00
Tap the Project field to open the Project window, where you can
load and save projects.

Tap the Bars:Beats:Ticks field to open the Locate window.

Tap the BPM field to open the Tempo window, where you can
adjust the tempo of the project.

The Memory and CPU meters monitor Force's system resources.

Tap the I/O icons to open the MIDI monitor.

Tap the Retrospective Record button to capture recently played
MIDI input and add it to the selected clip or arrangement.

Tap the Time Division button to open the Timing Correct
window.

Tap the MIDI Rec Erase button to enable or disable MIDI record
erasing in Arrange Mode. When enabled, recording MIDI events
will replace any existing events in the arrangement. When
disabled, recording MIDI events will overdub on any existing
events in the arrangement.
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Save Window

The Save Window lets you save your project, tracks and clips in a variety of ways.

To open the Save window, press the Save button.

B [ +]

Project Project As New Project

n FX -|l||1-

Track FX Rack Drum Kit Sample

Lo} ==

Clip as Audio Clip as MIDI All Clips Audio Mixdown  Ableton Live Set

To save a project, tap Project or Project As. If a project has not been saved before, both options will open the
Save window, described below. If a project has been saved before, tapping Project will automatically overwrite the
most recently saved version.

To open a new project, tap New Project.

To save the current track, tap Track.

To save the current track inserts, tap Track FX Rack.

To save the current drum kit, tap Drum Kit when a Drum track is selected.

To save the current plugin program, tap Plugin Program when a Program track is selected.

To save the current keygroup, tap Keygroup when a Keygroup track is selected.

To save the current MIDI program, tap MIDI Program when a MIDI track is selected.

To save the current CV program, tap CV Program when a MIDI track is selected.

To save the currently selected clip as audio, tap Clip as Audio when a clip is selected.
Use the Base File Name field to name the resulting export based on the Clip name or Track name.
Check the Include Track Volume/Pan Settings box to include these settings in the export.
Check the Bypass Track Effects Plugins box to not include track effects plugins in the export.

Use the Audio Tail field to set the amount, in seconds, of extra time added to the end of the resulting audio
files.

Use the Bit Depth field to set the bit depth to 8, 16 or 24.

Use the Sample Rate field to set the sample rate to 44.1, 48, 88.2 or 96 kHz. In most cases, we recommend
selecting 44.1 kHz.

To save the currently selected clip as MIDI, tap Clip as MIDI when a MIDI clip is selected.

Use the Export MIDI As field to set the export the clip(s) as MIDI files or MPC Pattern files.

Use the Base File Name field to name the resulting export based on the Clip name or Track name.
To save all current clips in the project, tap All Clips.

Use the same settings for Clip as Audio or Clip as MIDI depending on how you would like to save the clips.
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To save the project as an audio mixdown, tap Audio Mixdown.

Use the Start Bar and End Bar fields under Audio Length to set the time range that you want to mix down. You
can add a number of seconds to the end of the mixdown to capture any ringing notes or effects (such as a
reverb tail) by adjusting the Audio Tail field.

Use the fields under Render Source and Render Options to set the parameters for the audio mixdown. Check
the Separate Tracks box to render each track of the arrangement as stems.

Use the fields at the bottom of the screen to configure the audio mixdown settings. You can set the File
Format, Bit Depth, and Sample Rate.

To save the project as an Ableton Live set, tap Ableton Live Set.

Use the Export MIDI As settings to choose how MIDI tracks and clips are exported, either as Audio files or
MIDI files. When using Plugin, Drum or Keygroup tracks, you can render clips as Audio to preserve the sound of
the instruments, or render clips as MIDI data.

Check the Export Arrange as Clips box to save the arrangement as a clip row.

Check the Include Program Volume/Pan Settings box to include these settings in the export. When disabled,
the volume and pan settings will be set to 0 dB and center (C), respectively.

Check the Bypass Program Effects Plugins box to deactivate any third-party effect plugins used with the
program for the export. When disabled, those effects will be activated.

Use the Audio Tail field to set the amount, in seconds, of extra time added to the end of the resulting audio
files.

Use the Bit Depth field to set the bit depth to 8, 16 or 24.
Use the Sample Rate field to set the sample rate to 44.1, 48, 88.2 or 96 kHz.

After selecting the save type, use the following to select a save location:

& Save BX  ([Internal Jocuments/Projects
To select the storage device you want to view, tap it in the
Storage column on the left.

0 Internal

Internal is the internal drive of Force.

Force Documents is a shortcut to the Force Documents
folder on the internal drive of Force.

If you have storage devices connected to USB ports or SD
card slot of Force, they will appear in this column, as well.

FILE NAME Project 08

To enter a folder, double-tap it. Alternatively, turn the data dial FEEEe
or use the —/+ buttons to move through the list, and press the

data dial to enter a folder. You can also tap one of the five folder

buttons in the upper-right to jump immediately to those pre-

assigned file paths (see Modes > Browser to learn how to do

this).

To create a new folder, tap New Folder, use the virtual keyboard that appears to enter a name, and then tap Do It.
You will immediately enter the new folder.

To move up one folder level, tap the folder/1 icon in the upper-left corner.
To name the file, tap the File Name field at the bottom of the screen, and use the virtual keyboard that appears.
To save the file, tap Save.

To save the file as a project template file, tap the Save as Template checkbox to check it before tapping
Save. (This file will be shown in the Template File field in the Preferences’ Project Load/Save tab.)

To cancel and return to the Menu, tap Cancel. Alternatively, tap the € icon in the upper-left corner.
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Timing Correct (TC)

The Timing Correct window contains various settings to help quantize the events in your project. You can quantize
note events on MIDI tracks or track regions on audio tracks (though you cannot apply all types of quantization to audio
tracks).

To open the Timing Correct settings:
Press and hold Shift, and then press and hold the track 6 Track Assign button.

In Arrange Mode, Clip Edit Mode, List Edit Mode, or Step Sequencer Mode, tap TC at the bottom of the
screen.

To enable or disable global timing correct, tap the Global Timing Correct button so it is on. Alternatively, press
and hold Shift and press the track 6 Track Assign button.

To apply the settings you selected, tap Do It.

To cancel and return to the previous screen, tap Close.

© TIMING CORRECT © TIMING CORRECT

TIME DIVISION TIME DIVISION

116 116

Range

ALL TRACKS ALL TRACKS

Use the Type selector to set how timing corrections are applied.

o Start: The entire note event or audio track region will be nudged forward or backward so the start point aligns
with the closest time division marker in the grid. You can apply this to MIDI tracks or audio tracks.

e End: The end points of note events will be extended or shortened to align with the closest time division marker
in the grid. The start points will remain untouched. You can apply this to MIDI tracks only.

e Length: The end points of note events will be extended or shortened so that each event’s length is a multiple of
the time division, regardless of where it is in the grid. The start points will remain untouched. You can apply this
to MIDI tracks only.

e Legato: The end points of note events will be extended or shortened to create a long, unbroken phrase from the
first note event’s start point to the last note event’s end point. Each note event will sustain until another note event
starts. If multiple note events start at the same time (and are not the last note events), their lengths will become
identical. Selecting Legato disables all other options in this window. You can apply this to MIDI tracks only.

Without legato applied. With legato applied.
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Use the Time Division selector to set the quantization value. Events will “snap” to these time divisions on the grid. The
T indicates a triplet-based value.

Use the Swing field to set the amount of swing from 50% to 75%. Swing lets you “shuffle” your beats—from subtle to
extreme.

Use the Shift Timing field to shift all events by clock ticks.

Use the Window field to set how many events around a quantize value will be quantized. Any events outside this range
will not be quantized; events inside will.

Use the Strength field to set how strictly events will be quantized (i.e., shifted toward the quantize value). Lower values
move events a little bit towards the closest quantize value, resulting in a less mechanical feel than a strict quantization (a
higher value).

Use the Events selector to set the target range for the time correction.
You can apply the time correction to All note events or to just the
Selected ones.

Q@ TIMING CORRECT

To select note events to which to apply time correction, either use the [REEEEE
various tools in Event View or Region View or press the pad with the
desired events (while Hitting Pad Selects All Events is set to On).
You must do this before opening the Timing Correct window.

50

EVENTS

When Range is selected, you can define the locations (From and To)
as well as the pads or keys that will be quantized.

ALLTRACKS
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Metronome (Click/Metro)

The Click/Metro window contains all settings regarding the metronome (click track).

To enable or disable the metronome, press and hold Shift and press the track 5 Track Assign button.
To open the metronome settings, press and hold Shift and then press and hold the track 5 Track Assign button.

X CLCK/METRO

Record

Record

1/8

Metroclick

Use the Count-In field to set if/when the metronome counts before recording.
e Off disables the metronome pre-count.
e Record enables the pre-count during recording only.
e Record + Play enables pre-count in both Record and Playback Modes.

Use the Enable field to set if/when the metronome is enabled.
e Off disables the metronome.
e Play enables the metronome sound during playback only.
e Record enables the metronome sound during recording only.
o Record + Play enables the metronome to happen in both Record and Playback Modes.

Use the Rate field to select the metronome click’s time division: 1/4, 1/4T, 1/8, 1/8T, 1/16, 1/16T, 1/32 or 1/32T.
T indicates a triplet-based time division.

Use the Sound field to select the sound that you want to hear for the metronome: Sidestick 1, Sidestick 2, Clap,
Metroclick, Shake, Tambourine, or Force Click.

Use the Volume knob to set the volume of your metronome click.

Tap the On/Off button to enable or disable the metronome.

Use the Output field to set which pair of outputs will play the metronome click: Out 1,2, Out 3,4 or an individual Out
1-4.
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Automation

You can set the global automation setting, or individual tracks' automation settings, to be “written,” “read,” or disabled
entirely by using the automation buttons in the pull-down project menu and the channel strip in the Mixer.

Global

In the pull-down project menu, you can enable When you tap this button to change its state, it will change the
automation state for all tracks in the project.

Tap the global automation button to cycle through its two states:

When set to Read (R), automation data will be read but not recorded. (Think of this as a protective
feature to prevent accidental changes to your automation while recording.)

When set to Write (W), automation can be recorded and will overwrite any existing automation.
(Make sure not to touch the XY pad accidentally while you are recording.)

Press and hold Shift and tap the global automation button to disable global automation. When off,
automation data will be ignored. Tap the global automation button again to enable global
automation.

Important: If you have already recorded automation and turn it off, the track will still use the effect and
its parameter values at the point where you turned it off.

Tracks
In addition to global automation, you can set automation for individual tracks by using the track automation button in the
channel strip in the Mixer.

Note: Remember that tapping the global automation button will change the automation state for all programs in the
project; if they were originally different, all of them will then match the global automation state.

Tap the track automation button to cycle through its two states:

When set to Read (R), the track will read automation data but will not record any additional
automation over it. (Think of this as a protective feature to prevent accidental changes to your
automation while recording.)

When set to Write (W), the track can record automation. (If you have any Q-Link knobs assigned to
automatable parameters, make sure not to touch any accidentally while you are recording.)

Press and hold Shift and tap the track automation button to disable program automation. When off,
the track will ignore automation data. If you have already recorded or entered automation, tapping this
will switch between Read (R) and Write (W) only, but you can override this and turn it off by pressing
and holding Shift while pressing or tapping the button.

Important: If you have already recorded automation and turn it off, the track will still use the effect and
its parameter values at the point where you turned it off.

To quickly clear automation from a track:

1. Make sure the track is selected by pressing and holding its Track Select button.

2. Hold Shift and press the Track 4 Track Assign button, with Clear Automation written underneath.
3. All automation on the track will be immediately removed.

Alternatively, you can delete individual automation events using List View in Clip Edit Mode.
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Arpeggiator

Force includes a full-featured arpeggiator and phrase player for melodic track types, as well as traditional note repeat
functionality.

To enable the arpeggiator, press the Arp button.
To configure the arpeggiator setting, hold Shift and press the Arp button to open the Arpeggiator window.

ARPEGGIATOR

Setup

Arp

As played

Arp mode

The Setup section of the Arpeggiator window sets what kind of arpeggiator will be used and its basic functions.

Use the Action field to set the type: Arp, Note Repeat, Rhythm and Pattern. See below for more details about
these types and their additional parameters.

Use the Time Division selector to set the note value of each arpeggiator step from 1/1-1/64 beats, including T
(triplet) variations. This parameter is not available when Action is set to Pattern.

Note: This setting is tied to the project's Time Division setting, and will not function if Time Division has been set to
Off.

Use the Note Length slider to set the length of the played note in each step, from 1-100%.

Use the Velocity field to set the velocity of the arpeggiator notes. Choose As played, From first note, Accented,
Full, 3/4, Half or 1/4.

Use the Swing field to set the amount of swing in the arpeggiator from 50% to 75%. Swing lets you "shuffle" your
beats—from subtle to extreme.
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The Arp mode section of the Arpeggiator window is available when
the Action is set to Arp. When this action is selected, hold down a
chord and the arpeggiator will play a pattern based on the notes held.

Use the Pattern field to set how the arpeggiator triggers the held
notes.

Use the Octaves field to set how many octaves of the held notes
the arpeggiator will cycle through.

Use the Variation field to apply rhythmic variation to the set
pattern.

The Rhythm section of the Arpeggiator window is available when
Action is set to Note Repeat or Rhythm. The Note Repeat action
provides traditional MPC Note Repeat behavior. When the Rhythm
arpeggiator action is selected, hold down a chord and the arpeggiator
will play the held notes in a rhythmic pattern.

Use the Spread field to spread the timing of the held notes,
creating a glissando effect.

Use the Rhythm Pattern field to choose the pattern played when
notes are held. This is only available for the Rhythm action.

The Pattern section of the Arpeggiator window is available when the
Action is set to Pattern. When this arpeggiator action is selected,
hold down a single note to trigger a melodic phrase. As you change
what note is held, the melodic phrase will be transposed.

Use the Pattern field to choose the pattern.

The Settings section of the Arpeggiator window offers additional
options to control the arpeggiator.

If you have a sustain pedal connected, you can enable Sustain
Pedal Latches to use it to control latching.

Use the Latch Mode setting to set the action of the sustain pedal,
either Reset or Add.

Aljp mode

Up

i Normal

Rhythm

Jaunty

Pattern

Bass-Rhythm 01
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Effects

You can apply various effects to the pads, keygroups, tracks and master outputs, using insert and send/return effects.
This chapter can help you get a good overall understanding of how the effects work.

See Appendix > Effects & Parameters for a list of all available effects (with a brief description of each) and their
editable parameters.

Overview

In a track, each pad or keygroup can have up to four insert effects applied to it. See Insert Effects > Pads or
Keygroups to learn more about this.

An entire track can also have up to four insert effects applied to it, as well. See Insert Effects > Tracks to learn more
about this.

Additionally, each pad, keygroup, and track can each be sent to (up to) four return channels, each of which can have
up to four insert effects of their own. Their audio will be routed through the insert effects on those returns, and the
processed audio will be sent to a master output. See Send/Return Effects to learn more about this.

Finally, you can apply up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2 or
Outputs 3/4). See Insert Effects > Masters to learn more about this.

There are three other modes that handle effects differently:

¢ The Sampler can use up to four insert effects, which are applied to the audio as you record it. This means that
the effects cannot be “removed” from the sound later. Learn more about the Sampler in the Modes > Sampler
chapter.

e Similarly, the Looper can use up to four insert effects, which are applied to the audio as you record it. This
means that the effects cannot be “removed” from the sound later. Learn more about the Looper in the Modes >
Looper chapter.

o In XYFX Mode, the effects act like a single insert effect on that track. In fact, XYFX is the name of the insert
effect you have to load to the track before you can use this mode. Learn more about XYFX Mode in the Modes
> XYFX Mode chapter.
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To view, load, edit, or clear effects, tap the Inserts button. This
usually appears in a channel strip (next to a level slider and pan
knob).

To view and edit an effect, tap the effect name below the Inserts
button.

When viewing loaded effects, you will see this window:

Drum
< Drum 003

To select an effect, use the field for each insert slot. A window
(described below) will appear.

INSERTS

To edit the parameters of a loaded effect, tap the pencil icon AR Distortion [21n 2 out]
next to the insert slot.

To clear the insert slot, tap the trash can icon next to it.

To enable or disable an effect slot, tap the On/Off button next LPFiter (2in 2 out]
to it.

To disable all four effect slots, tap the All On/All Off button in the
upper-right corner. Tap it again to reactivate the previously active
effects.

MPC3000 [2in 2 out]

To load a factory FX rack, tap the Akai folder icon. Select the
desired FX rack from the options and all associated effects will be
added to the insert slots.

To load a user FX rack, tap the middle folder icon.
To save an FX rack, tap the Save disk icon.

When selecting an effect, you will see this window: P —
To move through the list, swipe up or down. Alternatively, use the kb
data dial or -/+ buttons. HP Fier

HP Shelving Filter

To sort or unsort the effects by type or manufacturer, tap Type
or Manufacturer in the lower-left corner.

LP Filter Sweep

LP Filter Sync

To load an effect, double-tap it. Alternatively, tap Select or the P Fier
data dial. LP Shelving Fitter
To cancel, tap Close or anywhere outside the list.

MPC60

MANUFACTURER

When you edit an effect, you will see this window:

& Reverb Small [ ] Small Reverb

OR O

20
DRY / WET

To adjust a parameter, tap and drag its control. Alternatively, use
the data dial or —/+ buttons. To make finer adjustments, double-
tap the control and adjust the larger version of it that appears.

Tip: Set the Knobs to screen mode to quickly adjust the m
corresponding parameters. -
To select another page of parameters, tap tabs at the bottom of m

the screen. bl

(o).

50
DENSITY

To remove the effect from the insert slot, tap the trash can icon.

To enable or disable the effect, tap the On/Off button in the |y—
upper-right corner.

To load an effect preset, tap the Folder icon.
To save an effect preset, tap the Save disk icon.

To edit parameters for another insert effect on the same pad,
track, etc., tap the Insert -/+ buttons at the top of the screen.

To close the window, tap Close or the upper part of the screen.
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Insert Effects

Pads
You can load up to four insert effects to each pad. You can do this in the Pad Mixer or Track Edit Mode.

Tip: When using pad insert effects, they will be applied to the selected pad only. This means that you could apply
unique combinations of effects to each pad within a kit. If you want to apply the same effect to all pads, do this with a
track insert effect (see Insert Effects > Tracks).

-INF dB -INF dB -INF dB -INF dB =l -INFdB

VOLUME PAN & VOLUME EFFECTS @ SETTINGS

To load a pad insert effect in the Pad Mixer:
1. Tap the Effects tab at the bottom of the screen.

2. Press the desired pad to select it, or tap it on the screen. Swipe your finger to the left to scroll through the banks of
pads.

3. Tap an insert slot to open the effects window and use it to load or edit effects.

PAD

< A06
INSERTS

| Reverb Small [2in 2 out]

2 Distortion Amp [2in 2 out]

4  NOEFFECT

To load a pad insert effect in Track Edit Mode:
1.  While using the desired track, press the desired pad to select it.

2. Tap the Effects tab in the lower-right corner, and use it to load or edit effects.
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Keygroups
You can load up to four insert effects to each keygroup. You can do this in the Pad Mixer or Track Edit Mode.

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load
insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

W2 W3 Wa Ws e w7 s
Keygroup 2 Keygroup 3 Keygroup 4 Keygroup 5 Keygroup 6 Keygroup 7 Keygroup 8

VOLUME PAN & VOLUME EFFECTS @ SETTINGS

To load a keygroup insert effect in the Pad Mixer:
1. Tap the Effects tab at the bottom of the screen.

2. Tap an insert slot to open the effects window and use it to load or edit effects.

Classic Bass

INSERTS

1 Chorus 2-voice [2in 2 out]

3  NOEFFECT

4 NOEFFECT
0

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

To load a keygroup insert effect in Track Edit Mode, tap the Effects tab at the bottom of the screen and then use the
screen that appears to load or edit effects.

Important: Remember that the effect will be applied to that keygroup only.
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Tracks
You can load up to four insert effects to each track. You can do this in the Mixer or XYFX Mode.

Note: In XYFX Mode, the effects act like a single insert effect on that track. In fact, XYFX is the name of the insert effect
that is loaded when use this mode.

Audio
< Hat Loop

INSERTS

Reverb Small [2in 2 out]

NO EFFECT

NO EFFECT

NO EFFECT

VOLUME PAN & VOLUME EFFECTS X SETTINGS

To load a track insert effect in the Mixer:
1. Tap the Effects tab at the bottom of the screen.

2. Tap aninsert slot to open the effects window and use it to load or edit effects.

Outputs 1/2

o
— g.w HPF Manual

To load XYFX for a track in XYFX Mode:
1. Select the desired track in another mode, and then enter XYFX Mode.
2. If you have not yet used XYFX Mode for this track, tap Insert XYFX on the screen to load it and show the XY pad.

Note: If you already have four insert effects loaded, you will need to clear one of the insert effect slots before doing
this.

If you have already used XYFX Mode for this track, the XY pad will appear.
Tap XYFX Location in the upper-left corner, and select Track.
If the Setup panel is not shown, tap Setup in the lower-right corner to show it.

Use the Preset field to load an effect. Use the controls below the Preset field to edit the effect.
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Masters

You can load up to four insert effects to each master output (a stereo pair of channels: Outputs 1/2 or Outputs 3/4).
You can do this in the Mixer.

7 8 1 =12 =13 w4 wq -
Submix 7 Submix 8 Return 1 Return 2 Return3 Return &4 Outputs 1/2 Outputs 3/4

VOLUME PAN & VOLUME EFFECTS B SETTINGS

To load a master insert effect in the Mixer:
1. Press the Master button to show the Returns and Master Outputs in the Mixer.
2. Tap the Effects tab at the bottom of the screen.

3. Tap an insert slot to open the effects window and use it to load or edit effects.

Submixes

You can load up to four insert effects to each Submix 1-8. You can do this in the Mixer.

To load a submix insert effect in the Mixer:

1. Press the Master button to show the Returns and Master Outputs in the Mixer.
2. Swipe to the right to show the Submixes to the left of the Returns.

3. Tap the Effects tab at the bottom of the screen.
4

Tap an insert slot to open the effects window and use it to load or edit effects.
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Send/Return Effects

Send/return effects work in the following way:
1. A pad or drum, keygroup, plugin or audio track sends its audio to a return at a designated send level.

2. That audio is processed by the effects on the return. Each return can have up to four insert effects loaded and
activated.

3. The processed audio is sent to a pair of master outputs (stereo) or a single master output (mono).

You can load send/return effects and set return levels only in the Track Mixer, described below. The rest of this section
describes the different ways to set the desired send levels for pads or tracks.

7 8 <1 2 3 A4 - =
Submix 7 Submix 8 Return 1 Return 2 Return3 Return 4 Outputs 1/2 Outputs 3/4

VOLUME PAN & VOLUME EFFECTS @ SETTINGS

To load a send/return effect to a return:

1. In the Mixer, press the Master button on the hardware to show the Returns and Master.
2. Tap the Effects tab at the bottom of the screen.

3. Tap an insert slot to open the effects window and use it to load or edit effects.

3 4 1 2 3 4
Return 3 Return &4 Outputs 1/2 Outputs 3/4 Outputs 5/6 Outputs 7/8

VOLUME PAN & VOLUME INSERTS & 1/0 © SETTINGS

To set the return level:

1. In the Mixer, press the Master button on the hardware to show the Returns and Master.
2. Tap the Volume or Pan & Volume tab in the lower-left corner.

3. Inthe screen, tap the track that corresponds to the desired return.

4

To adjust the level of the currently selected return, use the data dial or —/+ buttons. Alternatively, use the level
slider in the channel strip. To make finer adjustments, double-tap the track on the screen and adjust the larger
version of the slider that appears.
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Pads

You can set the send levels for individual pads in Track Edit Mode or the Pad Mixer.

Drum Kit

INSERTS

NO EFFECT

NO EFFECT

NO EFFECT

NO EFFECT

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

To set the send levels for a pad in Track Edit Mode:
1. While editing the desired clip in Track Edit Mode, press the desired clip launch pad to select it.
2. Tap the Effects tab in the lower-right corner.

3. Use the Send knobs to set the send level for each return.

-INFdB -INFdB -INF dB -INFdB | -INF dB

VOLUME PAN & VOLUME EFFECTS B SETTINGS

To set the send levels for a pad in the Pad Mixer:
1. Tap the Sends tab at the bottom of the screen.
2. Press the desired pad to select it, or tap it on the screen.

3. To set the send level, use the data dial or —/+ buttons. To make finer adjustments, double-tap the knob on the
screen and adjust the larger version of the knob that appears.
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Keygroups

You can set the send levels for keygroups in Track Edit Mode or the Pad Mixer.

Classic Bass

INSERTS

Chorus 2-voice [2 in 2 out]

NO EFFECT

NO EFFECT

(0]

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

To set the send levels for a keygroup in Track Edit Mode:

1. While using the desired track, press the desired pad to select its keygroup. Alternatively, use the Keygroup field at
the top of the screen.

2. Tap the Effects tab in the lower-right corner.

Use the Send knobs to set the send level for each return.

W2 W3 s Ws e w7 s
Keygroup 2 Keygroup 3 Keygroup & Keygroup 5 Keygroup 6 Keygroup 7 Keygroup 8

-INFdB -INFdB -INF dB -INFdB | -INF dB

VOLUME PAN & VOLUME EFFECTS B SETTINGS

To set the send levels for a keygroup in the Pad Mixer:
1. Tap the Sends tab at the bottom of the screen.
2. Press the desired pad to select its corresponding keygroup, or tap it on the screen.

3. To set the send level, use the data dial or —/+ buttons. To make finer adjustments, double-tap the pad on the
screen and adjust the larger version of the knob that appears.
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Audio and Plugin Tracks

You can set the send levels for audio and plugin tracks in the Mixer only.

e =8
Top Loop Classic Bass Drum Kit

-INFdB -INFdB -INFdB -INFdB -INF dB -INFdB

VOLUME PAN & VOLUME EFFECTS B SETTINGS

To set the send levels for an audio or plugin track:
1. Tap the Sends tab at the bottom of the screen.
2. Inthe screen, tap the send knob in the desired track.

3. To set the send level, use the data dial or —/+ buttons. To make finer adjustments, double-tap the pad on the
screen and adjust the larger version of the knob that appears.
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Plugins

Force includes four new plugins from AIR Music Technology to help you get started making music right out of the box.

To learn more about plugin tracks, see Operation > General Features > Tracks > Plugin Tracks.

Bassline

The AIR Bassline plugin emulates the sound of classic mono synths,
with a contemporary twist.

Plugin 001

Osc / Filter / Envelope

Use this tab to adjust the settings for the oscillators, as well as their
filter and envelope settings.

OSC/FLT/ENV  VEL/MSTR/CHORUS

Bassline

mw Q
| _8oost
08 o

| Default

1.37 kHz

“w o Q
\l/ Q 10,0 Hz

DELAY

COMPRSSR / HYPE

Parameter Description Value Range
Oscillator Waveform Continuously variable waveshape for the oscillator. Saw Octave, Saw, Square, Sine
Sub-Octave Amount of sub-octave oscillator. 0-100%
Fifth Amount of fifth-oscillator. 0-100%
Start Phase Position of the waveform when a note is triggered. Free, 0 degr., 180 degr.
Glide Time Amount of time to slide from the pitch of one note 10.0 ms -2.00 s
to the next note played.
Boost Boosts the signal of the oscillator. 0.0dB-48.0dB
Boost Freq. Center frequency of the boost. *1.0-7240.0
Boost Envelope Amount of effect of the envelope on the Boost Gain 100-0%, Off, Frequency
section. 0-100%
Adjust Gain to control the amount of boost.
Adjust Frequency to control the width of the
boosted frequency.
Filter LP Cutoff Cutoff frequency for the low-pass filter. 20.0 Hz - 20.0 kHz
Reso Resonance of the filter. 0-100%
Filter Env Envelope of the filter. -100% -0 -100%
At negative values, decreases the cutoff value
based on the filter decay value.
At positive values, increases the cutoff value
based on the filter decay value.
HP Cutoff Cutoff frequency for the high-pass filter. 10.0 Hz - 500 Hz
Envelope Amp Attack Length of time for the note to reach full volume. 100-0% Soft to 0-100% Hard
Amp Decay Length of time for the note to reach the sustained 0-100%
volume.
Filter Decay Length of time for the filter to reset after being 0-100%
released.
Pitch Mod Amount of pitch modulation applied to the 0-100%

envelope.

100



Velocity / Master / Chorus

Use this tab to adjust the Velocity Control settings, Master volume. You can also apply and adjust the settings for the
built-in Chorus effect.

Parameter Description Value Range
Velocity Amp Control The amount of effect velocity has on amplitude 0-100%
control.
Filter Control The amount of effect velocity has on filter control. 0-100%
Boost Control The amount of effect velocity has on boost control. 0-100%
Env Retrigger Sets whether the envelope will retrigger when a note is  Off, On
played while another note is being held.
Master Master Volume  Sets the volume level. -inf dB - +6.0 dB
Drive Type Choose one of two drive algorithms. Overdrive, Clip
Drive Amount Amount of drive applied. 0-100%
Bend Range Number of semitones up or down controlled by MIDI  0-12

pitch bend messages

Chorus Rate Modulation speed of the chorus effect. 0.40 Hz - 3.20 kHz
Depth Modulation depth of the chorus effect. 0-100%
Mix Wet/dry amount of the chorus effect. 0-100%
On/Off Enables or disables the effect. Off, On
Delay

Use this tab to apply and adjust the settings for the built-in delay effect.

Parameter  Description Value Range
Time Length of time of the delayed signal.
When Sync is set to Free: 1 ms—-2.00s

When Sync is set to Sync: 1/32 - 8/4

Sync Set to Free to adjust Time by milliseconds, or set to Sync to match the Free, Sync
Delay Time to the Global Tempo.
Mix Wet/dry amount of the delay effect. 0-100%
Feedback Amount of signal fed back into the delay line. 0-100%
Damp Center frequency of where the delay signal will be dampened. 1.00 - 20.0 kHz
Reso Amount of resonance of the feedback signal. 0-100%
Reso Freq Center frequency for feedback resonance. 100 Hz-10.0 kHz
Ratio Reduces the delay Time in either the Left or Right stereo field. This is L 50:100, R 50:100
useful for creating offset, panned delays.
HPF Center frequency for delay signal high-pass filter. 20.0 Hz-1.0 kHz
Width Stereo width of delay signal. Higher values give wider stereo separation.  0-100%

On/Off Enables or disables the effect. Off, On
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Compressor / Hype

Use this tab to apply and adjust the settings for the built-in Compressor and Hype effects.
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Parameter

Compressor

Hype

Description Value Range
Threshold Signal level after which the compressor will be applied. 0.0 - -60. dB
Ratio Amount of compression applied. 1.0:1 -100.0:1
Output Amount of additional output gain for the compressed 0.0-+30.0dB

signal.
Mix Wet/dry mix of the compressor effect. 0-100%
Knee How gradually the compressor reacts as the threshold 0-100%

is reached.

Lower values apply a "soft" knee (compression is

applied more slowly as signal approaches the

threshold), and higher values apply a "hard" knee

(compression is immediately applied when the

threshold is reached).
Attack Length of time to apply the compression. 100 us — 300 ms
Release Length of time for compressed signal to return to 10ms-4.00s

original level.
On/Off Enables or disables the effect. Off, On
High Dampens or maximizes high end frequencies. -100-0-+100%
Low Dampens or maximizes low end frequencies. -100-0-+100%
On/Off Enables or disables the effect. Off, On




Electric

The AIR Electric plugin emulates the sound of classic electric pianos.

While viewing any of the tabs listed below, you can quickly enable or
disable the Bell and Noise sounds, as well as the built-in effects
(Tremolo, Tube, Chorus, Delay and Spring Reverb).

When viewing a specific tab, you can enable or disable the sound or
effect by pressing the circle in the upper-right corner of each section.

Pickup / Env

Plugin 001 Electric

DISTANCE

PICKUP / ENV BELL / NOISE

Use this tab to edit the settings for the emulated pickup and the

sound envelope.

| Default

CHORUS

DELAY

SPRING
REVERB

TREM / TUBE / CHRS DELAY SPRING REVERB

Parameter Description Value Range
Pickup Type Type of pickup emulated. Pickup, 0-100% Electro-
Static, 0-100% Electro-
Magnetic
Height Height of the pickup to the tines. 0.0-5.0 mm
Distance Distance of the pickup to the tines. 0.1 -10.0 mm
Clip Amount of clipping applied to the signal. 0-100%
Keytrack Ties the pickup parameters to the pitch being played. 0-100%
At higher values, the Distance is increased as the
pitch is increased.
Envelope Attack Length of time for the note to reach full volume. 100-0% Hard,
0-100% Soft
Decay Length of time for the note to reach the sustained 100 ms-20.0s
volume.
Release Length of time for the note to become silent after 100ms-5.0s
being released.
Peak Length Length of time full volume is held before decaying. 3-50ms
Keytrack Ties the envelope parameters to the pitch being 0-100%

played.

At higher values, the envelope time is decreased as
the pitch is increased.
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Bell / Noise
Use this tab to apply and adjust the settings for the Bell and Noise sounds.

Parameter Description Value Range
Bell Tune Pitch of the bell sound, in semitones above the root 0- 60 semitones
pitch.
Dry/PU Mix of Dry versus Pickup signal for the bell sound. -100% - 0% — +100%
Volume Level of the bell sound. -inf dB - +6.0 dB
Tune Keytrack Ties the tuning of the bell sound to the pitches played. 0-100%
Decay How long it takes for the bell sound to dissipate 100ms-7.0s
Keytrack Ties the amount of bell sound to the pitch being -100% - 0% — +100%
played.
At negative values, the bell sound is increased as the
pitch increases.
At positive values, the bell sound is increased as the
pitch decreases.
Noise Freq Center frequency of the noise effect 200 Hz - 16.0 kHz
Random Amount of randomization applied to the noise effect 0-100%
Mix Level of noise effect present -inf dB — +6.0 dB
Attack Length of time for the noise effect to reach full level 1-50 ms
Decay Length of time for the noise effect to dissipate 100 ms-3.00 s
Keytrack Ties the Freq to the pitch being played. 0-100%
Setup

Use this tab to adjust general settings for the plugin.
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Parameter Description Value Range
Polyphony Number of voices available. 1-16 Voices
Master Volume Overall level of the plugin. -inf dB — +6.0 dB
Velo Level Adjusts how much incoming velocity is applied. 0-100%
Velo Tone Ties the incoming velocity to tone. 0-100%

At higher values, increased velocity increases tone brightness.
Velo Attack Ties the incoming velocity to the attack envelope. 0-100%

At higher values, low velocities feature longer attack times.




Trem / Tube / Chorus

Use this tab to apply and adjust the settings for the built-in Tremolo, Tube (Over Drive), and Chorus effects.

Parameter Description Value Range
Tremolo Rate Modulation speed of the effect.
When Sync is set to Free: 0.25-13.00 Hz
When Sync is set to Sync: 8/4-1/16

Sync Sync the Tremolo Rate to the Global Tempo or letit  Free, Sync
run Free.
Mode Select Pan for stereo field modulation, or Tremolo for Pan, Tremolo

amplitude modulation.

Depth Amount of modulation applied. 0-100%
Tube Drive Amount of drive applied. 0-100%

Headroom Amount of gain reduction between the clean signal -30.0-0.0dB

and the driven signal.

Saturation Amount of saturation applied. 0-100%

Output Output level of the tube driven signal. -20.0-0.0-+20.0dB
Chorus Rate Modulation speed of the effect. 0.40-3.20 Hz

Depth Amount of pitch modulation of the effect. 0-100%

Mix Wet/dry amount of the chorus effect. 0-100%

Delay
Use this tab to apply and adjust the settings for the built-in Delay effect.

Parameter  Description Value Range

Time Amount of time between the dry signal and the delayed signal.
When Sync is set to Free: 1 ms-2.00s

When Sync is set to Sync: 1/32 — 8/4

Sync Sync the Delay Time to the Global Tempo or set to Free to adjust Time Free, Sync
by milliseconds.
Mix Wet/dry amount of the delay effect. 0-100%
Feedback Amount of signal fed back into the delay line. 0-100%
Damp Center frequency of where the delay signal will be dampened. 1.00-20.0 kHz
Reso Amount of resonance of the feedback signal. 0-100%
Reso Freq Center frequency for feedback resonance. 100 Hz-10.0 kHz
Ratio Reduces the delay Time in either the Left or Right stereo field. This is L 50:100, R 50:100

useful for creating offset, panned delays.
HPF Center frequency for delay signal high-pass filter. 20.0 Hz-1.0 kHz

Width Stereo width of delay signal. Higher values give wider stereo separation. 0-100%



Spring Reverb

Use this tab to apply and adjust the settings for the built-in Spring Reverb effect.
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Parameter  Description Value Range
Pre-Delay Length of time between dry signal and reverberated signal. 0 ms-250 ms
Time Length of reverb tail. 1.0-100s
Mix Wet/dry amount of the reverb effect. 0-100%
Diffusion Rate of increasing density of reverb reflections. 0-100%
At lower settings, the sound of individual reflections is more present.
At higher settings, reflections are more uniform.
Width Stereo width of reverb signal. Higher values give wider stereo separation. 0-100%
Low Cut Center frequency for reverb signal low-cut filter. 20.0 Hz -1.00 kHz



Hype

The AIR Hype plugin is a modern style dual-oscillator synthesizer that [
includes a wide variety of built-in effects for endless combinations of
sound, as well as convenient macro controls for lightning-fast
adjustments.

Macro

Use this tab to adjust the macro settings for the plugin. You can

access the Effect on/off switches in all tabs. Ry —
Parameter Description Value Range
Macros These six macro controls are unique to each preset. Varies
Cutoff Amount of filter cutoff applied. 0-100%
Reso Amount of filter resonance applied. 0-100%
Mod Amount of modulation effect applied. 0-100%
Distortion Amount of distortion effect applied. 0-100%
Delay Amount of delay effect applied. 0-100%
Reverb Amount of reverb effect applied. 0-100%
Pumper Amount of pumper effect applied. 0-100%

Master Master output volume. -inf — +6.0 dB
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Filter / Amp

Use this tab to adjust the filter and amplitude envelope settings.

Parameter

Filter

Filter Envelope

Amp

Amp Envelope

108

Description Value Range

Cutoff Cutoff frequency for the filter. 0-100%
Reso Amount of resonance of the filter. 0-100%
Attack Length of time for the filter to reach full level. 0-100%
Decay Length of time for the filter to reach sustain level. 0-100%
Sustain Length of time for the filter to hold sustain level. 0-100%
Release Length of time for the filter to dissipate when released. 0-100%
Envelope Amount of Filter Envelope added to the filter cutoff. 0-100%
Depth

Envelope Amount of effect the note velocity has on the filter 0-100%
Velocity envelope.

Spike Applies additional velocity to the amplitude attack. 0-100%
Spike Decay Length of time for the Spike to decay. 0-100%
Attack Length of time for the note to reach full level. 0-100%
Decay Length of time for the note to reach sustain level. 0-100%
Sustain Length of time for the note to hold sustain level. 0-100%
Release Length of time for the note to dissipate when released. 0-100%
Fade Amount added to the envelope sustain level. 0-100%
Velocity Amount of effect the note velocity has on the 0-100%

amplitude envelope.



Effects 1

Use this tab to adjust the settings for the Low-Frequency Oscillator and Modulation, Distortion and Hype effects.

Parameter Description Value Range
LFO Rate Speed of the low frequency oscillator.
When Sync is set to 1st Note or Each Note: 0.03 — 30.00 Hz
When Sync is set to Temp+Note or Tempo+Beat: 8/4 - 1/64
Sync Enables or disables LFO sync, and sets how it is Off, 1st Note, Each Note,
synced when enabled. Tempo+Note,
Tempo+Beat
Depth Amount of LFO modulation applied. 0-100%
Mod Rate Speed of modulation. 0.05-20.00 Hz
Adjust Length of time the wet signal is offset from the dry 0.0-24.0ms
signal.
Depth Amount of modulation applied. 0-100%
Mix Wet/dry mix of the modulation effect. 0-100%
Distortion Drive Amount of drive applied. 0-100%
Bias Emulates amount of voltage sent to a tube power-amp. -100-0-100%
Output Output level of the distorted signal. 0-100%
Mix Wet/dry mix of the distortion effect. 0-100%
Hype Low Dampens or maximizes low end frequencies. -12.0-+12.0dB
Lo-Mid Dampens or maximizes low-mid frequencies. -20.0 - +20.0dB
Hi-Mid Dampens or maximizes high-mid frequencies. -20.0 - +20.0 dB
Dampens or maximizes high end frequencies. -12.0-+12.0dB

High
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Effects 2

Use this tab to adjust the settings for the Delay, Reverb, Compressor, Pumper and Limiter effects.
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Parameter Description Value Range
Delay Time Amount of time between the dry signal and the 1/32 - 8/4
delayed signal.
Feedback Amount of signal fed back into the delay line. 0-100%
Freq Adjusts the filter cutoff frequency of the delayed 0-100%
signal.
Mix Wet/dry amount of the delay effect. 0-100%
L/R Reduces the delay Time in either the Left or Right L 50:100 - R 100:50
stereo field. This is useful for creating offset, panned
delays.
Reverb Pre-Delay Length of time between dry signal and reverberated 0.0-250.0 ms
signal.
Time Length of reverb tail. 0.0-30.0s
Mix Wet/dry amount of the reverb effect. 0-100%
Compressor Threshold Signal level after which the compressor will be -30.0-+10.0dB
applied.
Ratio Amount of compression applied. 1.0:1 -20.0:1
Attack Length of time to apply the compression. 0-100%
Output Amount of additional output gain for the compressed -20.0 — +20.0 dB
signal.
Pumper Rate Speed of the pumper effect. Bar, 1/2 - 1/32T
Depth Amount of signal attenuation by the effect. 0-100%
Release Amount of time to release the effect. 0-100%
Limiter Amount of drive added after the limiter effect. 0.0-32.0dB

Drive



Setup

Use this tab to adjust the plugin setup parameters.

Parameter

Setup

MIDI Control
Mod Wheel

Aftertouch

Control LFO

Description Value Range
Transpose Transposition of the plugin, in semitones. -36 - +36
Tune Fine tuning of the plugin, in cents. -100 - +100
Glide Time Amount of time to slide from the pitch of onenoteto 0ms-32s
the next note played.
Glide Mode Enables or disables pitch gliding for all triggered notes Off, Legato, On
or legato notes.
Mode Sets the plugin to polyphonic or monophonic Poly, Mono
Del-Rev Level of the delay and reverb signals. -inf - +6.0 dB
Master Overall level of the plugin. -inf — +6.0 dB
Destination Send Mod Wheel data to one of the following control  Pitch, Cutoff, Reso, Amp,
destinations. Pan
Depth Amount of modulation applied.
When Destination is set to Pitch: -12.0 - +12.0
When Destination is set to Cutoff, Reso, Amp or Pan: -100-0-100%
LFO Ties the modulation to the Control LFO. Off, On
Destination Send Aftertouch data to one of the following control Pitch, Cutoff, Reso, Amp,
destinations. Pan
Depth Amount of modulation applied. 0-100%
When Destination is set to Pitch: -12.0 - +12.0
When Destination is set to Cutoff, Reso, Amp or Pan: -100 -0 -100%
LFO Ties the modulation to the Control LFO. Off, On
Sync Enables or disables Control LFO sync, and sets how  Off, First Note, Each
the Control LFO is synced when enabled. Note, BPM & Note, BPM
& Beat
Rate Speed of modulation of the Control LFO.
When Sync is set to First Note or Each Note: 0.03 —30.00 Hz
When Sync is set to BPM & Note or BPM & Beat: 8/4 — 1/64
Shape Waveshape of the Control LFO. Sine, Triangle, Sawtooth,

Square, S&H Random,
S&H Alternate, Random
Drift, Slow Drift

111



TubeSynth

The AIR TubeSynth plugin emulates the sound of classic vintage
analog polysynths. TubeSynth is based on the highly acclaimed AIR
Vacuum Pro desktop synth plugin and also includes 5 integrated AIR

effects.

Oscillator

Use this tab to adjust the settings for the two variable Oscillators and
the Sub Oscillator.
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Plugin 001
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OSCILLATOR MIXER / FILTER

TubeSynth ~  Default

ENVELOPE

Parameter Description Value Range
Oscillator 1 Octave Coarse tuning of the oscillator by octaves. Wide, 32', 16', 8', 4, 2"
The Wide setting provides additional Fine tuning
controls.
Fine Fine tuning of the oscillator by semitones.
When Octave is set to Wide: -70.00 - 0.00 - +70.00
When Octave is set to 32'-2': -12.00 - 0.00 - +12.00
Shape Waveshape of Oscillator 1 (continuously variable) Triangle, Saw, Square, Pulse
F-Env-Shape Amount of Filter Envelope output subtracted from  -100-0-+100%
or added to the value defined by the Osc 1 Shape
parameter.
Quad Enables or disables four-voice emulation for the Off, On
oscillator.
Detune Adjusts tuning of the additional Quad voices. 0-100%
Oscillator 2 Octave Coarse tuning of the oscillator by octaves, all the LFO, 32', 16', 8, 4', 2'
way down to LFO speed.
Fine Fine tuning of the oscillator.
When Octave is set to LFO: 0.01 —20.00 Hz
When Octave is set to 32'-2': -12.00 - 0.00 - +12.00
semitones
Shape Waveshape of Oscillator 2 (continuously variable) Noise, Saw, Square, Pulse

Sub Oscillator

F-Env-»Shape

Sync

Micro Detune

Phase

Shape

Amount of Filter Envelope output subtracted from
or added to the value defined by the Osc 2 Shape

parameter.

Enables of disables syncing of Oscillator 2 to

Oscillator 1.

Additional detuning of Oscillator 2.

Position of the waveshape when the sound is

triggered.

Waveshape of the sub oscillator (continuously

variable).

-100-0-+100%

Off, On

0-100%
0 — 360 degrees

Triangle, Saw, Square, Pulse



Mixer / Filter

Use this tab to control EQ for Oscillator 2, set the levels of the oscillators and effects, and edit the low-pass filter.

Parameter

Osc 2 EQ

Mixer

LP Filter

Description Value Range
Gain Amount of gain applied to the selected Frequency. -48 -0-+48 dB
Frequency Center frequency for the equalization band. 25-10,000 Hz
Drive Amount of drive added to the EQ signal. 0-100%
Keytrack Ties the EQ settings to the pitch being played 0-100%
Osc 1 Level of Oscillator 1. 0-100%
Osc 2 Level of Oscillator 2. 0-100%
Sub Osc Level of the Sub Oscillator. 0-100%
Ring Mod Level of Ring Modulation effect. 0-100%
Drive Level of Drive effect. 0-100%
Cutoff Center frequency of the low-pass filter cutoff. 0-100%
Reso Amount of resonance of the low-pass filter. 0-100%
Slope Amount of attenuation applied above the cutoff 0 -24 dB/oct
frequency.
Saturation Amount of saturation applied to the low-pass filter. 0-100%
Env Percentage of the envelope output subtracted from or -100-0-+100%

Keytrack

added to the LP Filter Cutoff.
Ties the LP Filter Cutoff to the pitch being played.

0-100%
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Envelope

Use this tab to adjust the various envelope settings.

Parameter Description Value Range
Filter Envelope Attack Length of time for the filter to reach full level. 1.00ms-100s
Decay Length of time for the filter to reach sustain level. 1.00ms-100s
Sustain Level that a sustained note is held at, as a percentage 0-100%
of the maximum level.
Release Length of time for the filter to dissipate when released. 1.00 ms - 100 s
Amp Envelope Attack Length of time for the note to reach full level. 1.00ms-100s
Decay Length of time for the note to reach sustain level. 1.00ms-100s
Sustain Level that a sustained note is held at, as a percentage 0-100%
of the maximum level.
Release Length of time for the note to dissipate when released. 1.00 ms - 100 s
Envelope 3 Start Level Initial velocity level of the envelope. 0-100%
Start Time Length of time for the envelope to start. 0-5000 ms
Slope Hold Amount of Envelope subtracted from or added tothe -100-0-+100%
Destination when a note is held.
Slope Rel Amount of Envelope subtracted from or added tothe -100-0-+100%
Destination when a note is released.
Destination Where the envelope will be applied to. Off, Pitch, Osc 2 Pitch,

LFO 1/2 Rate, Osc1 Quad
Det., Osc 1/2 Shape, Osc
1/2 Level, Ring Level
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LFO

Use this tab to adjust the settings for the low-frequency oscillators.

Parameter

LFO 1/LFO 2

Modulation

Shape

Destination

Rate

Description

Waveshape of the low-frequency oscillator.

Where the low-frequency oscillator is sent.

Speed of modulation.

LFO1:

LFO2:

When Sync is Off:
When Sync is On:

Value Range

Sine, Square. Saw Up,
Saw Down, Pump, S&H,
Drift

Off, Pitch, Filter, Level,
Pan

Pitch, Osc 1/2 Shape,
Osc 1/2 Pitch, LPF, Quad
Detune, Osc 2 EQ Freq,
Osc 2 EQ Gain, Ring
Level

0.01 -20.00 Hz
8/4 -1/32

Depth
Fade

Amount of modulation applied.

Apply a fade-in or fade-out of the LFO signal.

0-100%

0.00 - 20.00 s out,
No fade,
0.00-20.00sin

Sync

Source

Destination

Sync the LFO Rate to the Global Tempo or turn Off to

adjust Rate by Hertz.

Where the modulation signal is sent from.

Where the modulated signal is received.

Off, On

Filter Env, Amp Env, Osc
1,0sc 2

Pitch, Osc 1/2 Shape,
Osc 1/2 Pitch, LPF, Quad
Detune, Osc EQ 2 Freq,
Osc 2 EQ Gain, Ring
Level

Depth

Amount of modulation applied.

-100-0-100%
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Setup

Use this tab to adjust plugin setup parameters.
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Parameter

Controller Destinations

Description

Value Range

Velocity 1 Send Velocity data to one of the following control Amp, Cutoff, Osc1
destinations. Shape, Osc2 Shape,
Osc1&2 Shape
Depth Amount of modulation applied. 0-100%
Velocity 2 Send Velocity data to one of the following control Amp, Cutoff, Osc1
destinations. Shape, Osc2 Shape,
Osc1&2 Shape
Depth Amount of modulation applied. 0-100%
Modwheel Send Modwheel data to one of the following control Amp, Cutoff, Osc1
destinations. Shape, Osc2 Shape,
Osc1&2 Shape
Depth Amount of modulation applied. -100 -0 -100%
Aftertouch Send Aftertouch data to one of the following control LFO 1 Depth, Cutoff,
destinations. Osc1 Shape, Osc2
Shape, Osc1&2 Shape
Depth Amount of modulation applied. -100 -0 -100%
Setup Polyphony Number of allowable voices, and how voices are Legato, Retrigger, 2, 3, 4
triggered.
Bend Range Number of semitones up or down controlled by MIDI ~ 2-12 (semitones)
pitch bend messages
Glide Time Amount of time to slide from the pitch of one noteto  1.00ms-100s
the next note played.
Glide All Enables or disables pitch gliding for all triggered Off, On
notes, not just legato notes.
Detune Amount of detuning applied. This setting is only 0-100%
applied when Doubling is enabled.
Doubling Enables or disables voice doubling. Off, On
Output Shape Amount of signal sent to a Tube Drive. 0-100%
Width Stereo width of the audio signal. Higher values give 0-100%
wider stereo separation.
Overall output volume of the plugin. -infdB - +12.0 dB
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Chorus

Use this tab to apply and adjust the settings for the built-in Chorus effect.

Parameter
Rate

Delay
Voices
LFO Wave
Depth
Width

Lo Cut
Mix

Delay

Description

Modulation speed of the effect.

Length of time the wet signal is offset from the dry signal.
Number of voices used in the chorus effect.

Waveshape of the low-frequency oscillator for the chorus effect.
Amount of pitch modulation of the effect.

Stereo width of the chorus effect. Higher values give wider stereo
separation.

Center frequency for the chorus low-cut filter.

Wet/dry amount of the chorus effect.

Use this tab to apply and adjust the settings for the built-in delay effect.

Value Range
0.01 -10.0 Hz
0.00 - 24.00 ms
3,4,6

Tri, Sine

0.00 - 24.00 ms
0-100%

20.0 Hz- 1.0 kHz
0-100%

Parameter  Description Value Range
Time Length of time between the dry signal and the delayed signal.
When Sync is set to Free: 1 ms-2.00s
When Sync is set to Sync: 1/32 - 8/4
Sync Enable to sync the Delay Time to the Global Tempo, disable to set the Off, On
Time in milliseconds.
Feedback Amount of delay signal fed back into the delay line. 0-100%
Mix Wet/dry amount of the delay effect. 0-100%
Damp Center frequency of where the delayed signal will be dampened. 1.00 - 20.0 kHz
Reso Amount of resonance of the feedback signal. 0-100%
Reso Freq Center frequency for feedback resonance. 100 Hz-10.0 kHz
Ratio Reduces the delay Time in either the Left or Right stereo field. This is L 100:50, R 50:100
useful for creating offset, panned delays.
HPF Center frequency for delay signal high-pass filter. 20.0 Hz-1.0 kHz
Width Stereo width of delay signal. Higher values give wider stereo separation. 0-100%
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Reverb / Compressor / Hype

Use this tab to apply and adjust the settings for the built-in Reverb, Compressor and Hype effects.

Parameter Description Value Range
Reverb Mode Type of reverb applied. Hall, Stadium, Room,
Abstract
Time Length of reverb tail. 0.4s—+infs
Lo Cut Center frequency for the reverb low-pass filter. 1-1000 Hz
Hi Cut Center frequency for the reverb high-pass filter. 1.0-20.0 kHz
Mix Wet/dry mix of the reverb effect. 0-100%
Compressor Threshold Signal level after which the compressor will be 0.0--60.dB
applied.
Output Amount of additional output gain for the compressed 0.0 - +30.0 dB
signal.
Mix Wet/dry mix of the compressor effect. 0-100%
Ratio Amount of compression applied. 1.0:1-100.0:1
Knee How gradually the compressor reacts as the threshold 0-100%
is reached.

Lower values apply a "soft" knee (compression is
applied more slowly as signal approaches the
threshold), and higher values apply a "hard" knee
(compression is immediately applied when the
threshold is reached).

Attack Length of time to apply the compression. 100 us — 300 ms
Release Length of time for compressed signal to return to 10ms-4.00s
original level.
Hype High Dampens or maximizes high end frequencies. -100-0-+100%

Low Dampens or maximizes low end frequencies. -100-0-+100%
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DrumSynth

The AIR DrumSynth plugins emulate the sound of classic
drum machines and feature multiple synthesis types,
advanced modeling and carefully crafted, built-in effects to
create powerful contemporary drum sounds.

You can add the following drum types as individual plugins
per track: Clap, Crash, HiHat, Kick, Perc, Ride, Snare and
Tom. Each of these instruments has comprehensive
synthesis and effects sections described below.

In each plugin, you can quickly enable or disable the built-in
effects (Transient, Distortion, EQ and Compressor) while
viewing any of the tabs listed below by tapping the buttons
on the right side of the touchscreen under FX.

Drum Sound

Plugin 001 " DrumSynth:Cla

ransient

ooooo
- One-shot

zzzzzzzzzzzzzzz

TRANS/DIST EQ/COMP

Use this tab to adjust the basic settings for the drum sound. You can also use the knobs on this tab to quickly
adjust up to eight parameters specifically chosen for each sound.

Parameter Description Value Range

Model Type of drum sound emulated. Varies

One-Shot Allows the drum sound to play entirely when triggered Enabled, Disabled
or only for how long the note length is set.

Velocity Amount of incoming Velocity applied. When setto 0, 0-100%
all notes will sound as if Full Level.

Velocity 2 Amount of additional Velocity envelope that can be -100-0-+100%
used to control a parameter.

Target Select the Parameter where the Velocity 2 information Param 1-8

is sent.

Gain Volume level of the drum sound. -Inf, -68.0-0-+12.0 dB

Parameter Each drum sound has up to eight associated Varies

Knobs parameters that can be used to further shape the

sound. The available parameters vary based on the
type of drum sound selected. Use the knobs to adjust

the selected parameter.

119



Trans/Dist

Use this tab to adjust the settings for the Transient and Distortion effects.

Parameter

Transient

Distortion

EQ/Comp

Use this tab to adjust the settings for the EQ and Compressor effects.

120

Description Value Range

Attack Decreases or increases the amount of -100-0-+100%
transient attack applied to the signal.

Shape Adjusts the shape of the processed transient. 0-100%

Sustain Percentage of sustain envelope subtracted -100-0-+100%
from or added to the transient effect.

Pre-Shape Increases or decreases the high-end tone of -100-0-+100%
the incoming audio signal pre-distortion.

Drive Amount of drive applied. 0-60 dB

Threshold Signal level after which the distortion willbe  -20.0-0.0 dB FS
applied.

High Cut Center frequency of the distortion signal high- 1.00-20.0 kHz
cut filter.

Mix Wet/dry amount of the distortion effect. 0-100%

Parameter Description Value Range
EQ High Freq Center frequency for the High EQ band. 1.20 - 20.0 kHz
High Gain Amount of gain applied to the High EQ band. Cut, -12.0-0-+12.0dB
High Mid Freq Center frequency for the High Mid EQ band. 120 Hz - 16.0 kHz
High Mid Q Width of the High Mid EQ band. 0.40-10.00
High Mid Gain Amount of gain applied to the High Mid EQ -18.0-0-+18.0dB
band.
Low Mid Freq Center frequency for the Low Mid EQ band.  40.0 Hz - 8.00 kHz
Low Mid Q Width of the Low Mid EQ band. 0.40-10.00
Low Mid Gain Amount of gain applied to the Low Mid EQ -18.0-0-+18.0dB
band.
Low Freq Center frequency for the Low EQ band. 20.0 Hz-1.00 kHz
Low Gain Amount of gain applied to the Low EQ band. Cut, -12.0-0-+12.0dB
Compressor  Ratio Amount of compression applied. 1.0:1 -100.0:1
Attack Length of time to apply the compression. 100 us - 300 ms
Threshold Signal level after which the compressor will -60.0-0.0 dB
be applied.
Output Amount of additional output gain for the 0.0-30.0dB

compressed signal.



You can also use the DrumSynth:Multi plugin to access all
DrumSynth sounds from one plugin, which includes
additional dedicated effects and mixing controls.

Note: You can only have one DrumSynth:Multi plugin active

per project.

DrumSynth 1-8 / Trans/Dist / EQ/Comp Kick

Use the first eight tabs in the Multi to control the same
parameters as the individual DrumSynth plugins. Tap
each tab to cycle between the Drum Sound view, the 100%
Trans/Dist view, and the EQ/Comp view.

Send FX

Plugin 001 " DrumSynth:Multi Its A Trap

1 Tune
o 37Hz (D)

1 Hold
20%

1 Decay
65%

1 Harm
50°%

v

Eighty

VELOCITY VELOCITY 2 TARGET Gain
0%

None

Use this tab to adjust the settings for the Delay, Diffuser and Reverb effects.

1 Click
1 Noise

-105dB

~ 10%

1 DRUMSYNTH 2 DRUMSYNTH 3 DRUMSYNTH 4 DRUMSYNTH 5 DRUMSYNTH

1 Sweep

1 Noise-Col

ransient

Parameter Description Value Range
Delay Time Length of time between the dry signal and the 1/32 - 8/4
delayed signal.
Ratio Reduces the delay Time in either the Leftor L 100:50, R 50:100
Right stereo field. This is useful for creating
offset, panned delays.
Feedback Amount of delay signal fed back into the 0-100%
delay line.
Filter Freq Sets the center frequency of the filtered delay 1.00 —20.0 kHz
signal.
Reso Amount of resonance of the feedback signal. 0-100%
Reso Freq Center frequency for feedback resonance. 100 Hz - 10.0 kHz
Diffuser Delay Delay time between the dry signal and the 1/64 — 4/4
diffused signal.
Feedback Amount of diffused signal sent back into the  0-100%
delay line.
Diffusion Rate of increasing density of reverb 0-100%
reflections.
At lower settings, the sound of individual
reflections is more present.
At higher settings, reflections are more
uniform.
Bright Adjusts the high-end tone of the diffused 0-100%
signal.
Reverb Mode Type of reverb applied. Hall, Stadium, Room,
Abstract
Time Length of reverb tail. 0.4s—-+Infs
Low Cut Center frequency for the reverb low-pass 1-1000 Hz
filter.
High Cut Center frequency for the reverb high-pass 1.00 - 20.0 kHz

filter.
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Mixer / FX / Sends

Use this tab to mix the individual drum sounds as well as control their effects. The Mixer / FX / Sends tab contains
three different views that can be accessed by tapping the tab at the bottom of the display.

Use the Mixer view to adjust the volume, panning, muting and soloing for each drum.
Tap the 1-8 icons to mute or unmute the selected drum.

Tap the S icon to solo the selected drum.

Tap and drag the pan slider to adjust the drum panning. Alternatively, tap the slider and use the encoder, or
use the appropriate knob in Screen mode.

Tap and drag the volume slider to adjust the drum volume. Alternatively, tap the slider and use the encoder, or
use the appropriate knob in Screen mode.

Use the FX view to enable or disable the Transient, Distortion, EQ and Compressor effects for each drum sound.

Tap the FX box to enable or disable the selected FX on the selected drum.

Use the Sends view to adjust the send levels for the Delay, Diffuser and Reverb Send FX.

Tap and drag the Send knob to adjust the send level for the selected effect on the selected drum. Alternatively,
tap the knob and use the encoder, or use the appropriate knob in Screen mode.



Standalone vs. Computer Mode

Force can function in two ways: Standalone Mode and Computer Mode. By default, Force will power on in Standalone
Mode.

In Standalone Mode:

e The Force hardware will not communicate with a computer over a USB connection.

e Any files (projects, samples, etc.) that you save or load are in the internal hard drive on your Force or a
connected USB drive or SD card.

In Computer Mode:

e Force will communicate with a computer over USB connection.

e Force can be used as an audio interface.

Note: Full Computer Mode support will be available in a forthcoming firmware update.

To enter Computer Mode:

1.
2.
3.

Make sure the USB-B Port on Force is connected to your computer.
If Force is powered off, press the power button to turn it on.

With Force in Standalone Mode, press Menu to open the Menu, and then tap the computer icon in the upper-right
corner.

When the Enter Computer Mode window appears, tap Computer Mode to continue. (If you tap Cancel, you can
continue using Force in standalone mode.) Looking for computer may appear briefly on the display before your
computer recognizes the USB connection as a controller.

While in Computer Mode, the display will show Computer Mode with a monitor icon and a button to return to
Standalone Mode.

To return to Standalone Mode:

1.
2.
3.

If Force is powered off, press the power button to turn it on.
With Force in Computer Mode, press Standalone.

A confirmation window will appear. Make sure that you have safely ejected all drives connected to Force, and then
tap Yes to continue. (If you tap Cancel, you can continue using Force in computer mode.)

Force will restart into Standalone Mode.
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The Force hardware has a Menu page that lets you select any one of several modes. This chapter describes the various
features and functions of each one.

Click a button below to skip directly to that chapter.
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Matrix Mode

Matrix Mode gives you an overview of your tracks and clips.

To enter Matrix Mode, do one of the following:
¢ Press Matrix.
e Press Menu, and then tap Matrix.
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To create a new clip, double-tap an empty clip slot. Alternatively, tap and hold on an empty clip slot, and then tap Create.
To launch a clip, tap an existing clip.
To launch a scene, tap the scene launch icons on the far right of the display.

To add a new track, tap the + icon at the top of the display. If your project already has 8 tracks, move the Matrix view
to the right to show this icon.

To insert a new scene or clear a scene, hold Edit and press a

Scene Launch button to open the Edit Row window. e

Tap Insert to insert one new scene row. e

Tap Insert 8 to insert 8 new scene rows.

Tap Insert & Capture to capture any clips currently playing in

. I t Insert 8 | t & Capti c
other scenes and add it to the new scene. fser nse SIS ear

Tap Clear to clear the currently selected scene.

To edit track settings, double-tap the track name at the top of the display. See General Features > Tracks for more
information on editing track settings.

To edit clip settings, hold Edit and press a clip launch pad.

CLIP SETTINGS

Use the Name field to rename the clip. Tap it and use the virtual

keyboard that appears. enlsein

Use the Color field to set the clip color. IbizaHouse-Kit-Rocks 1
Use the Launch Quantization field to set the quantization amount Gyan

for launching the clip. Launch Settings

Use the Launch Mode field to set the clip launch behavior. Select
Toggle for the clip to start or stop with each successive press.
Select Trigger for the clip to start at the beginning with each
press.

Global Trigger

To move the current matrix display view, use the cursors. To move the display by eight rows or columns at a time,
hold Shift and use the cursors.

To show or hide the Arrangement row in the matrix, press and hold Shift and press the Launch/Config button to
open the Launch Configuration window, and then check or uncheck the Show arrangement in clip matrix box.
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You can also tap and hold your finger on a clip slot to quickly access some of the functions above. See Addenda >
Updates in Force 3.0.3 > New Features > Callout Menus for more information.

The clips in Matrix Mode will change appearance based on their current status:

> ciip-Deephouse.. |  Stopped, playback stopped Prepared to record

Stopped, playback active
P Clip-DeepHouse... Prepared to play Overdubbing

(flashing)

Prepared to stop

Recording

Exiting recording

(flashing)

To open the Project Configuration window, tap the upper left
corner of the display where the BPM and Key are located. You can m—
then do any of the following:

124.00
Project Key

Use the Tempo field to set the project tempo. Use the data dial
or -/+ buttons to change the tempo, or double-tap the field to
open the number pad. Alternatively, use the tap tempo button to
set the tempo.

Use the Note and Scale fields to set the project key information.

Use the Launch Quantization field to set the global quantization
amount for launching all clips.

Tap Close, the X or outside the window to close the Project
Configuration window and return to Matrix Mode.
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To open the Record Configuration window, press and hold Record,
and then tap Settings. RECORD CONFIG

Automation

Check the Write automation when recording box to capture
automation while recording.

Recording

Use the Record Launch field to set how recording is initiated.
When set to Pad, tap any pad while the track is armed to begin RECButtonthenPad  Overdub
recording. When set to Pad and REC Button, tap any pad while
the track is armed to begin recording, or press the Record button
to begin recording on the highlighted clip slot. When set to REC
Button then Pad, first press the record button, then tap any pad
to begin recording. This is the default mode when Force is
powered on.

Single

Use the Clip Record To field to set the behavior when recording
is completed, entering either Overdub or Play.

Use the Record Arm field to set the arming behavior of the Rec
Arm button. When set to Single, Force automatically record arms
the current track when changing tracks and disarms any others.
When set to Multi, Force can record arm multiple tracks at the
same time.

When using Single Record Arm, it is still possible to record arm
multiple tracks. To do so, press and hold the Select button and
then press the Track Assign buttons for the tracks you want to
arm.

Check the Fixed Length Recording box to stop recording after
the clip length set in the Fixed Length (Bars) field. Leave
unchecked to record for any desired clip length.

Tap Close, the X or outside the window to close the Record
Configuration window and return to Matrix Mode.
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Navigate Mode

Navigate Mode lets you quickly select which 8x8 grouping of clips is currently in focus for the clip launch pads
and Matrix Mode.

To enter Navigate Mode, do one of the following:
e Press Navigate.
e Press Menu, and then tap Navigate.

To move the matrix view, do any of the following:

Use the cursors to move the view one row or column at a time. You can also hold Shift and use the cursors to move eight
rows or columns at a time.

Use your finger to tap or drag to the desired location.

128



Mixer

In the Mixer, you can set levels, stereo panning, and other settings for your tracks, submixes, returns and
masters.

To open the Mixer, do either of the following:
e Press Menu, and then tap Mixer.

e Press Mixer.

1 "2 We HE:]
Kick Loop Top Loop Classic Bass Drum Kit

VOLUME PAN & VOLUME EFFECTS B SETTINGS

The Mixer works like an audio mixer with various settings for each track, with up to 8 tracks shown on the display at
once. The name of the track is displayed at the top of each one.

To select a track, tap it or press one of the track select buttons.

To view more tracks, use the left or right cursors. Alternatively, drag your finger left or right on the display.

To view the Submixes, quickly swipe your finger to the left on the display.

To view the Return and Master tracks, press the Master track select button. Alternatively, quickly swipe your finger to
the left on the display until the Returns and Master tracks are shown.

To open the Mixer configuration, tap the Settings icon in the lower-right corner of the screen to edit the Mixer
configuration.

Use the Solo Button field to set the behavior of the solo buttons. They can be used to either Solo Tracks or Cue
Tracks.

Use the Crossfader field to set the Profile of the crossfader, either Linear, Exponential or Logarithmic.
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Volume

The Volume tab gives you an overview of the volume level of your tracks.

VOLUME PAN & VOLUME EFFECTS X SETTINGS

Tap a level slider and then use the data dial or —/+ buttons to adjust the volume level of the currently selected
track, return or master. Alternatively, tap and drag a level slider to adjust the volume level.

The level sliders and meters in each pad show a visual representation of the level. Double-tap a track on the screen
to open a large version of the level slider and meter.

Pan & Volume

The Pan & Volume tab gives you a number of mixing options for your tracks.
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VOLUME PAN & VOLUME EFFECTS X SETTINGS

Use the M and S buttons to mute and solo the track. When Cue Tracks is enabled, the S button will become a
Headphones button.

Use the automation button to set the automation status of the track. See General Features > Automation for
more information on automation.

Use the record button to arm the track for recording.

The pan sliders in each track show a visual representation of the pan. Tap a pan slider and then use the data dial
or =/+ buttons to adjust the panning of the currently selected track, return or master. Double-tap a pan slider on the
screen to open a large version of the slider.

Tap a level slider and then use the data dial or —/+ buttons to adjust the volume of the currently selected track,
return or master. Double-tap a level slider on the screen to open a large version of the slider. Alternatively, tap and
drag a level slider to adjust the volume level.

Tap the A or B icons to assign the track to the crossfader A or B grouping.



Sends

The Sends tab gives you an overview of the Sends 1-4 level of your tracks.

*1 =2 We HE:]
Kick Loop Top Loop Classic Bass Drum Kit
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VOLUME PAN & VOLUME EFFECTS B SETTINGS

Use the M and S buttons to mute and solo the track. When Cue Tracks is enabled, the S button will become a
Headphones button.

Use the automation button to set the automation status of the track. See General Features > Automation for
more information on automation.

Use the record button to arm the track for recording.

Use the send knobs to adjust the send level of tracks. Tap the knob and use the data dial or —/+ buttons to adjust
the level.

To learn how to use send effects, please see General Features > Effects > Send/Return Effects.

Important: When using send channels, make sure you have already loaded at least one effect to it using the return
mixer. Press the Master button to view the Return channels and then select the Effects tab, described below.
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Effects

The Effects tab lets you view and edit insert effects for your tracks.
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VOLUME PAN & VOLUME EFFECTS B SETTINGS

Use the M and S buttons to mute and solo the track. When Cue Tracks is enabled, the S button will become a
Headphones button.

Use the automation button to set the automation status of the track. See General Features > Automation for
more information on automation.

Use the record button to arm the track for recording.
Tap the Inserts button to open the Inserts window.

Use the four insert fields to add insert effects to the track. Empty insert slots will show a + icon. Inserts with a
loaded effect will show the name of the effect.

To learn how to use insert effects, please see General Features > Effects > Insert Effects.
Tap the A or B icons to assign the track to the crossfader A or B grouping.

Press the Master button while viewing the Effects tab to view the Return and Output Insert effects slots.



I/0

The I/0 tab lets you view and edit audio and MIDI routing for your tracks.

»1 =2
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Input 1,2 All Ports Input 1,2 Input 1,2 All Ports All Ports Input 1,2 All Ports

All All All All
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Out 1,2 Out 1,2 Out1,2 Out 1,2 Out 1,2 Out1,2

VOLUME PAN & VOLUME EFFECTS B SETTINGS

Use the M and S buttons to mute and solo the track. When Cue Tracks is enabled, the S button will become a
Headphones button.

Use the automation button to set the automation status of the track. See General Features > Automation for
more information on automation.

Use the record button to arm the track for recording.
Tap the Monitor button to set the monitoring behavior.
For Audio tracks:
Off: The track's audio input is not monitored.
In: The track's audio input is monitored whether the track is record-enabled or not.
Auto: The track's audio input is monitored while the track is record-enabled only.
For MIDI tracks:

Off: The track's MIDI input is not monitored, and playback of recorded events will be heard. This setting is
useful when using keyboards with Local Control active.

In: The track's MIDI input is always monitored regardless of the track's Record Arm state, and playback
from recorded events will not be heard.

Auto: The track's MIDI input is monitored when the track is record armed, and playback of recorded events
will be heard.

Merge: The track's MIDI input is always monitored, and playback of recorded events will be heard.
Use the Input fields to select the input routing for the track.
For Audio tracks:
Use the Audio In field to configure the input source of the external audio signal, which you can set to a pair
of inputs (Input 1,2) or a single input (Input 1, Input 2).
For MIDI tracks:
Use the MIDI Input and Channel fields to configure the MIDI input settings.
Use the Send To field to send the track's MIDI output to another track.
Use the Output field to set the output routing for the track.
For Audio tracks:

Use the Audio Out field to configure where the track is routed, which you can set to a submix (Sub 1-8), a
pair of outputs (Out 1,2-Out 3,4), or a single output (Out 1-4).

For MIDI tracks:
Use the MIDI Output and Channel fields to configure the MIDI output settings.
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Pad Mixer

In the Pad Mixer, you can set levels, stereo panning, and other settings for individual pads. This mode is
only available for Drum and Keygroup tracks.

To open the Pad Mixer, do either of the following:
e Press Menu, and then tap Pad Mixer.

e Press and hold Shift and press Mixer.

VOLUME PAN & VOLUME EFFECTS B SETTINGS

Just like the track Mixer, the Pad Mixer works like an audio mixer with various settings for each pad, with up to 8 pads
shown on the display at once. The name of the pad is displayed at the top of each one.

To select a pad, tap it or press the respective clip select button in Note mode.
To view more pads, drag your finger left and right on the display.

To open the Pad Mixer configuration, tap the Settings icon in the lower-right corner of the screen to edit the Pad
Mixer configuration.

Check the Filter by events box to show only pads with events.
Check the Filter by samples box to show only pads with samples assigned.

Check the Write automation when recording box to set automation to always write when recording.
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Volume
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VOLUME PAN & VOLUME SENDS EFFECTS B SETTINGS

The Volume tab gives you an overview of the volume level of your pads.

Tap a level slider and then use the data dial or —/+ buttons to adjust the volume level of the currently selected pad.
Alternatively, tap and drag the level slider to adjust the volume level.

The level sliders and meters in each pad show a visual representation of the level. Double-tap a track on the screen
to open a large version of the level slider and meter.

Pan & Volume

VOLUME PAN & VOLUME EFFECTS B SETTINGS

Use the M and S buttons to mute and solo the pad.

The pan sliders in each track show a visual representation of the pan. Tap a pan slider and then use the data dial
or -/+ buttons to adjust the panning of the currently selected pad.

Tap a level slider and then use the data dial or —/+ buttons to adjust the volume of the currently selected pad.
Alternatively, tap and drag the level slider to adjust the volume level.
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Sends
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VOLUME PAN & VOLUME EFFECTS B SETTINGS

Use the M and S buttons to mute and solo the pad.

Use the send knobs to adjust the send level of the pads. Tap the knob and use the data dial or —/+ buttons to
adjust the level.

To learn how to use send effects, please see General Features > Effects > Send/Return Effects.

Important: When using send channels, make sure you have already loaded at least one effect to it using the return
mixer.



Effects

VOLUME PAN & VOLUME EFFECTS B SETTINGS

Use the M and S buttons to mute and solo the pad.
Tap the Inserts button to open the Inserts window.

Use the four insert fields to add insert effects to the pad. Empty insert slots will show a + icon. Inserts with a loaded
effect will show the name of the effect.

To learn how to use insert effects, please see General Features > Effects > Insert Effects.

1/0

Track Track Track Track

VOLUME PAN & VOLUME EFFECTS B SETTINGS

Use the M and S buttons to mute and solo the pad.

Use the Audio Out field to set the output routing for the pad. Select Track to output the pad to the track, or send it
directly to one of the outputs.
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Browser

The Browser lets you navigate your Force hardware’s internal and external hard disks to load samples, clips,
songs, etc. Using filter buttons and user-definable folders, you can easily adapt it to your preferred workflow.
You can also audition (preview) your samples before loading them.

Important: You can install an additional SATA drive in your Force hardware, allowing for even more storage
space. See Appendix > SATA Drive Installation to learn more about this.

Important: Force supports read and write capability for exFAT, FAT32, NTFS, and EXT4 file systems as well
as read-only capability for HFS+ file systems. We recommend using an exFAT file system as it is the most
robust one supported by both Windows and macQOS.

To show the Browser, do any of the following:

e Press Menu and then tap Browser.

e Press Load.
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In the Browser, you can do any of the following:

To browse your files by location, tap Places on the left side of the screen.
Internal is the internal drive of Force.
Force Documents is a shortcut to the Force Documents folder on the internal drive of Force.

If you have storage devices connected to USB ports or SD card slot of Force, they will appear in this column, as
well.

To browse your files by content, tap Content and then tap the type of file: Audio Clips, Instruments, Midi Clips,
Kits, Samples or Splice (see below to learn about these content buttons).

To browse your Expansions, tap Expansions.
To move up one folder level, tap the folder/L icon in the upper-left corner.
To move through a list, do any of the following:

e Swipe up or down

e Turn the data dial

e Use the -/+ buttons

e Tap Previous and Next at the bottom of the screen.

To sort the list, tap one of the file list headers to sort by Name, Size, Date Modified or Date Created. Tap the
header again to change the sorting direction. These can be added or removed using the Browser Options window.

To select a file or folder, tap it once.
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To enter a folder, double-tap it or tap Open in the lower-right corner. Alternatively, press the data dial to enter a
selected folder. You can also tap one of the folder buttons (1-5) in the upper-right corner to jump immediately to
those pre-assigned file paths (see below to learn how to assign these file paths).

To load a selected file, double-tap it, tap Load, or press the data dial. If the file is a sample, it will be loaded to the
project’s sample pool. If the file is a project, it will be loaded in its entirety (you will be asked if you want to close
your current project).

When loading files such as clips, samples or kits, you can also use the hardware -/+ buttons or the Previous and
Next function buttons on the display to move through the files and automatically load the selected file to your clip,
pad or track. If the previously selected file is not used elsewhere in your project, it will be deleted from memory.

To delete a selected file or folder, press and hold Shift and then tap Delete File at the bottom of the screen.
To preview a selected sound, tap and hold Play (») at the bottom of the screen.

To enable or disable the audition function and set its volume level, tap the speaker icon at the bottom of the
screen. In the screen that appears, tap Auto to enable or disable it, and tap and drag the level slider up or down to
set the volume level. Use the Sync and Warp buttons to audition samples and loops in time with your project. See
Addenda > Updates in Force 3.0.2 for more information. Tap the speaker icon once more to hide the window.

To show the information for the current storage device, press and hold Shift and then tap Drive Info at the bottom of
the screen. The drive’s information will appear in a new window. Tap OK to return to the previous screen.

To format a storage device to use an exFAT file system, select it in the Browser, press and hold Shift and then
tap Format Drive at the bottom of the screen. In the window that appears, tap OK and then Format in the next
window to format the device, or tap Cancel to return to the previous screen without formatting. This formatting
process will set the device to use the exFAT file system, remove any partitions from the drive, and erase all of its
content. (Devices that are uninitialized or do not have a file system will not be recognized by the Force hardware and
consequently cannot be formatted.)

To get the most efficient use of the Browser, set the file paths
to your favorite drive locations first. There are five folder
buttons labeled 1-5 in the upper-right corner. You can set
these to be shortcuts to five locations on your Force
hardware’s internal drive and/or any connected storage
devices, giving you quick access to your files.

To assign the current location to a folder button, press and
hold Shift, and then tap one of the folder buttons (1-5). Now,
when you tap that folder button again, the Browser will show
that folder’s content immediately.

Use the five filter buttons to show only specific types of files in
the list below. Folders will still be shown in the list.

To show project files only, tap the P/page icon.
To show pattern files only, tap the bars icon.

To show kit files only, tap the four-squares icon.

To show sample files only, tap the waveform icon.

To show all file types, tap the three-pages icon.
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To open the Browser Options window, tap the gear icon:

Check the Show file size box to display file size in the file list.

Check the Show modified date box to show the last date the file
was modified in the file list.

Check the Show created date to show the date the file was
created in the file list.

Check the Search includes subfolders box to enable recursive
searching. When enabled, all files, including those in subfolders,
will be appear in the search.

Check the Hide system folders box to disable system folder
types from appearing in the file list.

Use the six Content buttons to show specific locations in the internal
drive of Force and filter them automatically by file type:
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Audio Clips: Tap this button to enter the Expansions folder on
the internal drive, viewing audio files only.

Instruments: Tap this button to enter the Expansions folder on
the internal drive, viewing plugin preset files only.

Midi Clips: Tap this button to enter the Expansions folder on the
internal drive, viewing pattern files only.

Kits: Tap this button to enter the Expansions folder on the
internal drive, viewing kit files only.

Samples: Tap this button to enter the Expansions folder on the
internal drive, viewing sample files only.

Splice: Tap this button to enter the Splice folder on the selected
drive, where you can view samples that have been downloaded
from a linked Splice account. See Addenda > Updates in Force
3.0.2 for more information on how to use Splice.

BROWSER OPTIONS




Arrange Mode

Arrange Mode is a fully-featured linear sequencer where you can record a clip performance or live input (MIDI
or audio) into a linear timeline to create an arrangement of a song. You can use the powerful Arrange Edit
commands to edit and arrange your song and then mix it down to a stereo audio file, or stem it as separate
ARRANGE tracks.

To enter Arrange Mode, press Menu and then tap Arrange. The event editor's Arrange, Grid, Clip and List views are
displayed as tabs in the top left of the screen to make it easy to jump between them.

© MIDI REC ERASE
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The toolbar at the top of Arrange Mode lets you switch between the different edit modes as well as showing project and
timing information.

Use the Arrange, Grid, Clip and List icons to switch between the different Force modes.

Tap the automation icon to toggle between Read and Write. To disable or enable global automation entirely, press
and hold Shift and tap this icon.

Use the BPM field to adjust the tempo of the project.
Use the Bars field to set the length of the arrangement.

The time counter at the top of the screen indicates the current playhead position. Double-tap this field to open the
Locate Popup.

Tap the pencil icon to open the Arrange Edit window.

Tap the gear icon to open the Grid Settings.
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© MIDI REC ERASE D>BACK TO ARRANGE

The project's tracks are displayed in Arrange Mode on a linear timeline. Each track header will show Record Arm, Track
Automation and Crossfader Assign states. Note that this requires the vertical zoom to be adjusted so there is enough
space to show all components. Use the pinch and expand gestures to change the zoom level of the arrangement.

To open the Timing Correct window, tap TC at the bottom of the screen. Alternatively, tap the timing correct value
shown above the track headers. See General Features > Timing Correct (TC) to learn about this.

To enable or disable MIDI record erasing in Arrange Mode, tap the MIDI Rec Erase button at the bottom of the
screen. When enabled, the new recording will replace existing MIDI data in the arrangement. When disabled, recording
MIDI will overdub on existing MIDI data in the track arrangement.

To enable or disable loop, tap Loop at the bottom of the screen.

To return playback of all tracks to the recorded arrangement, tap the Back to Arrange button.

The Arrangement timeline also features six user-controllable Locate markers. Press and hold Shift to show the six
Locator buttons at the bottom of the screen.

To add a locator at the playhead position, tap one of the six Locator buttons. You can also use the Locate
Popup to edit these markers.

To record a clip performance into Force's arrangement timeline:

1. You must first configure the Record button to point to the
linear arrangement rather than the clip matrix. You can set this ESzEREdEbIe
by doing either of the following:

e Hold Shift and press the REC button. 73

e Press and hold the REC button to open the Start
Recording Selector window, and then tap To [CEIE I [C AR et HEDIe
Arrangement.

Next, enter Arrange mode by pressing Menu and tapping Arrange.

3. Trigger a clip or scene to begin recording. As clips are triggered, Arrange Mode will draw regions containing
audio or MIDI data into the track lanes.
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To replace a section of the arrangement with a new clip performance:
1. Tap the Loop button at the bottom of the screen to activate loop.

2. Set the Loop Start and Loop End points by tapping and dragging the beginning and end of the loop region in
the timeline. Tapping and dragging in the middle of the loop region moves both the Loop Start and Loop End
points at the same time.

Enable arrangement recording by following the directions above.

Trigger a clip or scene to begin recording. The recording will begin at the Loop Start point and finishes at the
Loop End point, making it easy to replace a section of the arrangement.

To play the arrangement:
e Press Play to begin playback of the arrangement from 1:1:00, or if Loop is activated, from the Loop Start.

e Hold Shift and press Play to begin playback from the current playhead position.

To move the playhead position, tap the Playhead Position field in the toolbar to select it, and then use the data dial or
-/+ buttons to adjust the value. Alternatively, you can set the playhead position by tapping in the lower-half of the
timeline.

Switching Between the Arrangement and Clips

For each track in Force, you can play a clip or play the linear arrangement, but never both at the same time. When you
trigger a clip, the arrangement on that track will stop playing; conversely, if you are triggering clips and then play the
arrangement, the clips will stop.

In Arrange Mode, a track will show the Back to Track icon (a square with a play symbol shown on the right side of the
track lane) when either there is a clip playing or the Stop All button has been pressed.

To return playback of a track to its linear arrangement, simply tap the Back to Track icon.

To return all tracks to the linear arrangement, tap the Back to Arrange button at the bottom of the screen in
Arrange Mode.

You can also set the track's playback type from Matrix mode or Force's launch pad mode. Hold Shift and press the
Launch button to open the Launch Config window. Select the Show arrangement in clip matrix option so it is
enabled. The arrangement row will appear as the top row of pads above the first row of clips in Matrix/Launch mode.
Tapping a pad in the arrangement row will stop playing any clips on the respective track and play the linear
arrangement. Tapping the Scene Launch button for the arrangement row will play the linear arrangement for all tracks.
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Editing Arrangements

You can edit your linear arrangement using Force's powerful Arrange Edit commands.

To edit an arrangement, tap the pencil icon in the Arrange Mode toolbar to open the Arrange Edit window, and
then select one of the following tools.

ARRANGE EDIT

Half length

The Erase function erases all or part of a track.

@\ ERASE
To select the track you want to erase within the sequence, use

the Track field. Hype Chords

To set the time range of the track you want to erase, use the
Bar, Beat, and Tick fields. The left fields set the start of the time
range, and the right fields set the end of the time range.

To select what types of events you erase, select one of the
Erase options:

All erases all pad events from the designated time range and
reset all of its settings.

Automation erases only automation from the designated time
range. Use the Parameter field to select what type of
automation is erased.

To confirm your choice, tap Do It.

To cancel and return to the previous screen, tap the X, Cancel,
or anywhere outside the window.

The Clear function erases all events from the track and resets all of
its settings.

To confirm your choice, tap Clear. bl

To return to the previous screen, tap Cancel.

Are you sure you want to clear this Arrangement?

The Trim function immediately crops the arrangement to the Bars
value in the main Arrangement Mode window.
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The Transpose function transposes a range of events on a track in an
arrangement. The events within that range will shift accordingly in the ! R
Grid View. This option is available for MIDI tracks only.

Classic Bass

To select the track you want to transpose within the
arrangement, use the Track field.

To set the time range of the arrangement you want to
transpose, use the two sets of Bar, Beat, and Tick fields. The left
fields set the start of the time range, and the right fields set the
end of the time range.

For drum tracks, use the two Pad fields to select the “source” pad
(whose events you want to move) and “destination” pad (where the

events will be placed). Tap each field and then press the desired

pad.

For keygroup tracks, plugin tracks, and MIDI tracks, set the
range and amount of transposition:

Range: Use the two Note fields to set the range of notes of
the events you want to transpose. Note events within this
range will be transposed, while note events outside of this
range will remain unchanged.

Transpose: Use this field to set how many semitones up or
down you want to transpose the note events.

To confirm your choice, tap Do It.

To cancel and return to the previous screen, tap the X, Cancel,
or anywhere outside the window.

The Delete Bars function removes a range of bars from the
arrangement.

To set the range of bars to delete from the arrangement, use
the First Bar and Last Bar fields.

[FT] DELETEBARS

To confirm your choice, tap Do It.

To cancel and return to the previous screen, tap the X, Cancel,
or anywhere outside the window.

The Insert Bars function adds a number of bars to the arrangement.
To set how many bars to add, use the # of bars field.

To set where the bars are added, use the Before Bar field. The A0 CEETE
bars will be inserted before this bar.

To confirm your choice, tap Do It.

To cancel and return to the previous screen, tap the X, Cancel,
or anywhere outside the window.

The Half Length function immediately halves the length of the
arrangement.

The Double Length function immediately doubles the length of the
arrangement.
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The Copy Bars function copies a range of bars from the arrangement
and adds them at a specified point.

To set the range of bars to copy from the arrangement, use
the First Bar and Last Bar fields.

To set where you want to add the copied bars, use the After
Bar field. The copied bars will be inserted after this one.

To set how many instances of the copied bars you want to
add, use the Copies field.

To overwrite the arrangement at the destination, tap Replace.

To add the events to the destination without erasing anything,
tap Merge.

To cancel and return to Arrange Mode, tap Cancel.

The Copy Events function copies a range of events or selected audio
track regions from the arrangement and adds them to another at a
specified point.
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To select the “source” track, use the From Track field. This is the
track whose content you want to copy.

To set what content is copied, use the field below the From
Track field. Copy All Events will copy and paste all events in the
track. Copy Only Selected Events will copy and paste only the
events that are currently selected.

To set the time range of the events or the audio track you
want to copy, use the Bar, Beat, and Tick fields. The left fields
set the start of the time range, and the right fields set the end of
the time range.

To select the “destination” track, use the To Track field. This is
the track where the content of the source track will be copied.

To set where you want to add the copied events or audio
track, use the Bar, Beat, and Tick fields. The events or audio
track will be added after this point.

To set how many instances of the copied events or audio
track you want to add, use the Copies field.

To overwrite the arrangement at the destination, tap Replace.

To add the events to the arrangement at the destination
without erasing anything, tap Merge.

To cancel and return to Arrange Mode, tap Cancel.

[ copyBaRs
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Copy All Events
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Clear

Copy Track

Copy Events

Reset Channel Strip

Bounce To Sample

Flatten Track

Flatten Track Elastique

© MIDI REC ERASE

In Arrange Mode, you can tap and hold on the header for an audio track (on the left side of the screen) to open a drop-
down menu of Track Edit options for audio tracks.

The Clear function erases all events from the track and resets all of its settings.
To confirm your choice, tap Clear.

To return to the previous screen, tap Cancel.

The Copy Track function immediately duplicates the selected track to a new track.

The Copy Events function copies selected audio track regions from the track and adds them to another at a specified
point.

To select the “source” track, use the From Track field. This is the track whose content you want to copy.

To set what content is copied, use the field below the From Track field. Copy All Events will copy and paste all
events in the track. Copy Only Selected Events will copy and paste only the events that are currently selected.

To set the time range of the events or the audio track you want to copy, use the Bar, Beat, and Tick fields. The
left fields set the start of the time range, and the right fields set the end of the time range.

To select the “destination” track, use the To Track field. This is the track where the content of the source track
will be copied.

To set where you want to add the copied events or audio track, use the Bar, Beat, and Tick fields. The events
or audio track will be added after this point.

To set how many instances of the copied events or audio track you want to add, use the Copies field.
To overwrite the arrangement at the destination, tap Replace.
To add the events to the arrangement at the destination without erasing anything, tap Merge.

To cancel and return to Arrange Mode, tap Cancel.
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The Reset Channel Strip function immediately:
e clears all Insert effect slots;
¢ turns Mute, Solo, automation, and Monitor off;
e resets the pan knob to the center;
e resets the level slider to 0.00 dB; and

e turns the Record Arm button off.

The Bounce to Sample function immediately renders the track as an audio sample and places it in the project’s
sample pool. By default, it will be named Bounce - and appended with the track name.

The Flatten Track function immediately renders all edits and regions within the current track's arrangement to a new
audio file.

The Flatten Track Elastique function also immediately renders all edits and regions within the current track's
arrangement to a new audio file, but renders any time-stretching or pitch-shifting using the Elastique Pro algorithm,
providing higher-quality results with less artifacts than Force's standard algorithm.
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Copy Track

Copy Events

Double-Speed

Half-Speed

Pitch Quantize

Random Events

Bounce To Sample

Bounce To Audio Track

© MIDI REC ERASE

You can also tap and hold on the header for a MIDI track (on the left side of the screen) to open a drop-down menu of
Track Edit options for MIDI tracks.

The Clear function erases all events from the track and resets all of its settings.
To confirm your choice, tap Clear.

To return to the previous screen, tap Cancel.

The Copy Track function immediately duplicates the selected track to a new track.

The Copy Events function copies a range of events from the
arrangement and adds them to another at a specified point.

[Z3 COPYEVENTS

To select the “source” track, use the From Track field. This is the Hype Chords

track whose content you want to copy. S —

To set what content is copied, use the field below the From
Track field. Copy All Events will copy and paste all events in the
track. Copy Only Selected Events will copy and paste only the
events that are currently selected.

To set the time range of the events or the audio track you
want to copy, use the Bar, Beat, and Tick fields. The left fields o
set the start of the time range, and the right fields set the end of

the time range.

To select the “destination” track, use the To Track field. This is
the track where the content of the source track will be copied.

To set where you want to add the copied events or audio
track, use the Bar, Beat, and Tick fields. The events or audio
track will be added after this point.

To set how many instances of the copied events or audio
track you want to add, use the Copies field.

To overwrite the arrangement at the destination, tap Replace.

To add the events to the arrangement at the destination
without erasing anything, tap Merge.

To cancel and return to Arrange Mode, tap Cancel.
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The Double-Speed Events function immediately halves the lengths of all note events on the track in the arrangement
as well as the distance between them. In other words, the track’s notes are pressed closer together so the track sounds
like it is playing at twice the previous speed. This does not actually affect the pitches of notes or the tempo.

The Half-Speed Events function immediately doubles the lengths of all note events on the track in the arrangement as
well as the distance between them. In other words, the track’s notes are spread further apart so the track sounds like it
is playing at half of the previous speed. This does not actually affect the pitches of notes or the tempo.

The Pitch Quantize function forces the pitches of note events into a
specific scale.

To select the desired root note of the scale, use the Root Note
field.

To select a type of scale, use the Scale field.
To determine which note events will be quantized, tap the Only
apply to selected events checkbox.

When on, only the currently selected note events will be
quantized.

When off, all pitches in the current track will be quantized.
To set lowest-possible and highest-possible pitches where the
quantized note events will be placed, use the Start Note and
End Note fields (respectively). If a note event is originally outside of

this range, it will be forced to the nearest pitch (within the scale)
inside the range.

To continue and quantize the note events, tap Do It.

To cancel, tap Close.

The Random Events function creates random melodic or drum
patterns on the current MIDI track in the arrangement.
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To select the type of events you want to create, use the Event
Type field to select Drum Events or Melodic Events.

To select how the events will be created relative to the
existing events on the track, use the Replace field:

Replace All Events: Select this option to replace all events on
the track with the randomly generated ones.

Replace Events in Note Range: Select this option to replace
all events in the designated note range on the track with the
randomly generated ones. Use the Bank or Start Pad and
End Pad menus to set the note range for drum events or the
Start Note and End Note menus to set the note range for
melodic events.

Add to Existing Events: Select this option to add the
randomly generated events to the track without replacing or
overwriting the existing ones.

To set how many bars the events will use, use the Pattern Size
(Bars) field. The highest possible value is the number of bars in
the current sequence.

To select the duration of the events, use the Note Length field.
(This feature is nonfunctional if Legato is enabled while
generating melodic events.)

To generate the events and keep this window open, tap Apply.
To generate the events and close the window, tap Do It.

To close the window without generating any events, tap Close.

PITCH QUANTIZE

Setup

C

Note Input Filter

Output Note Range

Quantized notes will be moved up/down by an octave to fit into this note range.

GENERATE RANDOM EVENTS

Generation

Melodic events

Replace all events

37

Melodic event options
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If Event Type is set to Drum Events:

GENERATE RANDOM EVENTS

To select the pad bank that will be used to generate the
events, use the Bank field or select Range to use the Start
Pad and End Pad menus to define a specific pad range Drumevents
instead.

Generation

Replace all events

To define a specific pad range over which the events will
be generated, use the Start Pad or End Pad fields. You 32
can use these fields only if the Bank menu is set to Range. AT

To set how closely together the events will be placed in 2
the track, use the Density (%) slider.

To set how widely or narrowly the rhythmic patterns of the
generated notes vary, use the Rhythm Variation slider.

If Event Type is set to Melodic Events:

To define a specific note range over which the events will
be generated, use the Start Note or End Note fields.

Generation

Melodic events

To enable or disable legato, tap the Legato checkbox.

When on, the generated notes will be extended or e
shortened to create a long, unbroken phrase from the
first note event’s start point to the last note event’s end
point. Each note event will sustain until another note
event starts. If multiple note events start at the same @
time (and are not the last note events), their lengths will
become identical.

When off, the generated notes will use the duration set by
the Note Length menu.
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Melodic event options

To set the maximum number of note events that can be
sounding simultaneously in the track, use the Polyphony
field to select 1-8.

To determine whether or not the notes will use a scale, tap
the Constrain Notes to Scale checkbox.

When on, the notes will be within the scale determined by
the Scale menu.

When off, the notes will be chromatic.

To set how closely together the events will be placed in
the track, use the Density (%) slider.

To set the root note of the scale that the notes will use,
use the Root Note field.

To select the scale or mode that the generated notes will
use, use the Scale field.

The Bounce to Sample function immediately renders the track as an audio sample and places it in the project’s
sample pool. By default, it will be named Bounce - and appended with the track name. This function does not work for
MIDI or CV tracks.

The Bounce to Audio Track function immediately renders the track as an audio track in the project. By default, it will
be named Audio and appended with a number (e.g., Audio 002). This function does not work for MIDI or CV tracks.
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Arrangement Track Editor

When in Arrange Mode, events from the currently selected track can be edited using the bottom panel track editor.
To open the track editor, do either of the following:
e Tap the arrow up icon at the bottom of the screen.

e Double-tap inside a track lane in the main arrangement view.
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Once opened, you can also adjust the height of the track editor by tapping and dragging the arrow icon or anywhere in
the editor toolbar.

For drum tracks, you can tap and hold on a pad header in the track editor to open a drop-down menu where you can
quickly Mute, Solo, or change the Color of the pad.

To close the track editor, tap the down arrow icon.

At the top of the Track Editor are two tabs, Grid and Auto. Use the Grid tab to edit MIDI events or audio regions. Use
the Auto tab to edit automation for the track. The editing workflow in the arrangement track editor is the same as in Clip
Mode, except that the arrangement track editor is fixed to editing the arrangement event list, whereas the clip editor
follows the currently selected clip or arrangement event list.

To edit a track from your arrangement using Clip Edit Mode, make sure the arrangement is playing and the
desired track is selected (you can check this by making sure the Back to Track icon is not displayed on the
selected track). Then, open Clip Edit Mode to edit the arrangement track.

Press and hold Shift to view additional editing options for the Track Editor.
To select all events, tap Select All.
To cut the selected events, tap Cut.
To copy the selected events, tap Copy.
To paste the selected events at the playhead location, tap Paste.
To delete the selected events, tap Delete.

To duplicate the selected events, tap Duplicate. The events will be added after the last selected event.
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Locate Popup

Force now includes a popup window for the Locate function, allowing you to quickly jump to specific points in your
project.

To open the Locate popup, double-tap the Bars:Beats:Ticks field in the toolbar.

® LOCATE

® LOCATE

Locator 1
Locator 2

Locator 3

AUTO RECORD

The Locate popup is divided into two sections:

The Time tab is used to adjust the position of the playhead in the arrangement, as well as adjust Loop and Record
settings.

To move the playhead in the arrangement, use the Bars:Beats:Ticks fields. You can also tap the Step and
Bars arrow buttons to move the playhead by the specified amount.

To enable loop in the arrangement, tap the Loop button. Use the Loop Start and Loop End fields to set the
length of the loop. Alternatively, you can set the loop length according to the Locator markers in the timeline.
When Set Loop Range By Locator is set to On, the loop range will automatically adjust to the length between
the selected Locator and the next Locator. The current loop region is always displayed in the timeline of the
arrangement whether it is activated or not.

To enable automatic recording when the loop starts, use the Auto Record field. When enabled, recording
will begin immediately when the arrangement loops.

The Locators tab is used to edit the six Locator markers which can be applied to the timeline.
To add a locator, tap Set.
To rename a locator, tap the keyboard icon, and then use the keyboard to enter a new name.
To adjust the position of the locator, use the Bars:Beats:Ticks fields.
To edit the color of the locator, tap the eyedropper icon, and then select a color from the list.

To delete the locator, tap the Xicon.

To close the Locate window, tap Close, the X in the upper-right corner, or anywhere outside the window to return
to the arrangement.
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Saving and Exporting the Arrangement

& Audio Mixdown

B START BAR END BAR AUDIO TAIL 1 SECONDS
o

Project ProjectAs New Project
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n il

Track Track FX Rack Sample SEPARATE TRACKS

SAVE AS PROJECT PREVIEW

Clip as Audio All Clips Audio Mixdown  Ableton Live Set

FILE FORMAT WAV BITDEPTH SAMPLERATE 44,1 kHz

To save and export your arrangement, press the Save button, and then select Audio Mixdown. In this window, you
can mixdown or stem your arrangement into individual files.

To set the time range that you want to mixdown, use the Start Bar and End Bar fields under Audio Length. You
can add a number of seconds to the end of the mixdown to capture any ringing notes or effects (such as a reverb
tail) by adjusting the Audio Tail field.

To set the parameters for the audio mixdown, use the fields under Render Source and Render Options. Check
the Separate Tracks box to render each track of the arrangement as stems.

To configure the audio mixdown file settings, use the fields at the bottom of the screen to set the File Format,
Bit Depth, and Sample Rate.

You can also export the arrangement as a clip row in an ALS file to use with Ableton Live.

To save the arrangement as a clip row, press the Save button to bring up the Ableton Live Set Export popup, and
then select the Export Arrange as Clips option.



Grid Mode

Grid Mode (formerly Event View for MIDI tracks and Region View for audio tracks) lets you view and edit
the note events or audio regions of each clip of a track in a project and their velocities. This mode has
three different appearances: one for audio tracks, one for drum tracks and one for keygroup tracks, MIDI
tracks, and plugin tracks.

To enter Grid Mode, press Menu and then tap Grid. You can also tap Grid at the top of the screen in Arrange Mode,
Clip Mode, or List Mode.

For audio tracks, the waveform of the audio clip is shown.
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For drum tracks, the left column shows you all available pads in a
vertical view with their corresponding events in the grid to the right.

Velocity
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For keygroup, plugin, MIDI and CV tracks, the left column shows a
vertical “piano roll” keyboard with the corresponding events in the grid
to the right.
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In all views, the time counter at the top of the screen indicates the current playhead position.

Additionally, the Settings window lets you configure certain Grid Mode
settings.

To view the Settings, tap the gear icon. {3 GaDsETTINGS

Use the Snap Mode selector to set how events “snap” to the grid.

Absolute: Events will “snap” to the nearest time division on the
grid (as determined by the TC field or Time Correct window). This
is the typical and traditional method of using the snap/
quantization feature.

Relative: Events will “snap” to the nearest time division on the
grid (as determined by the TC field or Time Correct window) plus
the original time position of the event (e.g., an event that is
originally three ticks past a time division on the grid will snap only
to positions that are three ticks past every time division).

Use the Hitting Pad Selects All Events selector to turn the feature on or off. When On, pressing a pad will
automatically select all note events for that pad in the selected clip on that track. When set to Off, pressing a pad will
simply play its sound without selecting any note events.

This setting is not available when using audio clips.

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead.
Follow: The list will scroll along in the background while keeping the audio playhead centered.
Page: The list will move to the “next page” to follow the audio playhead.

Off: The list will not move at all.

These functions also apply to Arrange Mode and Clip Mode.



Audio Tracks

When viewing audio clips In Grid Mode, these seven tool icons at the top of the screen enable you to use different
functions in the clip.

%

Tap one to select its mode:

Marquee: Marquee Mode:

To select a clip region, tap the upper third of it.
To move a clip region (or multiple selected clip regions), tap and drag the upper third of it left or right.

To split the clip at two specific points (creating a clip region on either side and between them), tap and drag
across the middle third of it to create a translucent white box, and then tap the upper third of that box.

To shorten or lengthen a clip region (or multiple selected clip regions), tap and drag the lower third of it left
or right.

Arrow: Selection Mode:

To select a clip region, tap it.

E2

To move a clip region (or multiple selected clip regions), tap and drag the upper third of it left or right.

To shorten or lengthen a clip region (or multiple selected clip regions), tap and drag the lower third of it left
or right.

Pencil: Draw Mode:

To draw automation, open the velocity/automation lane and tap and drag.

Eraser: Erase Mode:

To erase a clip region (or multiple selected clip regions), tap it.

Scissors: Split Mode:
To split the clip at a specific point (creating a clip region on either side), tap that point in the clip.
To select a clip region, tap its left-most edge.

Mute: Mute Mode:

To mute or unmute a clip region (or multiple selected clip regions), tap it.

Magnifying Glass: Navigation Mode:

To move to another part of the clip, tap and drag it.

B EEA

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically,
horizontally, or both at the same time.
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Tap the pencil Edit icon to open the Grid Edit menu for audio clips:

Use Trim Audio to Clip to trim the audio sample to the size of the clip.

Use Clear Regions to clear the audio sample from the clip.

Use Export as Audio to save the current clip as an audio file.
Use the Base File Name field to name the resulting export based on the Clip name or Track name.
Check the Include Track Volume/Pan Settings box to include these settings in the export.
Check the Bypass Track Effects Plugins box to not include track effects plugins in the export.

Use the Audio Tail field to set the amount, in seconds, of extra time added to the end of the resulting audio
files.

Use the Bit Depth field to set the bit depth to 8, 16 or 24.

Use the Sample Rate field to set the sample rate to 44.1, 48, 88.2 or 96 kHz. In most cases, we recommend
selecting 44.1 kHz.

Use Flatten Clip or Flatten Elastique to flatten the audio clip, rendering all the edits and regions within the clip
bounds to a new audio clip in a single audio file. See Addenda > Updates in Force 3.0.5 > New Features >
Flatten Clip for more information.

Regardless of which tool is selected, you can do any of the following to edit the selected audio clip regions.

Tip: If you want to hear only the audio track while editing, press the Solo button and press the relevant Track Assign
button to solo it.

To select a clip region, tap the arrow icon to enter Selection Mode and tap a clip region. When a clip region is
selected, all region parameters will be available to edit.

To undo your last action, press Undo.
To redo the last action you undid, press Shift+Undo/Redo.

To move the selected clip region, tap Nudge at the bottom of the screen, and then use the data dial or —/+
buttons to shift the clip region left or right. Alternatively, if the arrow tool or marquee tool are selected, tap and
drag the upper third of the selected clip region left or right. By default, you can move a clip region only by
quantization values defined by the Time Correct value (see General Features > Timing Correct (TC) to learn
about this).

To move the selected clip region without restricting (“snapping”) it to the quantization grid, tap and hold Don’t
Snap in the lower-left corner of the screen, and then use the data dial or =/+ buttons to shift the clip region. In this
case, each nudge is equivalent to four ticks.

To adjust the start point or end point of the selected clip region (without changing its position), tap Edit Start at
the bottom of the screen, and then use the data dial or —/+ buttons.

To split the clip at the current playhead position (creating a clip region on either side), tap Split at the bottom of
the screen.

To copy, cut, or paste the selected clip region, press Copy or
press and hold Shift, and then tap Copy or Cut. Turn the data
dial to move the highlighted clip region, and then press the data
dial to paste it at its current location. Alternatively, press and hold
Shift, and then tap Paste (respectively).

To duplicate the selected clip region, tap Duplicate at the
bottom of the screen. The duplicate clip region will appear
immediately after the original one.

To create a fade-in or fade out for the selected clip region, use the Fade In or Fade Out fields, respectively. The
fades will be shown as a sloped line at the start or end of the clip region.

To set the level of the selected clip region, use the Level field. The waveform amplitude will change accordingly.



To reverse the selected clip region, tap Reverse.

To mute the selected clip region, tap Mute.

To lengthen or shorten the selected clip region without changing its pitch, tap Warp, which will enable the
Semi, Fine, and BPM fields next to it. Use the BPM field to change the tempo, which will change the length of the
clip region accordingly. Use the Semi and Fine fields if you want to change the pitch (this is useful for matching the
durations of two samples with different pitches).

Tip: You can configure audio track recording to ensure the resulting clip region is warped automatically. You can then
adjust the project tempo while clip region remains in time. See Menu > Preferences > General to learn about this.

Note: When you record an audio file, the current project tempo will be embedded with it. This information is stored
within the sample file when you save the project. When you warp an audio clip region, the warping algorithm uses this
project tempo and the current value in the BPM field to generate the “stretch factor.”

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too
freely. Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by
doing any/all of the following:

Minimize the amount of pitch adjustment (e.g., the Semi and Fine fields).
Avoid warping very small clip regions.

Warp as few tracks or clip regions as possible (i.e., reduce the number of total number of voices [of the
polyphonic limit] that use the warp algorithm at a given time), especially instances where the warped regions
start at the same time.

If you have warped samples used in a drum kit, consider using the Flatten Pad function to consolidate the
affected pad’s layers into one audio sample (see here to learn about this). After you flatten the pad, its
sample/samples no longer need to be warped.

To open the Timing Correct window, press and hold Shift, and then tap TC at the bottom of the screen. See
General Features > Timing Correct (TC) to learn about this.

To mute or solo the clip, press and hold Shift, and then tap Mute or Solo (respectively) at the bottom of the
screen.
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MIDI Tracks

When viewing MIDI tracks in Grid Mode, use these four tool icons at the top of the screen to use different functions in
the grid.

Tap one to select its mode:

Pencil: Draw Mode:
% To enter a note in an empty grid square, tap the grid square.

To select a note, tap it.
To move a note, tap and drag it to another grid square.
To erase a note, double-tap it.

To edit velocity or draw automation, tap and drag in the velocity/automation lane.

Eraser: Erase Mode:

To erase a note, tap it. You can also tap and drag to erase multiple notes in the same row.

Select Box: Select Mode:

Note: Notes will remain selected if you switch to another mode. The selection will change, however, if you
press a pad while Hitting Pad Selects All Events is set to On.

To select a note, tap it.

To select multiple notes, tap and drag across the grid to create a box around them.
To move a note, tap and drag it to another grid square.

To move multiple notes, select them as described above, and tap and drag them.

To erase multiple notes, select them as described above, and then select the eraser tool and tap any of
the selected notes.

Magnifying Glass: Navigation Mode:
®\ To move to another part of the grid, tap and drag it.

To zoom in or out, spread or pinch your fingers (respectively) on the grid. You can do this vertically,
horizontally, or both at the same time.
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Velocity

DON'T SNAP NUDGE EDIT START EDIT END TRANSPOSE VELOCITY

Regardless of which tool is selected, you can do any of the following to move, lengthen, shorten, or transpose any
selected note/notes.

To automatically set the grid to view one pad bank and two bars, tap the grid-and-magnifying-glass icon in
the upper-left corner.

To undo your last action, press Undo.
To redo the last action you undid, press Shift+Undo.
To select all notes for a pad, press the desired pad.

To move the selected notes, tap Nudge at the bottom of the screen, and then use the data dial or =/+ buttons to
shift the notes left or right. By default, you can position notes only by quantization values defined by the Time
Correct value (see General Features > Timing Correct (TC) to learn about this).

To move the selected notes without restricting (“snapping”) them to the quantization grid, tap and hold Don’t
Snap in the lower-left corner of the screen, and then use the data dial or —/+ buttons to shift the notes. In this case,
each nudge is equivalent to four ticks.

To adjust the start point or end point of the selected notes (without changing their position), tap Edit Start or
Edit End at the bottom of the screen, and then use the data dial or —/+ buttons.

To transpose the selected notes up or down, tap Transpose at the bottom of the screen, and then use the data
dial or -/+ buttons.

To copy the selected notes instantly, press and hold Shift and then tap Copy at the bottom of the screen. The
selected notes will be duplicated and start immediately after the end of the last selected note. Nudge will be
automatically selected so you can immediately use the data dial to move the copied notes.

To cut the selected notes, press and hold Shift and then tap Cut at the bottom of the screen. The selected notes
will be copied and removed from the grid.

To paste the copied notes, press and hold Shift and then tap Paste at the bottom of the screen. The selected
notes will be pasted at the playhead location.

To open the Timing Correct window, press and hold Shift and then tap TC at the bottom of the screen. See General
Features > Timing Correct (TC) to learn about this.
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Tap the pencil editing icon next to the time counter to open the event editing window. You can use any of these
functions as described below.

To return to Grid Mode, tap Cancel or tap at the top of the screen.

The Clear Events function erases all events from the clip and resets all of its settings.
To confirm your choice, tap Clear.

To return to the previous screen, tap Cancel.

The Trim to clip function immediately cuts all note events from outside the clip bounds.

The Double-Speed Events function immediately halves the lengths of all note events in the clip as well as the distance
between them. In other words, all notes are pressed closer together so the clip sounds like it is playing at twice the
previous speed. This does not actually affect the pitches of notes or the tempo.

The Half-Speed Events function immediately doubles the lengths of all note events in the clip as well as the distance
between them. In other words, all notes are spread further apart so the clip sounds like it is playing at half of the
previous speed. This does not actually affect the pitches of notes or the tempo.

The Pitch Quantize function forces the pitches of note events into a

specific scale. PrTCH QuANTIZE
Setup
To select the desired root note of the scale, use the Root Note
field. €
. Note Input Filter
To select a type of scale, use the Scale field.
To determine which note events will be quantized, tap the Only Output Note Range
apply to selected events checkbox. Quantized notes will be moved up/down by an octave tofit into this note range.
When on, only the currently selected note events will be 2
quantized.

When off, all pitches in the current clip will be quantized.

To set lowest-possible and highest-possible pitches where the
quantized note events will be placed, use the Start Note and
End Note fields (respectively). If a note event is originally outside of
this range, it will be forced to the nearest pitch (within the scale)
inside the range.

To continue and quantize the note events, tap Do It.

To cancel, tap Close.
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The Humanize function applies randomization to the timing, length,
and/or velocity of note events.

HUMANIZE

Time
To select whether or not humanization will be applied to the &
timing of note events, tap the Humanize Time checkbox.

To select the maximum number of pulses by which the timing
of an event will be adjusted, use the Amount (Pulses) slider.

To set how dramatically the humanization effect is applied to
the timing, use the Eagerness slider. Negative values correspond
to playing “ahead of the beat” while positive values correspond to
playing “behind the beat.”

To set whether or not humanization will be applied to the
duration of note events, tap the Humanize Note Length
checkbox. e

To set how dramatically the humanization effect is applied to es
note lengths, use the Length (%) slider.

To set whether or not humanization will be applied to the =
velocities of note events, tap the Humanize Velocity checkbox. ——

To set how dramatically the humanization effect is applied to
note velocities, use the Strength (%) slider.

To determine which notes will use these humanization values,
tap the Only Apply to Selected Events checkbox.

When on, just the currently selected notes will be humanized.
When off, all notes in the clip will be humanized.

To apply humanization and keep this window open, tap Apply.
To apply humanization and close the window, tap Do It.
To close the window without making any changes, tap Close.

The Generate Random Events function creates random melodic or
drum patterns in the current clip. CENERATE RANDOM EVENTS

Generation

To select the type of events you want to create, use the Event
Type field to select Drum Events or Melodic Events. Drum events

To select how the events will be created relative to the
existing events on the track, use the Replace field:

Replace All Events: Select this option to replace all events in 2
the clip with the randomly generated ones. Zum eentoptons

Replace Events in Note Range: Select this option to replace Range
all events in the designated note range in the clip with the
randomly generated ones. Use the Bank or Start Pad and
End Pad menus to set the note range for drum events or the
Start Note and End Note menus to set the note range for
melodic events.

Add to Existing Events: Select this option to add the

randomly generated events to the clip without replacing or
overwriting the existing ones.

Replace all events

To set how many bars the events will use, use the Pattern Size
(Bars) field. The highest possible value is the number of bars in
the current clip.

To select the duration of the events, use the Note Length field.
(This feature is nonfunctional if Legato is enabled while generating
melodic events.)

To generate the events and keep this window open, tap Apply.
To generate the events and close the window, tap Do It.
To close the window without generating any events, tap Close.

163



If Event Type is set to Drum Events:

To select the pad bank that will be used to generate the .
events, use the Bank field or select Range to use the Start SRR RS *
Pad and End Pad menus to define a specific pad range

instead.

Drum event options

To define a specific pad range over which the events wiill
be generated, use the Start Pad or End Pad fields. You can
use these fields only if the Bank menu is set to Range. A

Range

To set how closely together the events will be placed in
the clip, use the Density (%) slider.

To set how widely or narrowly the rhythmic patterns of the
generated notes vary, use the Rhythm Variation slider.

If Event Type is set to Melodic Events:

GENERATE RANDOM EVENTS

To define a specific note range over which the events will
be generated, use the Start Note or End Note fields.

Generation

Melodic events

To enable or disable legato, tap the Legato checkbox.

Replace all events

When on, the generated notes will be extended or
shortened to create a long, unbroken phrase from the first 3

note event’s start point to the last note event’s end point. Melodic event options
Each note event will sustain until another note event
starts. If multiple note events start at the same time (and
are not the last note events), their lengths will become
identical.

)
2

When off, the generated notes will use the duration set by
the Note Length menu.

To set the maximum number of note events that can be
sounding simultaneously in the track, use the Polyphony GENERATE RANDOM EVENTS
f|e|d tO Se|eCt 1_8. Melodic event options

To determine whether or not the notes will use a scale, tap o)
the Constrain Notes to Scale checkbox.

When on, the notes will be within the scale determined by
the Scale menu.

When off, the notes will be chromatic.

To set how closely together the events will be placed in
the clip, use the Density (%) slider.

To set the root note of the scale that the notes will use,
use the Root Note field.

To select the scale or mode that the generated notes will
use, use the Scale field.

The Split Note Events process divides note events into an equal
number of parts.

To set the number of parts note events will be split into, use SRR
the Into field. setup

To set the process to only affect selected notes, tap the Only
selected events checkbox. When unchecked, all note events in
the clip will be split.
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The Merge Pads function allows you to merge samples and settings from two drum tracks together.
To select the track from which the pads will be copied, use the From Track field.
To select the track to which the copied pads will be merged, use the Into Track field.
To merge the samples and settings at the start of the next unused bank, check the Start on next bank field.
To merge the pads, tap Do It.

To close the window and return to the previous screen, tap Cancel.

The Copy Pads function allows you to copy one or more pads from one drum track to another.

To select the whether you want to copy an individual Pad, a Bank of pads or a Range of pads, use the Copy
Type menu. Use the fields that appear to select the Pad, From Bank or Start/End Pads that will be copied.

To select the track from which the pads are copied, use the From Track field.

To select the track to which the copied pads are added, use the To Track field.

To set the starting point where the copied pads are added, use the Pad, To Bank or Start Pad fields.
To copy the pads and keep this window open, tap Apply.

To copy the pads and close the window, tap Do It.

To close the window without making any changes, tap Close.

The Convert to Progression function creates a custom Progression from a melodic MIDI track that you can use to
perform with Progressions Note mode.
To set the parameters of the new Progression, use the Progression fields:
To set the progression name, use the Name field.
To set the root note, use the Root Note field.
To set the scale type, use the Scale Type field.

To set the parameters for the chords in the Progression, use the Chord fields:
To select a chord from the progression to edit, use the Chord field.
To rename the selected chord, use the Name field.
To set the type of chord, use the Type field to select Root, Normal or Below Root.
To play the selected chord, tap the Play button.
To convert the progression and close the window, tap Do It.

To close the window and return to the previous screen, tap the X, Close or anywhere outside the window.
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The Export as Pattern and Export as MIDI functions save the current
clip as a pattern (.mpcpattern) or MIDI file (.midi), respectively, to an
external storage device or the internal drive of Force.
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To select the storage device you want to view, tap it in the
Storage column on the left.

Internal is the internal drive of Force.

Force Documents is a shortcut to the Force Documents
folder on the internal drive of Force.

If you have storage devices connected to USB ports or SD
card slot of Force, they will appear in this column, as well.

To enter a folder, double-tap it. Alternatively, turn the data dial
or use the —/+ buttons to move through the list, and press the
data dial to enter a folder. You can also tap one of the five folder
buttons in the upper-right to jump immediately to those pre-
assigned file paths (see Browser to learn how to do this).

To create a new folder, tap New Folder, use the virtual keyboard
that appears to enter a name, and then tap Do It. You will
immediately enter the new folder.

To move up one folder level, tap the folder/t icon in the upper-
left corner.

To name the file, tap the File Name field at the bottom of the
screen, and use the virtual keyboard that appears.

To save the file, tap Save.

To cancel and return to the Menu, tap Cancel. Alternatively, tap
the € icon in the upper-left corner.

<& Save

L3 Internal

FILE NAME

NEW FOLDER

[Internall/Force Documents

Pattern 09

a
Pattern 08.mpcpattern

CANCEL



Velocity/Automation Lane

Grid Mode also contains a velocity/automation lane where you can easily adjust note velocities and automation
parameters.

DON'T SNAP NUDGE EDIT START EDITEND TRANSPOSE

The velocity/automation lane in Grid Mode.

To show or hide the velocity/automation lane:
1. Tap the up arrow (A) button in the lower-right corner to show the velocity/automation lane.

2. Tap the down arrow (v) to hide the velocity/automation lane.

When editing velocity, each note’s velocity is represented by a vertical bar. The higher and more red the bar is, the
higher the velocity is. Yellow bars indicate a lower velocity. Bars with a gray line at the top indicate a currently selected
note.

To adjust the velocity of the selected notes, tap Velocity at the bottom of the screen, and then use the data dial or
—/+ buttons.

To add automation to a clip:
1. Select a MIDI Track or Audio Track, and then press Menu and tap Grid to open Grid Mode.
Tap the up arrow on the parameter bar to expand the velocity/automation lane.

3. By default, Velocity is shown in this lane for MIDI tracks and TRK: Volume is shown for Audio tracks. Double-tap
this field to open the Parameter drop-down menu.

4. In the menu that appears, tap Add New to add an automation parameter. You can choose from a variety of
parameters depending on the type of track, insert effects added and other options.

To edit automation, do any of the following in Grid Mode or Clip Mode:
e Use the pencil tool to draw your automation in the automation lane.
e Use the eraser tool to erase automation points. If you erase all automation points, the parameter will be removed.

e Tap the trash can icon to delete all automation for the
selected parameter at once.
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Clip Mode

Clip Mode lets you view and edit the parameters of the clip container itself. This view has three different
appearances: one of audio track, one for drum tracks and one for keygroup, plugin, MIDI and CV tracks.

To enter the Clip Mode, do either of the following:
e Press Menu and then tap Clip.
e Press Clip.

For audio tracks, the waveform of the audio clip is shown.

0  Global Trigger

T tegar0

For drum tracks, the left column shows you all available pads in a
vertical view with their corresponding events in the grid to the right.

0  Global Trigger

Tamcup tecao

For keygroup, plugin, MIDI and CV tracks, the left column shows a
vertical “piano roll” keyboard with the corresponding events in the grid
to the right.

Velocity

0 T Pk © 4 0. 0 Global Trigger

SETSTART TRIM CLIP LEGATO LooP
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TRIMCLIP LEGATO LOOP

Use the Start fields to set the starting location of the clip when launched. Alternatively, drag the start marker.
Use the Loop Start fields to set the starting location of the clip loop. Alternatively, drag the loop start marker.
Use the Loop Length fields to set the total length of the loop. Alternatively, drag the loop end marker

Use the Launch Quantize field to set the quantization for launching the clip. This can be set separately from the global
launch quantization.

Use the Launch Mode field to set how the clip is launched. Select Toggle for the clip to start or stop with each
successive press. Select Trigger for the clip to start at the beginning with each press.

To open the Timing Correct window, tap TC at the bottom of the screen. This window contains various settings to
help quantize the events in your clip (learn about this feature in Operation > General Features > Timing Correct (TC)).

To adjust the clip start or end points, tap Set Start or Set End while the clip is playing. The starting point or ending
point will be set at the playhead location.

To trim a clip, use the Loop Length fields to set the preferred length, then tap Trim Clip to trim the whole clip to this
size.

To enable or disable legato, tap Legato. When Legato is active, the playhead will continue from the same position as
it was in the previous clip of the same track when switching between clips. This is useful for creating seamless fills in
drum breaks or when using an a capella track.

To toggle the clip loop on or off, tap Loop. Generally, turn Loop on for complete phrases and turn it off for one shots.
To shift the entire loop area left or right, press and hold Shift and tap << Loop or Loop >>.
To halve or double the loop size, press and hold Shift and tap /2 or 2X.

To view the velocity/automation lane, tap the up arrow (A) button in the lower-right corner. Velocity and automation
can be edited in Grid Mode. To hide the velocity/automation lane, tap the down arrow (v) when it is expanded.

The Settings window lets you configure certain Grid Mode settings.
To view the Settings, tap the gear icon.
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List Edit Mode

List Edit Mode has some of the features of Grid Mode—as well as some additional ones—but with a
different interface/workflow.

LIST EDIT

A13 (48) Aftertouch
Volume
A01(36) -

001:01:48 A02 (37)

001:01:73 LUERE)) -

001:02:00 0 Pan
A01(36) Aftertouch
AO06 (41) Pad Mute
Volume
001:02:25 41 o

INSERT DELETE

The time counter at the top of the screen indicates the current playhead position.

The View menu lets you select what type of events are shown in the list.
All: Select this option to show all event types.
Notes: Select this option to show only notes.
Aftertouch: Select this option to show only aftertouch messages.
MIDI Automation: Select this option to show only MIDI automation events.
Track Automation: Select this option to show only track automation events.
Pitch Bend: Select this option to show only pitch bend events.
Control Change: Select this option to show only MIDI CC messages.
Program Change: Select this option to show only MIDI program change messages.
Ch Pressure: Select this option to show only channel pressure messages.
Solo/Mute: Select this option to show only solo and mute events for clips, tracks, and pads.

Other: Select this option to show other types of events not listed above, such as pad or keygroup parameters.

170



The Settings window lets you configure certain List Edit Mode settings.
To view the Settings, tap the gear icon.

X SETTINGS

Use the Hitting Pad Selects All Events selector to turn the feature on or off. When On, pressing a pad will
automatically select all note events for that pad in the selected clip on that track. When set to Off, pressing a pad will
simply play its sound without selecting any note events.

Use the Auto-Advance on Step Record selector to turn the feature on or off. When set to On, pressing a pad when the
track is record-armed will move the audio playhead forward by a length determined by the current Time Division setting
in the TC/Timing Correct window. When set to Off, pressing a pad when the track is record-armed will not change the
audio playhead position.

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead.
Follow: The list will scroll along in the background while keeping the audio playhead centered.
Page: The list will move to the “next page” to follow the audio playhead.

Off: The list will not move at all.

These functions also apply to Grid Mode and Sample Edit Mode.

The contents of the clip will be shown as a list of events, with the following parameters:
#: This is the number of the note event.

Time: This is the position of the note event in bars, beats, and ticks. If multiple note events occur at the same time,
additional note events will be listed immediately below, but their Time values will be grayed out.

Event Type: This icon indicates the type of event (e.g., Note, Aftertouch, Track Automation, etc.). See the list of
icons below showing the different types of events.

Pad/Note: This is the pad and/or corresponding MIDI note number. For drum tracks, you will see the pad number.
For keygroup tracks, plugin tracks, and midi tracks, you will see the note.

Length: This is the length of the note event in ticks.
Velocity: This is the velocity of the note event with its corresponding color.
Mod Type: This is the type of modifier used on the note event via automation.

Value: This is the value of the modifier automation.
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The red arrow () on the left side of the list represents the audio playhead’s current position. If your clip is playing, the
arrow will move accordingly.

The following icons indicate the corresponding types of events:
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MIDI Automation (Volume, Pan, Mute, Solo)

[| a8 MIDI CC Automation (0-127)

pi

MIDI Parameter Automation (Aftertouch, Pitchbend, Channel Pressure, or Program Change)

Mixer Automation (Volume, Pan, Mute, Solo, or Send 1-4)

Mixer Parameter Automation (options vary based on the type of track)

Track Insert Effect Automation (options vary based on the effect)

Pad/Keygroup Mixer Automation (Level, Pan, Pad Mute, Pad Solo, or Send 1-4)

Pad/Keygroup Parameter Automation (options vary based on the type of track)

Pad/Keygroup Insert Effect Automation (options vary based on the effect)
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To select an event, tap it.

To select multiple events, press and hold Shift and tap each event.

To insert a note event, press Rec so the button is lit, and then press a pad. A note event will be created at the current
location using the pad you pressed. You can keep pressing additional pads, which will continue to insert each press as
a single note event in the order you pressed them (similar to a step sequencer). Press Stop to exit this function.

Note: Depending on the Auto-Advance on Step Record setting, the current time position will either advance each time you
press a pad or remain in place. See the earlier description of Auto-Advance on Step Record to learn about this.

Alternatively, press the Insert button at the bottom of the screen to
open the Insert Event window:

7} INSERT EVENT

Use the Bar:Beat:Tick fields to set the location where you want to
add an event.

Use the Type field to set what kind of event you would like to add:
Note, Pad Automation, Mixer Automation or MIDI Automation.

Use the Pad and/or Parameter fields to set the additional values
or settings based on the type of event.

Tap Do It to add the event.

Tap Cancel, the X or anywhere outside the window to close the
Insert Event window and return to List Mode.

To edit the Pad/Note, Length, or Velocity or numeric Value of an event, tap the value to select it, and then use the
data dial or -/+ buttons to change the value. Alternatively, double-tap it and use the numeric keypad that appears to
enter a value (for Length, Velocity, or numeric Value only).

To edit the Length of an event according to your Timing Correct settings, tap the value to select it, and then press
and hold Shift and use the data dial or —/+ buttons to change the value.

To shift the Pad/Note of an event by pad bank, tap the value to select it, and then press and hold Shift and use the
data dial or —/+ buttons to change the pad bank.

To turn a Solo/Mute event on or off, tap the desired setting on the On/Off switch. Alternatively, tap the On/Off switch
to select it, and then use the data dial or -/+ buttons to change the value.

To move an event, tap it to select it, tap Nudge at the bottom of the screen, and then use the data dial or —/+ buttons
to shift the event up or down. Repeat this for other events, or tap Nudge again to turn the feature off.
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To move an event according to your Timing Correct settings, tap the Time value to select it, and then press and
hold Shift and use the data dial or =/+ buttons to change the value.

To play an event, tap it to select it, and then tap Play (») at the bottom of the screen. This works with note events only.

To delete an event, tap it to select it, and then tap Delete at the bottom of the screen.

To open the Timing Correct window, tap TC at the bottom of the screen. See General Features > Timing Correct
(TC) to learn about this.
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Step Sequencer

The Step Sequencer lets you create or edit clips by using the pads as “step buttons,” simulating the
experience of a traditional step-sequencer-style drum machine. This is available for MIDI tracks only, not
audio tracks.

You can also create and edit automation using the Step Sequencer.

To enter the Step Sequencer, press Menu, and then tap Step Sequencer. If you have not yet created a clip for the track,
you will be prompted to do so.

Note: Entering the Step Sequencer mode on the display will not also put the clip launch pads into their own Step
Sequencer pad mode. Press the Step Seq button to do so.

Top Loop

A03

2 \elocity

The top of the screen shows the track name and information as well as project and timing information.

The Track field shows the name of the current track.

Use the BPM field to adjust the tempo of the project.

The time counter at the top of the screen indicates the current playhead position.
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Top Loop

A03
2 Velocity

To enter or delete steps in a clip:

1. Use the Pad —/+ buttons at the bottom of the screen to select the pad whose steps you want to enter or delete. The
current pad number is shown in the upper-left corner.

2. Use the Bar —/+ buttons at the bottom of the screen to select the bar of the clip whose steps you want to enter or
delete. The current bar number is shown in the upper-left corner.

3. Press the pads of your Force hardware, or tap a button at the bottom of the sequencer. Each pad corresponds to a
step in the bar and will light with a color corresponding to its velocity.

For time divisions larger than 16, the bar’s steps will be represented by multiple pad banks. In this
case, use the left and right arrows (< and >) by the step numbers (1-16, 17-32, etc.) to change 1-16
which steps are shown in the sequencer.

To adjust the velocities of the steps, do any of the following:
e Tap anywhere on the velocity bar of a step. The top of the velocity bar will jump to that point.

e Use the slider on the right edge of the screen to increase or decrease the velocities of all steps.

Use the Nudge < and Nudge > arrows to shift each step left or right (respectively) one step. This is useful for
experimenting with different rhythmic permutations.

Use the slider on the right edge of the screen to increase or decrease the velocities of all steps.

Use the Flip Steps button to switch which steps have notes entered and which do not have notes. Steps
that previously had no notes will now have notes at full velocity (127). Steps that previously had notes will .‘\
now be empty. X
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Tap Presets to show or hide the preset velocity controls. These controls let you manipulate and
transform the velocities of the current bar in the clip.

The first button will apply ascending or descending velocities to the steps. Each time you tap it, it will
cycle through these options:

e The velocities will ascend to a single peak at the end of the bar.

e The velocities will ascend to two peaks—one after each half of the bar.

o The velocities will ascend to four peaks—one after each quarter of the bar.
e The velocities will descend from a single peak at the start of the bar.

e The velocities will descend from two peaks—one after each half of the bar.

e The velocities will descend from four peaks —one at the start each quarter of the bar.

The second button will set the velocities of the steps to be at the maximum value (127) or minimum values
(1), depending on their position in the bar. Each time you tap it, it will cycle through these options:

e The velocities of the first half of the bar will be set to 1. The velocities of the second half will be
set to 127.

o The velocities of the first and third quarters of the bar will be set to 1. The velocities of the second
and fourth quarters will be set to 127.

e The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 1. The velocities
of the second, fourth, sixth, and eighth eighths will be set to 127.

e The velocities of the first half of the bar will be set to 127. The velocities of the second half will be
setto 1.

e The velocities of the first and third quarters of the bar will be set to 127. The velocities of the
second and fourth quarters will be set to 1.

e The velocities of the first, third, fifth, and seventh eighths of the bar will be set to 127. The
velocities of the second, fourth, sixth, and eighth eighths will be set to 1.

The third button will apply ascending or descending velocities to the steps. Each time you tap it, it will
cycle through these options:

e Across the entire bar, the velocities will ascend to a peak and then descend from it.
¢ In each half of the bar, the velocities will ascend to a peak and then descend from it.
¢ In each quarter of the bar, the velocities will ascend to a peak and then descend from it.

e Across the entire bar, the velocities will descend from a peak into a valley and then ascend back up
to the peak.

e In each half of the bar, the velocities will descend from a peak into a valley and then ascend back up
to the peak.

e In each quarter of the bar, the velocities will descend from a peak into a valley and then ascend
back up to the peak.

The fourth button will swap the first half and second half of the bar. In other words, the first half of the bar
will become a mirrored image of the second half, and vice versa.
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The fifth button will invert the velocities of all steps with entered notes. The sum of the old and new
velocities will equal 127. The exception is a velocity of 127 or 1 as a step with a note cannot have a
velocity of 0.

Examples:
Steps with velocities of 40 will now have velocities of 87, and vice versa.
Steps with velocities of 75 will now have velocities of 52, and vice versa.

Steps with velocities of 127 will now have velocities of 1, and vice versa.

Step Automation

You can also create and edit automation using the Step Sequencer.

To add a step automation parameter:

1.

Press Menu and tap Step Sequencer to open the Step Top Loop

Sequencer. + TRK: Pan

By default, the Parameter field of the Step Sequencer
displays Velocity for MIDI tracks and TRK: Volume for
audio tracks. Double-tap this field to open the drop-
down menu.

In the menu that appears, tap Add New to add an
automation parameter. You can choose from a variety of
parameters depending on the type of track, insert effects
added and other options.

To edit step automation, do any of the following:

Tap and drag your finger in the step area to freely draw step values.

Press and hold the Knobs button and tap Screen to set the knobs to Screen Mode. While viewing the step
sequencer, you can use the knobs for tactile control of each step's automation value, emulating traditional knob-
based step sequencers. Use Bank 1 of the knobs to control Steps 1-8 and Bank 2 to control Steps 9-16. While it
is being adjusted, the current automation value will be shown next to the Parameter field, as well as in the display
strip above the knobs.

Press and hold Shift and tap Clear to clear all automation for the selected parameter in the selected clip.

Press and hold Shift and tap Clear Bar to clear all automation for the selected parameter in the current bar of the
selected clip.

Use the Nudge < and > buttons to shift the current automation parameter to the left or right at the current Timing
Correct value.

Use the slider on the right side to increase or decrease the parameter values for all automation steps in the visible
time range.

Tap Presets and use the buttons to apply the presets to the step automation (See Operation > Modes > Step
Sequencer for more information).

Note: When editing step automation, if a step is not activated, a darkened step bar will indicate the current parameter
value at that step, based on the last active step.
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Track Edit Mode

Track Edit Mode contains all parameters for editing your Tracks.

For drum tracks, this mode includes the parameters of four layers as well as all synthesis parameters and insert effect
settings. See the Drum Tracks section to learn more.

For keygroup tracks, this mode contains slightly more parameters than drum tracks. See the Keygroup Tracks section
to learn more.

For plugin tracks, skip to Plugin Tracks to learn more.
For MIDI tracks and CV tracks, skip to MIDI Tracks and CV Tracks to learn more.

For more general information on the differences between the types of tracks, please see General Features > Tracks.

To enter Track Edit Mode, do either of the following:
e Press Menu, and then tap Track Edit.
e Press and hold Shift and press Clip.

Drum Tracks

Drum Kit

MASTER

-4.35dB

SIMULTANEQOUS
PLAY

Off

MUTE

THRGET Off Off Off Off

SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

When using drum tracks, Track Edit Mode lets you edit the parameters for each pad.
To select a pad, press it. Its parameters will appear on the screen immediately.

To view a specific tab of parameters, tap the Master, Samples, Pan Velocity, Filter/Env, LFO Modulation, or
Effects button at the bottom of the screen. You can tap the Samples button multiple times to cycle through its
three available tabs.
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Tap the keyboard+ icon at the top of the screen to quickly create a keygroup from the selected sample. The new
keygroup will be created on a new track and automatically be selected.

5

Q] EDITZONES

(4]

CURRENT Q

Tap the location icon at the top of the screen (on the right side) to open the Edit Zones window, which is a feature for
drum tracks. This window displays an overview of any selected pads. Use the Mode selector to set how the selected
pads will be edited:

e Current: Only the currently selected pad can be edited.
e Multiple: All selected pads can be edited simultaneously.

e All: All pads can be edited simultaneously.

To close the window, tap Close, the X, or anywhere outside the window.

Tip: You can immediately select multiple pads while on any tab in Track Edit Mode (regardless of the current Edit Zones
setting) by pressing and holding the Shift button and pressing each desired pad. The Edit Zones setting will
automatically change to Multiple.
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FLATTEN PADS

1 seconds

IbizaHouse-Kick-IH Kick 1 [

Tap the down-arrow icon at the top of the screen (next to the Track field) to open the Flatten Pad window, which
renders all samples on a pad as an audio sample and places it on the first layer of that pad. The resulting sample is the
audio signal produced by that pad at full velocity (127) after the pad channel strip, which means that it includes any
assigned pad insert effects and the results of warping the sample.

This function is useful if you need to reduce how CPU-intensive a pad or track is by essentially “embedding” the warping
and effects in the sample itself. By default, it will use the name of the first sample. This function works for drum tracks only.

To select the pad, press it or use the Pad menu.

To set the length of the audio tail, use the Audio Tail field. This will add extra seconds to the end of the resulting
audio file. This is useful if you are using effects or samples whose sounds exceed the defined audio length (e.g., long
reverb or delay, one-shot samples with long decays, etc.). We recommend using an audio tail of at least a couple of
seconds.

To name the new sample, tap the Edit Name field, and use the virtual keyboard that appears.
To confirm your choice, tap Do It.

To cancel, tap Cancel.
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Master

In the Master tab, you can set the playback mode and tuning for the overall Track.

Drum Kit

MASTER

SIMULTANEOUS
PLAY

MUTE

THRGET Off Off Off Off

SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

Polyphony sets the playback mode for the track’s pads. In Mono Mode, only one pad will sound at a time. If a pad is
played while another (or the same one) is still playing its sample/samples, the new pad will immediately mute all other
currently playing pads in that track. In Poly Mode, several pads can be triggered at the same time (limited only by the
total number of voices available).

Semi lets you transpose the track up to 36 semitones up or down.

Fine provides fine-tuning of the track up to 99 cents up or down.

Volume controls the overall volume level of the loaded sample/samples.

Pan controls the overall panning of the loaded sample/samples in the stereo field.

The Simultaneous Play section lets you set up to four pads that can be triggered by pressing one pad only. This function is
useful for triggering a stack of sounds (e.g., layered kick drums). Use each Pad field to select the desired pad.

The Mute Targets tab lets you select up to four pads (in the same track) for the currently selected pad. When the
currently selected pad is played, it will immediately silence its mute targets. Use each Pad field to select the desired
mute target.

Tips:
This feature is useful for programming realistic hi-hats, especially if only the open or closed hat should be heard.

This feature is similar to the mute group feature, available for both drum tracks and keygroup tracks.
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Samples

Each pad can trigger up to four samples, which are assigned in four individual layers. Each layer has identical,
independently assignable parameters.

Tap Samples to cycle through its three available tabs.

Drum Kit

| ]
BassHouse-Kick...

Pad

ot [elo}?
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On all three sections, you can access the Settings window, which lets you configure certain settings in the Samples tab.
To view the Settings, tap the gear icon.
To close the Settings, tap Close, the X in the upper-right corner, or anywhere outside the window.

Use the Link Slices selector to set how the start point and end point of a slice in a larger sample is set. You can create
these slices in Sample Edit Mode (Chop Mode).

When on, changing the start point of a slice will also change the end point of the previous slice. Similarly, changing the
end point of a slice will also change the start point of the next slice. Disable Link Slices if you are trying to create slices
that use non-contiguous parts of the sample. This is the same as the Link Slices button in Sample Edit Mode.

Use the Loop Lock selector to “link” or “unlink” the loop point from the start point. When on, the loop point is the same
as the start point. When off, the loop point is independent from the start point and indicated by a separate loop marker.
This is the same as the Loop Lock button in Sample Edit Mode.

Use the Zero Snap selector to enable or disable the Zero Snap feature, which forces start points, end points, and loop
points to occur only at the waveform’s “zero-crossings.” This can help to avoid clicks and glitches when playing a
sample. This is the same as the 0 Snap button in Sample Edit Mode.
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The first Samples tab contains the sample waveform for each layer and controls for its pitch, timing, and playback.

Top Loop
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The upper half of the screen shows the waveform of the sample on the currently selected layer. The lower half shows
the editing controls.

The waveform display shows the “active” section of the sample waveform. Swipe left or right on the waveform to move
through it.

Above the waveform is the timeline, shown in bars, beats, and ticks.

Tap each layer number (Layer 1-4) under the waveform to select it. When selected, its sample waveform will be shown
in the upper half of the screen and its settings will be shown in the lower half.

Use the Sample field to select the sample file for that layer. Remember that the sample has to be loaded into the project’s
sample pool beforehand. For information on how to load samples into a project, please see the Browser chapter.

Important: The parameters in the Samples tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s
how it works:

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads, you can convert
a slice using Non-Destructive Slice or Pad Parameters.

A Non-Destructive Slice will let its pad to refer to that slice when you press it; the original sample remains intact and
each slice marker is like a “bookmark” for a pad. In Track Edit Mode, you’ll see that the pad/layer to which it's assigned
has its Slice drop-down menu set to the corresponding slice number in the original sample. Playing that pad will cause
it to refer to that slice marker like a “bookmark” instead of creating an entirely new sample of that slice. This means that
you no longer have to clutter your project with a new sample for every slice (though you can still use this earlier method,
if you prefer).

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is that
in Track Edit Mode, the pads/layers they’re assigned to have their Slice drop-down menus set to Pad (instead of the slice
number), and the start and end points will correspond to the slice markers in the original sample.
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The green/S marker and red/E marker are the start point and end point (respectively). These two points define the
region of the sample that will be played.

To move the start point or end point, do any of the following:
e Tap and drag the S or E marker left or right.
e Use the Start or End fields shown below the waveform.

e When the knobs are set to screen mode, use Knobs 1 and 5 to adjust the start point or Knobs 2 and 6 to
adjust the end point. Knobs 1 and 2 provide fine adjustment and Knobs 5 and 6 provide coarse adjustment.

Note: When Loop Lock is on, the loop position (as determined by the Loop field, if enabled) is the same as the
sample’s start point. When off, the loop position is independent from the start point.

Use the Loop field to determine the position where the sample’s playback will repeat when Pad Loop is activated.

Note: When Loop Lock is on, the loop position is the same as the sample’s start point. When off, the loop position is
independent from the start point.

Use the Slice field to select what part/parts of the sample will play:
e All: The entire sample will play.

o Pad: The sample will play from the Pad Start position to the Pad End position, described earlier. This also lets
you activate Pad Loop (if the Sample Play field in the LFO Modulation tab is set to Note On).

e Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode, you can select which slice will play when you
trigger the pad.

Semi lets you transpose the selected layer 36 up to semitones up or down. This will affect the length of the sample (if
Warp is off). This is the same as the Semi knob on the second Samples tab.

Fine provides fine-tuning of each layer by cents. This will affect the length of the sample (if Warp is off). This is the same
as the Fine knob on the second Samples tab.
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Use the Reverse button to select in which direction the sample will play. When on, the sample will play in reverse. When

off, the sample will play in the normal forward direction.

Use the Pad Loop button to cycle through the available Pad Loop modes.

Important: For Pad Loop to work, you must (1) set the Sample Play field (in the LFO Modulation tab) to Note On
instead of One Shot and (2) set the Slice field (in the first Samples tab) to Pad instead of All or a slice number.

e Off: The sample will not loop.

e Forward: You can hold down the pad to cause that sample to repeat from the Loop Position
to the end of the sample. Release the pad to stop the repeating playback.

e Reverse: You can hold down the pad to cause that sample to play in reverse, repeating from
the end of the sample to the Loop Position. Release the pad to stop the repeating playback.

e Alternating: You can hold down the pad to cause that sample to play from the Loop Position
to the end of the sample and then play in reverse until it reaches the Loop Position again. This
will repeat as long as you are holding the pad down. Release the pad to stop the repeating
playback.
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Tap Warp to enable or disable warping of the sample.
When enabled, lengthening or shortening the sample (based on the BPM) will not change its pitch.

When disabled, lengthening or shortening the sample will also change its pitch and vice versa.

Use the Stretch field to set the “stretch factor,” which affects how the sample is warped (if Warp is on).

Use the BPM field to enter a tempo, which affects how the sample is warped (if Warp is on).

Tap BPM Sync to enable or disable BPM Sync.
When BPM Sync and Warp are both enabled, the sample’s BPM will be “locked” to the tempo of the project.

When BPM Sync is disabled but Warp is enabled, the sample will be independent of the tempo of your project—use the
Stretch field to lengthen or shorten a sample.

Note: The Warp algorithms are very CPU-intensive and can result in audio drop-outs during playback if used too freely.
Be mindful of how (and how often) you use the warp function. You can reduce the CPU resources required by doing
any/all of the following:

Avoid using extreme Stretch values.
Minimize the amount of pitch adjustment (e.g., the Semi and Fine parameters) of warped audio.
Avoid warping very small clip regions.

Warp as few clips or clip regions as possible (i.e., reduce the number of total number of voices of the polyphonic
limit that use the Warp algorithm at a given time), especially instances where the warped regions start at the same
time.

Avoid rapidly triggering samples that are warped.

If you have warped samples used in a drum kit, consider using the Flatten Pad function to consolidate the affected
pad’s layers into one audio sample (see here to learn about this). After you flatten the pad, its sample/samples no
longer need to be warped.
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The second Samples tab contains controls for its pitch and volume level.

Drum Kit
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Semi lets you transpose the selected layer 36 up to semitones up or down. This will affect the length of the sample (if
Warp is off). This is the same as the Semi field on the first Samples tab.

Fine provides fine-tuning of each layer by cents. This will affect the length of the sample (if Warp is off). This is the same
as the Fine field on the first Samples tab.

Level lets you adjust each layer’s volume, letting you control the “balance” of the samples assigned to the pad.
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The third Samples tab contains the control for its offset.

Drum Kit

& BassHouse-Kick-BH Kick 3

# BassHouse-Kick-BH Kick 4

SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

Use the Offset slider to determine a time offset for the sample’s playback.

o Positive values (right of center): When the pad is played, playback will start immediately but at a later point in the
sample specified by the offset value.

¢ Negative values (left of center): When the pad is played, playback will be delayed by the amount specified by the
offset value.
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Use the pan knob to adjust the stereo placement of the respective layer.

Use the Vel Start and Vel End knobs to define the velocity range of each layer.

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective pad while, for
example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several samples of
one instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of each layer
accordingly.

For example, you may have three samples of a drum hit with low force, medium force, and high force. You can set each
sample to a layer and set the Velocity ranges so only low velocities trigger the low-force sample, only mid-range
velocities trigger the medium-force sample, and only high velocities trigger the high-force sample.
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Use the Type field to select a filter for the selected pad. See Appendix > Glossary > Filter for an explanation of the
available filter types.

Use the Cutoff knob to set the cutoff frequency for low-pass and high-pass filter types or the center frequency for
band-pass and band-stop filter types.

Use the Reso knob to set the resonance/emphasis of the frequencies around the cutoff point.

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a
strong audible boost around the cutoff frequency.

Use the Env to determine the amount of influence the filter envelope has on the cutoff frequency. Higher settings will
increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter Cutoff
over time.

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Decay values as well as
a medium-low Sust value of the Filter Envelope. This will start a sound with the filter opened and close it shortly
afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much more
“alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.

Use the Modulation Sources knobs to set how much velocity is required to modulate certain other parameters:
o Vel>Sta (Velocity® Start) sets how much velocity is needed (for a triggered pad) to modulate the sample start point.

o Vel>Atk (Velocity® Attack) sets how much velocity is needed (for a triggered pad) to modulate the Attack phase
for the Amp envelope.

e Vel>Env (Velocity®Envelope) enables velocity information to control the amount of the filter envelope’s effect
on the cutoff frequency.

e Vel>Flt (Velocity®Filter) uses the velocity of a pad to modulate the cutoff frequency directly.

The Filter Envelope controls affect the filter frequency. Use the fields or tap and drag the “handles” of the envelope to
shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with the
Env knob. See the later Anatomy of an Envelope section to learn about the envelope parameters.

The Amp Envelope controls affect level changes over time. Use the fields or tap and drag the “handles” of the envelope
to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with the
Env knob. See the later Anatomy of an Envelope section to learn about the envelope parameters.
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The Modes controls let you set the behavior for each pad’s samples in a drum track.

Use the Mute Group field to assign the selected pad to one of the 32 available groups. When pads assigned to the
same mute group receive MIDI notes, the last pad played will silence all other pads in that mute group. A mute group
affects pads within that track only; mute groups do not affect pads in other tracks.

Tip: This feature is useful for programming realistic hi-hats, so only the open or closed hat is heard.

Use the Layer Play selector to determine how multiple samples assigned to the same pad are played:

e Cycle (Cyc): Each time the pad is played, it will play the next layer’'s sample. In other words, the samples will
cycle through the layers as follows: 1, 2, 3,4, 1, 2, 3, 4... etc.

e Velocity (Vel): The pad will switch between layers depending on how hard you press a pad.

¢ Random (Ran): Each time the pad is played, it will play one of its layer’s samples at random.

Use the Sample Play selector to determine how much of the sample is played.
e One Shot: The entire sample will play from start to end. Use this when you want to play short sounds.

e Note On: The sample will play only as long as the pad is held. This is better for longer samples so you can
control a sound’s duration by pressing and holding its corresponding pad.
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Use the Pad Polyphony field to determine how the pad’s sound behaves when multiple hits are registered. When set to
Mono, only one pad will sound at a time. If a pad is played while another (or the same one) is still playing its
sample/samples, the new pad will immediately mute all other currently playing pads in that track. When set to Poly,
several pads can be triggered at the same time (limited only by the total number of voices available). You can also select
a specific number of pads (2-32) so that you can trigger up to this many pads at the same time (unless they exceed the
total number of voices available).

The Velocity Sensitivity controls determine how much the velocity affects the pitch of the sound (Pitch), the attack of
the filter envelope (Attack), the volume level of the filter envelope (Amp) and or the panning of the sound (Pan).

When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount also
gets stronger depending on the setting of the corresponding knob.

A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can be
used for modulation purposes.

Use the Wave field to select the LFO waveform type:
¢ Sine (best suited for smooth modulations)
e Triangle (best suited for smooth modulations)
e S&H (samples a random value and holds it until the next value is generated)
e Saw (can generate interesting filter or volume changes)
e Saw Down (can generate interesting filter or volume changes)
e Square (interesting results with hard-panning modulations)

¢ Noise (generates random values and glides)

Use the Rate field to determine the LFO frequency. At lower values, it might take some time for the LFO to complete a
cycle, while higher values will come closer to audible range.

Use the Sync field to set if the LFO’s rate is synchronized with the tempo. You can select one of several time divisions
(a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off.

Use the Destinations sliders to determine how much the LFO affects the pitch of the sound (Pitch), the cutoff frequency
of the filter (Filter), the volume level of the sound (Amp) and panning of the sound (Pan).
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Inserts

You can select up to four insert effects for each pad. To learn how to use insert effects, please see General Features >
Effects > Insert Effects.

To add an effect:
1. Double-tap the desired Inserts slot. A list of effects will appear.
2. Swipe up or down to move through the list.
You can tap the Type and Manufacturer buttons to sort your effects by those categories.
3. To load an effect, double-tap it, or tap Select.

To close the list, tap Close.

To remove an effect from its slot, tap the trash can icon.

To enable or disable the effect, tap the On/Off button for the slot.
To enable or disable all four insert effects, tap the All On/Off button in the upper-right corner.
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To adjust the effect’s parameters, tap the pencil icon. Use the sliders to set the value of each parameter. These
values affect only this instance of the effect; insert effects are not global.

To load an effect preset, tap the folder icon next to the preset name at the top of the display to open the file browser.

To save a new effect preset, tap the disk icon next to the insert selector at the top of the display.

Sends

The audio of the pad will be routed to send effects (if you have any loaded) at their designated send levels. The return
channels will then send the audio to an assigned master output at the designated return levels.

Use the Send knobs to set the volume level of the signal the pad will route to each send effect.

Important: To learn about send effects, please see General Features > Effects > Send/Return Effects.
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When using keygroup tracks, Track Edit Mode lets you edit the parameters for each keygroup.

To select a keygroup, press a pad within that keygroup. Its parameters will appear on the screen immediately.
Alternatively, use the Keygroup field at the top of the screen.

To view a specific tab of parameters, tap the Master, Samples, Pan Velocity, Filter/Env, LFO Modulation, or
Effects button at the bottom of the screen. You can tap the Samples button multiple times to cycle through its three
available tabs.

Number of KG (keygroups) lets you create up to 128 keygroups within a keygroup track. This is useful when working with
multi-samples. For example, if you want to create a realistic piano, you can use different keygroups (e.g., 88 for a grand
piano) with every keygroup containing its own sampled note (with up to four possible velocity layers).

Tap the Keygroup field to select a keygroup to edit. You can also select All to edit all keygroups simultaneously.

Tap the piano-keys icon to edit the note range of the current
keygroup. This will open the Set Keygroup Note Range window. This
lets you restrict the key range used for a sample’s playback. Only
notes with a key number higher or equal (Low Key) or lower and equal
(High Key) to the selected value will trigger a sound.

& Set Keygroup Note Range

Tips:

Alternatively, you can set the current keygroup’s note range by using T e
the Lo and Hi fields under Note Range in the Master tab. ‘ ‘ IRARARENA

Set the Lo parameter to A0 and the Hi parameter to C8 to emulate the
range of a standard 88-key piano.
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Master

In the Master tab, you can set the playback mode and tuning for the overall track.
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Polyphony sets the playback mode for the track’s keygroups. In Mono Mode, only one keygroup will sound at a time. If
a keygroup is played while another (or the same one) is still playing its sample/samples, the new keygroup will
immediately mute all other currently playing keygroups in that track. In Poly Mode, several keygroups can be triggered
at the same time (limited only by the total number of voices available).

Semi lets you tune the track up to 36 semitones up or down.

Fine provides fine-tuning of the track up to 99 cents up or down.

Transpose shifts the pitch of the MIDI notes sent to the track up to 36 semitones up or down.

KG Select (Keygroup Select) lets you select a specific keygroup for editing. This parameter works in conjunction with
the Number of KG (keygroups) parameter at the top of the screen, which lets you create up to 128 keygroups within
one keygroup track. A default keygroup track contains only one single keygroup. When you have created more than one
keygroup with Number of KG, use KG Select to select any keygroup for editing. All selects all available keygroups of a
keygroup track for simultaneous editing.

Key Track allows you to switch a sample’s automatic transposition on or off. If this is off, you will always hear the same
pitch of the sample, no matter which note is triggered by pads or a connected MIDI keyboard.
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Level controls the overall volume level of the loaded sample/samples.

Pan controls the overall panning of the loaded sample/samples in the stereo field.

Note Range lets you restrict the key range used for a sample’s playback. Only notes with a key number higher or equal
(Lo) or lower and equal (Hi) to the selected value will trigger a sound. The settings for Lo and Hi are also shown in the
virtual keyboard in the Edit Layers section. Alternatively, tap the piano-keys icon to open the Set Keygroup Note
Range window.

Tip: Set the Lo parameter to A0 and the Hi parameter to C8 to emulate the range of a standard 88-key piano.

Semi lets you transpose the sample 36 semitones up or down, while Fine provides fine-tuning of each layer up to 99
cents up or down.

Tip: The Edit Layers section has some parameters similar to those in this section (Level, Pan, Semi, Fine, Note
Range). Remember that Key Group parameters control the overall settings for the sample, while Edit Layer parameters
control the settings for each layer (up to 4).

Use the KG Polyphony (keygroup polyphony) field to determine how the keygroup will play. When set to Mono, only
one pad will sound at a time. If a pad is played while another (or the same one) is still playing its sample/samples, the
new pad will immediately mute all other currently playing pads in that track. When set to Poly, several pads can be
triggered at the same time, limited only by the total number of voices available. You can also select a specific number of
pads (2-32) so that you can play up to this many pads at the same time (unless they exceed the total number of voices
available).

Use the Mute Group field to assign the selected keygroup to one of the 32 available mute groups. When keygroups
assigned to the same mute group receive MIDI notes, the last keygroup played will silence all other keygroups in that mute
group. A mute group affects keygroups within that track only; mute groups do not affect keygroups in other tracks.

Layer Play determines how multiple samples assigned to the same pad are played:

e Cycle (Cyc): Each time the pad is played, it will play the next layer’'s sample. In other words, the samples will
cycle through the layers as follows: 1, 2, 3, 4, 1, 2, 3, 4... etc.

e Velocity (Vel): The pad will switch between layers depending on how hard you press a pad.

e Random (Ran): Each time the pad is played, it will play one of its layer’s samples at random.

Sample Play determines how much of the sample is played:
e One Shot: The entire sample will play from start to end. Use this when you want to play short sounds.

e Note On: The sample will play only as long as the pad is held. This is better for longer samples so you can
control a sound’s duration by pressing and holding its corresponding pad.
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Samples

Each keygroup can trigger up to four samples, which are assigned in four individual layers. Each layer has identical,
independently assignable parameters.

Tap Samples to cycle through its three available tabs.
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On all three sections, you can access the Settings window, which lets you configure certain settings in the Samples tab.
To view the Settings, tap the gear icon.
To close the Settings, tap Close, the X in the upper-right corner, or anywhere outside the window.

Use the Link Slices selector to set how the start point and end point of a slice in a larger sample is set. You can create
these slices in Sample Edit Mode (Chop Mode).

When on, changing the start point of a slice will also change the end point of the previous slice. Similarly, changing the
end point of a slice will also change the start point of the next slice. Disable Link Slices if you are trying to create slices
that use non-contiguous parts of the sample. This is the same as the Link Slices button in Sample Edit Mode.

Use the Loop Lock selector to “link” or “unlink” the loop point from the start point. When on, the loop point is the same
as the start point. When off, the loop point is independent from the start point and indicated by a separate loop marker.
This is the same as the Loop Lock button in Sample Edit Mode.

Use the Zero Snap selector to enable or disable the Zero Snap feature, which forces start points, end points, and loop
points to occur only at the waveform’s “zero-crossings.” This can help to avoid clicks and glitches when playing a
sample. This is the same as the 0 Snap button in Sample Edit Mode.
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The first Samples tab contains the sample waveform for each layer and controls for its pitch, timing, and playback.
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The upper half of the screen shows the waveform of the sample on the currently selected layer. The lower half shows
the editing controls.

The waveform display shows the “active” section of the clip waveform. Swipe left or right on the waveform to move
through it.

Above the waveform is the timeline, shown in bars, beats, and ticks.

Tap each layer number (Layer 1-4) under the waveform to select it. When selected, its sample waveform will be shown
in the upper half of the screen and its settings will be shown in the lower half.

Use the Sample field to select the sample file for that layer. Remember that the sample has to be loaded into the
project’s sample pool beforehand. For information on how to load samples into a project, please see the Browser
chapter.

Important: The parameters in the Samples tabs work in conjunction with Chop Mode (in Sample Edit Mode). Here’s
how it works:

When working in Sample Edit Mode and using Chop Mode to divide a sample into slices for your pads (keygroups), you
can convert a slice using Non-Destructive Slice or Pad Parameters.

A Non-Destructive Slice will let its keygroup to refer to that slice when you press a pad in that keygroup; the original
sample remains intact and each slice marker is like a “bookmark” for a keygroup. In Track Edit Mode, you’ll see that the
layer to which it’s assigned has its Slice drop-down menu set to the corresponding slice number in the original sample.
Playing that keygroup will cause it to refer to that slice marker like a “bookmark” instead of creating an entirely new
sample of that slice. This means that you no longer have to clutter your project with a new sample for every slice (though
you can still use this earlier method, if you prefer).

A slice converted using Pad Parameters is very similar to a non-destructive slice described above. The difference is
that in Track Edit Mode, the layers they’re assigned to have their Slice drop-down menus set to Pad (instead of the slice
number), and the start and end points will correspond to the slice markers in the original sample.

200



Classic Bass

Inst-DeepHouse-Bass-Cr2 SlamBass-024 CO

. Inst-DeepHouse-Ba... 110250

» PADLOOP
pad =3

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

The green/S marker and red/E marker are the start point and end point (respectively). These two points define the
region of the sample that will be played.

To move the start point or end point, do any of the following:
e Tap and drag the S or E marker left or right.
e Use the Start or End fields shown below the waveform.

e When the knobs are set to screen mode, use Knobs 1 and 5 to adjust the start point or Knobs 2 and 6 to
adjust the end point. Knobs 1 and 2 provide fine adjustment and Knobs 5 and 6 provide coarse adjustment.

Note: When Loop Lock is on, the loop position (as determined by the Loop field, if enabled) is the same as the
sample’s start point. When off, the loop position is independent from the start point.

Use the Loop field to determine the position where the sample’s playback will repeat when Pad Loop is activated.

Note: When Loop Lock is on, the loop position is the same as the sample’s start point. When off, the loop position is
independent from the start point.

Use the Slice field to select what part/parts of the sample will play:
e All: The entire sample will play.

o Pad: The sample will play from the Pad Start position to the Pad End position, described earlier. This also lets
you activate Pad Loop (if the Sample Play field in the Master tab is set to Note On).

e Slice 1, 2, 3, etc.: If you have sliced the sample in Chop Mode, you can select which slice will play when you
trigger the pad.

Semi lets you transpose the selected layer 36 up to semitones up or down. This is the same as the Semi knob on the
second Samples tab.

Fine provides fine-tuning of each layer by cents. This is the same as the Fine knob on the second Samples tab.
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Use the Reverse button to select in which direction the sample will play. When on, the sample will play in reverse. When
off, the sample will play in the normal forward direction.

Use the Pad Loop button to cycle through the available Pad Loop modes.

Important: For Pad Loop to work, you must (1) set the Sample Play field (in the Master tab) to Note On instead of One
Shot and (2) set the Slice field (in the first Samples tab) to Pad instead of All or a slice number.

e Off: The sample will not loop.

e Forward: You can hold down the pad to cause that sample to repeat from the Loop Position
to the end of the sample. Release the pad to stop the repeating playback. o

» PRDLOOP

i

e Reverse: You can hold down the pad to cause that sample to play in reverse, repeating from
the end of the sample to the Loop Position. Release the pad to stop the repeating playback. O

PAD LOOP

e Alternating: You can hold down the pad to cause that sample to play from the Loop Position
to the end of the sample and then play in reverse until it reaches the Loop Position again. This | () s
will repeat as long as you are holding the pad down. Release the pad to stop the repeating
playback.
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The second Samples tab contains controls for its pitch and volume level.
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Semi lets you transpose the selected layer 36 up to semitones up or down. This will affect the length of the sample (if
Warp is off). This is the same as the Semi field on the first Samples tab.

Fine provides fine-tuning of each layer by cents. This will affect the length of the sample (if Warp is off). This is the same
as the Fine field on the first Samples tab.

Level lets you adjust each layer’s volume, letting you control the “balance” of the samples assigned to the pad.
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The third Samples tab contains the control for its offset.
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Use the Offset slider to determine a time offset for the sample’s playback.

o Positive values (right of center): When the pad is played, playback will start immediately but at a later point in
the sample specified by the offset value.

o Negative values (left of center): When the pad is played, playback will be delayed by the amount specified by
the offset value.
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Use the Pan knob to adjust the stereo placement of the respective layer.

Use the Vel Start and Vel End knobs to define the velocity range of each layer.

A range from 0 to 127 lets the layer respond to the entire velocity range which is input from the respective pad while, for
example, a range from 100 to 127 lets the layer respond only to higher velocity levels. By assigning several samples of
one instrument, you can create a realistic-sounding “multi-sample” by adjusting the velocity ranges of each layer
accordingly.

For example, you may have three samples of a piano key with low force, medium force, and high force. You can set
each sample to a layer and set the Velocity ranges so only low velocities trigger the low-force sample, only mid-range
velocities trigger the medium-force sample, and only high velocities trigger the high-force sample.

Use the Root Note menu to set the starting note of each loaded sample. Smp denotes the sample’s default pitch.
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Use the Type field to select a filter for the selected pad. See Appendix > Glossary > Filter for an explanation of the
available filter types.

Use the Cutoff knob to set the cutoff frequency for low-pass and high-pass filter types or the center frequency for
band-pass and band-stop filter types.

Use the Reso knob to set the resonance/emphasis of the frequencies around the cutoff point.

Tip: Use values lower than 80 to give more brilliance to the sound. At values higher than 80, the sound will result in a
strong audible boost around the cutoff frequency.

Use the Env to determine the amount of influence the filter envelope has on the cutoff frequency. Higher settings will
increase the modulation of the filter by the envelope; lower settings will result in only subtle changes of the filter Cutoff
over time.

Tip: To give a sound a more distinctive attack, increase the Env setting and set low Atk and Decay values as well as
a medium-low Sust value of the Filter Envelope. This will start a sound with the filter opened and close it shortly
afterward, giving it a bright start followed by a darker sustain. String sounds, on the other hand, can sound much more
“alive” with low Env settings and a high Atk value, resulting in a slight fade-in of the higher frequencies.

Use the Modulation Sources knobs to set how much velocity is required to modulate certain other parameters:

o Kbd>Flt (Keyboard=+ Filter) sets how much the note value will be added to the filter cutoff. This allows samples to
sound brighter as they are played higher on the keyboard.

o Vel>Atk (Velocity® Attack) sets how much velocity is needed (for a triggered pad) to modulate the Attack phase
for the Amp envelope.

e Vel>Env (Velocity®Envelope) enables velocity information to control the amount of the filter envelope’s effect
on the cutoff frequency.

e Vel>FIt (Velocity®Filter) uses the velocity of a pad to modulate the cutoff frequency directly.

The Filter Envelope controls affect the filter frequency. Use the fields or tap and drag the “handles” of the envelope to
shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with the
Env knob. See Anatomy of an Envelope to learn about the envelope parameters.

The Amp Envelope controls affect level changes over time. Use the fields or tap and drag the “handles” of the envelope
to shape the envelope or time-variant modulation output. Adjust the envelope’s influence on the filter frequency with the
Env knob. See Anatomy of an Envelope to learn about the envelope parameters.
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The Velocity Sensitivity controls determine how much the velocity affects the pitch of the sound (Pitch), the attack of
the filter envelope (Attack), the volume level of the sound (Amp), and the panning of the sound (Pan).

When you press a pad softly, only minimal modulation is applied. When you press it harder, the modulation amount also
gets stronger depending on the setting of the corresponding knob.

A low-frequency oscillator (LFO) generates a periodic waveform with an adjustable frequency and shape which can be
used for modulation purposes.

Use the Wave field to select the LFO waveform type:
¢ Sine (best suited for smooth modulations)
e Triangle (best suited for smooth modulations)
e S&H (samples a random value and holds it until the next value is generated)
e Saw (can generate interesting filter or volume changes)
e Saw Down (can generate interesting filter or volume changes)
e Square (interesting results with hard-panning modulations)

¢ Noise (generates random values and glides)
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Use the Rate field to determine the LFO frequency. At lower values, it might take some time for the LFO to complete a
cycle, while higher values will come closer to audible range.

Use the Sync field to set if the LFO’s rate is synchronized with the tempo. You can select one of several time divisions
(a . indicates a dotted note; a T indicates a triplet-based time division). When None is selected, Sync is off.

Use the Destinations sliders to determine how much the LFO affects the pitch of the sound (Pitch), the cutoff frequency
of the filter (Filter), the volume level of the sound (Amp) and the panning of the sound (Pan).

The Controller Mod section determines the influence of additional play controllers on various sound parameters.

Important: To use these parameters, make sure that a connected MIDI device can send pitch bend messages as well
as aftertouch and modulation wheel data.

Pitch Bend sets the range (in semitones) of a connected MIDI keyboard’s pitch-bend wheel.

Wheel>LFO determines how much a connected MIDI keyboard’s modulation wheel affects the LFO intensity.

Aft>Filt (AftertouchFilter Cutoff) determines how much a connected MIDI keyboard’s aftertouch data affects the filter
cutoff.

208



Effects

Classic Bass

INSERTS

Chorus 2-voice [2 in 2 out]

NO EFFECT

NO EFFECT

MASTER SAMPLES PAN VELOCITY FILTER/ENV LFO MODULATION EFFECTS

Inserts

You can select up to four insert effects for each keygroup. To learn how to use insert effects, please see General
Features > Effects > Insert Effects.

Important: When using keygroup insert effects, they will be applied to that keygroup only. Keep this in mind if you load
insert effects to multiple keygroups with overlapping note ranges—the effects will overlap in that range as well.

To add an effect:
1. Double-tap the desired Inserts slot. A list of effects will appear.
2. Swipe up or down to move through the list.
You can tap the Type and Manufacturer buttons to sort your effects by those categories.
3. To load an effect, double-tap it, or tap Select.

To close the list, tap Close.

To remove an effect from its slot, tap the trash can icon.

To enable or disable the effect, tap the On/Off button for the slot.
To enable or disable all four insert effects, tap the All On/Off button in the upper-right corner.

209



To adjust the effect’s parameters, tap the pencil icon. Use the sliders to set the value of each parameter. These
values affect only this instance of the effect; insert effects are not global.

INSERT INSERT

& AR Enhancer PreeBa 1 “ & Reverb Small ) “

0.0dB

12.0dB I

-4.4 dB I

DENSITY

ENHANCER REVERB SMALL

To load an effect preset, tap the folder icon next to the preset name at the top of the display to open the file browser.

To save a new effect preset, tap the disk icon next to the insert selector at the top of the display.

Sends

The audio of the track will be routed to send effects (if you have any loaded) at their designated send levels. The return
channels will then send the audio to an assigned master output at the designated return levels.

Use the Send knobs to set the volume level of the signal the track will route to each send effect.

You can select up to four send effects for each keygroup, but remember that they will be applied to that keygroup only.
Keep this in mind if you load insert effects to multiple keygroups with overlapping note ranges—the effects will overlap
in that range as well.

Important: To use a send effect, you have to load an effect into the corresponding send effect slot in the Mixer. See
General Features > Effects > Send/Return Effects to learn more how to do this.
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Plugin Tracks

TubeSynth Chords TubeSynth Soft Perc Chords

Oscillator 1 Oscillator 2

OCTAVE FINE OCTAVE FINE

* & & ©

16 0.00 16 -0.01

HINASIEHL

F-ENV + SHAPE F-ENV  SHAPE

0%

MICRO DETUNE

e 9

PHASE
0 degrees

OSCILLATOR MIXER / FILTER ENVELOPE

For plugin tracks, you will see an overview of all available plugin parameters with a slider for each, or a visual
representation of the plugin interface.

Use the sliders to set the value of each parameter, or use the plugin interface.

Use the tabs at the bottom of the screen to access the available parameters.

To load a plugin preset, tap the folder icon next to the preset name at the top of the display to open the file browser.

To save a new plugin preset, tap the disk icon next to the insert selector at the top of the display.
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MIDI Tracks

Midi 001

For MIDI tracks, you will see an overview of all available MIDI CCs with a slider for each.

Use the sliders to set the value of each parameter.

Use the six tabs at the bottom of the screen to access the available parameters.
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CV Tracks

For CV tracks, you will see an overview of all available CV outputs with a slider for each.

Use the sliders to set the value of each parameter.

Use the six tabs at the bottom of the screen to access the available parameters.
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Anatomy of an Envelope

An envelope creates a variable control signal. It can be used, for instance, to modulate the filter settings of a sound over
a given period of time.

For drum tracks, use the AD/AHDS selector to select an AD or AHDS envelope. When Sample Play is set to Note-On, it
will use an ADSR envelope.

Keygroup tracks always use AHDS envelopes. When Sample Play is set to Note-On, it will use an ADSR envelope.

With AHDS envelopes, the following happens when you trigger a [RaETETT
sample:

1.  Within the period of time you have defined with the attack (Atk), the
sample volume rises to its maximum value.

2. The sample’s maximum volume will be maintained during the
Hold phase.

3. During the Decay phase, the sample’s volume will gradually drop
to the sustain level.

4. The sample’s volume will stay at the sustain level (Sust) until the
pad is released.

With AD envelopes, the following happens when you trigger a sample: R R ELRE

1.  Within the period of time you have defined with the attack (Atk), the
sample volume rises to its maximum value.

2. The sample’s maximum volume will be maintained until its Decay
phase, when the sample’s volume will gradually drop to zero over the
set duration. Tap the Type drop-down menu to select how the decay
functions:

e Decay From Start: The volume will start decreasing
immediately after reaching its maximum level.

e Decay From End: The maximum volume will be
maintained for a hold phase until it reaches the decay
phase.

With ADSR envelopes, the following happens when you trigger a [P
sample:

1. Within the period of time defined by Attack, the sample volume
rises to its maximum value.

2. During the Decay phase, the sample’s volume will gradually drop
to the Sustain level.

3. The sample’s volume will stay at the Sustain level until the note is
released.

4. The sample’s volume will drop to “zero” over the duration set by
Release.
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Sample Edit Mode

Sample Edit Mode lets you edit samples using various functions.

To enter Sample Edit Mode, press Menu, and then tap Sample Edit.

IbizaHouse-FX-IH SFX 08

430244

PAD - ASSIGN PROCESS

To select a sample to edit, use the Sample field at the top of the screen.

To edit the name of the sample, tap the keyboard icon next to the name at the top of the screen, and use the virtual
keyboard that appears.

To delete the sample, tap the trash-can icon next to the name at the top of the screen. In the screen that appears,
you will see the tracks that use this sample within your project. Tap Delete Sample to continue, or tap Cancel to return
to the previous screen.
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To enable the Sample Edit pad controls, tap the pads icon next to the name at the top of the screen.

When in Trim Sample Edit Mode, the lower-left quadrant of pads can be used to audition certain parts of the selected

sample:

Play to Loop Play from Loop Play Loop
Play Loop Start Start Continuous
13 14 15 16
Play Sample Play Sample .
Play All (One Shot) (Note On) No function
09 10 11 12
Play from Start Play to Start Play to End Play from End
(Note On) (Note On) (Note On) (Note On)
05 06 07 08
Play from Start Play to Start Play to End Play from End
(One Shot) (One Shot) (One Shot) (One Shot)
01 02 03 04

Play Sample (One Shot) (Pad 10) plays the sample once from the start point to the end point. Press the pad once
to play it.

Play Sample (Note On) (Pad 11) plays the sample once from the start point to the end point. Press and hold the
pad to play it, and release the pad to stop playing it. Alternatively, select the headphones icon in the upper-right
corner, and then tap and hold your finger on the waveform.

Play Loop Continuous (Pad 16) plays the sample repeatedly using the mode set by the Loop button (Forward,
Reverse, or Alternating; if the Loop button is off, the sample will loop forward repeatedly).

Play Loop (Pad 13) plays the sample repeatedly using the mode set by the Loop button (Forward, Reverse, or
Alternating; if the Loop button is off, the sample will loop forward repeatedly). Press and hold the pad to play it,
and release the pad to stop playing it.

Play to Loop Start (Pad 14) plays the part of the sample just before the loop point. Press and hold the pad to play
it, and release the pad to stop playing it.

Play from Loop Start (Pad 15) plays the sample from the loop point to the end of the sample regardless of the end
point. Press and hold the pad to play it, and release the pad to stop playing it.

Play All (Pad 9) plays the entire sample.

Pads 1-4 have the same respective functions as Pads 5-8, but Pads 1-4 play the sample part as “One Shots”
(pressing the pad once will play the entire part) while Pads 5-8 play the sample part as “Note Ons” (pressing the pad
and holding it will play the part; releasing it will stop playback):

Play from Start (Pad 1, Pad 5) plays the sample from the start point to the end point.

Play to Start (Pad 2, Pad 6) plays the part of the sample just before the start point to the start point.
Play to End (Pad 3, Pad 7) plays the part of the sample just before the end point to the end point.

Play from End (Pad 4, Pad 8) plays the part of the sample from the end point to the end of the sampile.

When in Chop Sample Edit Mode, you can use the lower-left quadrant of pads to add slices to the current sample or
trigger existing slices.

When the current Track is a Drum Track and Pad Sample Edit Mode is selected, you can use the lower-left quadrant of
pads to audition the current sample of the current pad, similar to using Notes mode with a Drum Track.
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The upper half of the screen shows the waveform. The lower half shows the editing controls.

IbizaHouse-FX-IH SFX 08
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The waveform display shows the “active” section of the sample waveform. Swipe left or right on the waveform to move
through it.

Above the waveform is the timeline, shown in Samples, Time (in seconds and milliseconds), or Beats. You can select
the measurement units you want to show in the Settings.

To zoom in or out, do any of the following:

e When the magnifying-glass icon (in the upper-right corner) is selected, spread or pinch your fingers
(respectively) on the waveform.

e Tap the Zoom + or Zoom - buttons (respectively) at the bottom of the screen.
e Turn Knob 8 when the knobs are set to screen mode.

To scroll through the waveform, do either of the following:
¢ When the magnifying-glass icon (in the upper-right corner) is selected, swipe the waveform left or right.
e Turn Knob 7 when the knobs are set to screen mode.

The green marker and red marker are the start point and end point (respectively). These two points define the region of
the sample that will be played.

To move the start point or end point of the selected region, do any of the following:
e Tap and drag its marker left or right.
e Use the Start or End fields shown below the waveform.

e When the knobs are set to screen mode, use Knobs 1 and 2 to adjust the start point or Knobs 3 and 4 to
adjust the end point. Knobs 1 and 3 provide fine adjustment and Knobs 2 and 4 provide coarse adjustment.

Tip: A recorded sample may have some silence at the beginning or end, which makes it difficult to time it correctly in a
musical context. Fix this by adjusting the start point. You can also adjust end point to remove any extra silence or
unwanted audio at the end. In addition to making your workflow easier, having a “tight,” well-edited sample can
enhance your production or performance.

You can use Sample Edit Mode in two different ways: Trim Mode or Chop Mode. The options for each mode are
slightly different. Please refer to the following Trim Mode and Chop Mode parts of this chapter to learn how each
works. Before using these modes, though, you may want to configure your settings —see the following Settings chapter
to do this.

217



Settings

The Settings window lets you configure certain Sample Edit Mode settings.

To view the Settings, tap the gear icon.

{3 SETTINGS

TOGGLE

(. PAGE
il SAMPLES

Use the Cue Play Mode selector to set how the cue playhead will play audio.
e One Shot: Tapping Play Cue will play the entire sample from the cue playhead.
o Toggle: Tapping Play Cue once will start playback from cue playhead. Tapping it once more will stop playback.

Use the Cue Preview selector to set if any audio plays as you move the cue playhead. As you move the cue playhead
through the sample waveform, you can set it to play the small part of the sample before the cue playhead (Before), play
the small part of the sample after the cue playhead (After), or not play at all (Off). You can also set this in your overall
Preferences (see General Features > Menu > Preferences > General).

Use the Slice Preview selector to set if any audio plays as you move a slice marker. As you move the slice marker
through the sample waveform, you can set it to play the small part of the sample before the slice marker (Before), play
the small part of the sample after the slice marker (After), or not play at all (Off). You can also set this in your overall
Preferences (see General Features > Menu > Preferences > General).

Use the Auto-Scroll selector to set how the screen behaves relative to the audio playhead.

e Follow: Depending on the zoom setting, the waveform will scroll along in the background, keeping the audio
playhead centered.

e Page: The waveform display will move to the “next page” to follow the audio playhead.
e Off: The waveform display will not move at all.

These functions also apply to the sample waveform in the Grid Mode.

Use the Timeline Units selector to set the measurement units shown above the sample waveform. You can select one
of the following options:

e Time: hours:minutes:seconds:frames
e Samples: number of samples

e Beats: bars:beats:ticks
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Trim Mode
We recommend using Trim Mode to crop the start and/or ends from a sample.

To enter Trim Mode, tap the Trim/Chop button in the lower-left corner so it says Trim.
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Use the Start and End fields to set the position of the start point and end point of the sample (respectively).
Alternatively, tap and drag the start (S) or end (E) marker left or right, or use Knobs 1 and 2 to adjust the start point or
Knobs 3 and 4 to adjust the end point when the knobs are in screen mode.

Trim Mode includes a loop function. When on, the region of the sample between the loop point and end point will repeat.
This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To adjust the loop point, do any of the following:
e Use the Loop field.
e Tap and drag the start (S) marker (if Loop Lock is on) or the loop marker (if Loop Lock is off).

e When the knobs are in screen mode, use Knobs 5 and 6 to adjust the loop marker. Knob 5 provides fine
adjustment and Knob 6 provides coarse adjustment.

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop point is the same as the start point. When
off, the loop point is independent from the start point and indicated by a separate loop marker.

To turn the loop function on or off, tap the Loop button to cycle between the four modes:
e  Off: The sample will not loop.
e Forward: When the loop reaches its end point, it will start playing again from the loop point.

e Reverse: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will
return to the end point and continue playing in reverse.

e Alternating: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it
will start playing forward again from the loop point.

To switch between Forward and off, press and hold Shift, and then tap Loop at the bottom of the screen.
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Use the Tune field to transpose the sample up or down from its original pitch.

EX EDITTUNING

BassHouse-Vocal-BH Vox 4

TO PROJECT

Tap From BPM to open the Edit Tuning window, which lets you tune a sample to the project.

Use the Beats field to match the number of beats in the sample.

To tune the sample to the project, tap Match. The Tune field will adjust automatically and close the window. The
sample is now tuned to the project.

To tune the sample to the project and adjust the project tempo, tap To Project. This is the same as tapping
Match but it also changes the project's tempo to the BPM shown in the Tempo field on the right.

To close the window, tap Close.

E) epreem

DETECT TAP TEMPO

To enter a tempo manually, use the BPM field.
To detect the tempo automatically, tap Detect. In the Edit BPM window that appears, you can do any of the following:

e Use the BPM field to enter a tempo manually.

o Tap Detect to detect the tempo automatically.

o Tap Tap Tempo at the bottom of the screen at the desired rate to use it as the tempo.

e Tap Close, the X, or anywhere outside the window to close it.
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Use the Root Note field to set the root note of the sample. This defines which note will play the sample at its original
pitch when in a keygroup track.

Tap X-Fade to open the X-Fade window, which lets you apply real-time crossfade looping to sample playback. Before
applying a crossfade, make sure the Loop Lock setting is Off and the Loop function is set to Forward. Then, you can
set the Length of the crossfade and the Type, either Equal Power or Linear.

To select a slice to edit, (after you have created slices in Chop Mode), use the Slice field.

When Link Slices is enabled (after you have created slices in Chop Mode), changing the start point of a slice will also
change the end point of the previous slice. Similarly, changing the end point of a slice will also change the start point of
the next slice. Disable Link Slices if you are trying to create slices that use non-contiguous parts of the sample.

To enable or disable this feature, tap the Link Slices button.
Important: Link Slices must be disabled to make slices non-sequential, noncontiguous, or overlapping.

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help
to avoid clicks and glitches when playing a sample.

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom of the screen.

To enable or disable the loop function, press and hold Shift, and then tap Loop at the bottom of the screen. This
switches the loop function between Forward and off. The loop function is described earlier.

Tip: You can use Trim Mode for a specific slice of the sample, previously created and selected in Chop Mode. This
allows for a more detailed view of a single slice than in Chop Mode and gives you more options for auditioning the slice.
You can easily switch between Trim Mode and Chop Mode while doing this.

To use both Trim Mode and Chop Mode to edit a sample slice:
1. Tap Trim/Chop at the bottom of the screen so it says Chop.
2. Set all fields as desired to create your sample slices.

3. Select the desired slice.
4

Tap Trim/Chop at the bottom of the screen so it says Trim. The region you are now editing is indicated by the normal
start point and end point markers rather than slice markers.

5. Tap Trim/Chop at any time to return to Chop Mode.
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Assigning Samples

You can assign your new sample directly to a pad from Trim Mode.
To assign a sample, tap Assign at the bottom of the screen to open the Assign Sample window.

Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

If you set the Assign To field to Assign slice to a pad, the pad will
simply refer to the slice in this sample instead of creating a new i ASSIGN SAPLE
sample. This is useful for reducing clutter in your project.

Assign slice to pad

Use the Pad field to select the desired pad. Alternatively, press the
desired pad.

Use the Slice Type field to select how the pad’s layer settings will
be set when the slice is assigned to it (see Track Edit Mode to
learn more about the parameters mentioned below):

¢ Non-Destructive Slice: The pad’s Slice setting will be set
to the slice number.

e Pad Parameters: The pad’s Slice setting will be set to
Pad. The Pad Start and Pad End will be set to the slice’s
start point and end point values, and the Loop Position
will be set to the slice’s start point but with Pad Loop
deactivated.

Use the Track field to specify the track to which you want to add
the slice.

To assign the sample, tap Do It.

To cancel the operation, tap Close, the X, or anywhere outside the
window.
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If you set the Assign To field to Make new sample, this will create a
new sample in your project. (The original sample will remain as it is.) G MR

Make new sample

Use the Pad field to select the desired pad. Alternatively, press the
desired pad.

A01

Check the Crop Sample box to delete the unused parts from the
sample when it's created and assigned. This feature is
destructive, though the project will still contain your original
sample.

Leave this box unchecked to keep the unused parts of the sample
when it is created and assigned. This way, you will still be able to
edit the entire sample further even though you are using only part of
it at the moment.

Use the Track field to specify the track to which you want to add
the slice.

To assign the sample, tap Do It.

To cancel the operation, tap Close, the X, or anywhere outside the
window.
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Processing Slices & Samples

Tap the Process button to open the Process window, where you can select an editing option for the sample.

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the screen to open
the Function window, which displays an overview of all available editing processes.

& SELECT FUNCTION

fil)  SLICE

g x
SCARI SILENCE

il ""'"”
NORMALIZE FADEIN

o ©
PITCH SHIFT TIME STRETCH GAIN CHANGE
i SAMPLE

= a»

BIT REDUCE STEREO -> MONO

You can use any of these functions as described below.
To return to Sample Edit Mode, tap Cancel.
To return to the Process window, tap the top of the screen.

Note: All Slice processes will affect only the part of the sample between the start point and the end point. The Sample
processes (Bit Reduce and Stereo -> Mono) will affect the entire sample regardless of its start point or end point.

The Discard process deletes the regions before the start point and
after the end point. Fi. processsuce

Discard

Pressing 'Do It' will discard the data

FUNCTION

The Delete process deletes the region between the start point and
end point and closes the gap between them. e fEnocs i

Delete

Pressing 'Do It' will delete the section

FUNCTION
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The Silence process replaces the region between the start point and
end point with silence.

The Extract process deletes the regions before the start point and
after the end point and saves it as a new sample in your current
project.

Use the Edit Name field (and the virtual keyboard that appears) to
name the new sample.

Tip: This is useful if you recorded a drum loop and wanted to remove
just a snare drum hit, a kick drum hit, etc. to use separately in the

project.

The Normalize process increases a sample’s level to the highest level
possible without distortion. This is essentially a kind of digital gain
optimization, so you do not have to worry about excessive level
settings when working with samples with a wide range of amplitudes.

The Reverse process reverses the region between the start point and
end point.

iy} PROCESS SLICE

Silence

Pressing 'Do It' will silence the section

FUNCTION

iy} PROCESS SLICE

Extract

NEW SAMPLE

BassHouse-Vocal-BH Vox 1

FUNCTION

iy} PROCESS SLICE

Normalize

FUNCTION

iy} PROCESS SLICE

Reverse

FUNCTION
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The Fade In process sets a fade-in between the start point and end
point. The following types are available:

Linear fades the audio in with a linear curve—a straight line
between the start and end.

Log fades the audio in with a logarithmic curve—quickly rising
at the start and flattening out towards the end.

Exp fades the audio in with an exponential curve—slowly
rising in the beginning and growing steeper towards the end.

The Fade Out process sets a fade-out between the start point
and end point. The following types are available:

Linear fades the audio out with a linear curve—a straight line
between the start and end.

Log fades the audio out with a logarithmic curve—quickly
falling at the start and flattening out towards the end.

Exp fades the audio out with an exponential curve—slowly
falling in the beginning and growing steeper towards the end.

The Pitch Shift process changes the pitch of the sample without
changing its length. This lets you set the sample’s pitch to your
project without affecting the sample’s tempo or duration. You can
adjust it up to 12 semitones, up or down. Keep in mind that the audio
quality may decrease at more extreme settings.

The Time Stretch process lengthens or shortens the sample without
changing its pitch. This is useful for matching the durations of two
samples with different pitches. You can enter the original tempo of the
sample and the desired tempo after processing.
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Use the Beat field to set the desired value number of beats.

Use the New Tempo field to set the new tempo. The Ratio field
will then automatically show the time stretch factor.

Alternatively, to adjust the ratio instead, use the Ratio field to set
the desired ratio. The New Tempo field will then change
automatically based on the new time stretch factor.

iy} PROCESS SLICE

Fade In o/

LINEAR

Pressing 'Do It' will put a fade in

FUNCTION

iy} PROCESS SLICE

Fade Out

e

LINEAR

Pressing 'Do It' will put a fade out

FUNCTION

iy} PROCESS SLICE

Pitch Shift

FUNCTION

iy} PROCESS SLICE

lime Stretch

2

Pressing 'Do It' will change the length of the sample.

FUNCTION



The Gain Change process raises or lowers the volume of the sample.
You can adjust it up to 18 dB, higher or lower. This function is bl b
different than Normalize because it will allow volumes beyond clipping
level. This may be a desired effect, but remember to watch your Gaini@hange
output level!

FUNCTION

The Copy process saves a copy of the sample.

iy} PROCESS SLICE

Use the Edit Name field (and the virtual keyboard that appears) to
name the new sample. Otherwise, the process will add a
consecutive number after the sample name.

Copy

M-
Ls |

NEW SAMPLE

BassHouse-Vocal-BH Vox 1

FUNCTION

The Bit Reduce process lowers the bit resolution of a sample,
effectively reducing its degree of faithful reproduction. You can reduce
it down to 1 bit. (The sound is similar to the Resampler effect, but Bit
Reduce will permanently alter the sample.)

“lie PROCESS SAMPLE

Bit Reduce
Tip: Use this on drum loops to get a dirty, “old-school” sizzle but with
a digital “edge.”

Note: This process affects the entire sample regardless of its start
point or end point.

FUNCTION

The Stereo -> Mono process converts a stereo sample to a new mono
sample and saves it as a new sample. e prOCESSSAMPLE

Use the Edit Name field (and the virtual keyboard that appears) to
name the new sample. Otherwise, the process will add a
consecutive number after the sample name.

Stereo > Mono

The following options are available:

e Left will convert the left channel only.

BassHouse-Vocal-BH Vox 1

¢ Right will convert the right channel only.

e Sum will combine the left and right audio channels to a Fncron
single mono channel.

Note: This process affects the entire sample regardless of its start
point or end point.
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Chop Mode

Whereas Trim Mode crops only the start and/or end off of a sample, Chop Mode divides the sample into multiple
regions called slices. We recommend using Chop Mode when working with a long sample with different sounds
throughout (e.g., a drum loop or a long melodic or harmonic passage).

To enter Chop Mode, tap the Trim/Chop button in the lower-left corner so it says Chop.
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Use the Start and End fields to set the position of the start point and end point (respectively) of the currently selected
slice. Alternatively, tap and drag the start (S) or end (E) marker left or right, or use Knobs 1 and 2 to adjust the start point
or Knobs 3 and 4 to adjust the end point when the knobs are in screen mode.

Use the selector in the lower-left corner of the screen to choose how you want to use Chop Mode:

Manual
This method lets you insert slices at locations you select.

Threshold

This method uses an adjustable detection algorithm that derives the number of slices created from the volume
levels present in the sample.

Use the Threshold field to set the threshold level. The higher the selected value, the more slices will be created.
Use the Min Time field to set the minimum length of a slice in milliseconds.

Regions
This method divides a sample into several slices of equal length.

Use the Regions field to set how many regions the sample will be divided into. The higher the selected value,
the more slices will be created.

BPM
This method divides a sample into several slices based on the tempo (beats per minute).
Use the Bars field to set how many bars are in the sample.
Use the Beats field to set how many beats are in each bar.

Use the Time Div field to set a note division. The slice markers will be placed according to this setting. You can
select 1/4, 1/8, 1/16, or 1/32. (In most cases, you should set this parameter to 1/16.)
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To play a slice, when the headphones icon (in the upper-right corner) is selected, tap a slice in the waveform.

When the One Shot feature is enabled, you can press a pad once to play the entire slice. When this is disabled,
pressing the pad and holding it will play the slice; releasing it will stop playback.

To enable or disable One Shot, press and hold Shift, and then tap One Shot.

To select a slice to edit, do any of the following:
e Use the Slice field.
e \When the knobs are in screen mode, turn Knob 6.

¢ When the headphones icon (in the upper-right corner) is selected, tap a slice in the waveform.

To add a slice at the current playhead position, tap Slice+ at the bottom of the screen. You can do this at any point
during sample playback.

65X  SPLIT/COMBINE REGION

Do you want to

SPLIT THE REGION COMBINE WITH PREVIOUS

r

J

COMBINE

To split or combine slices, tap the glue-and-scissors icon. In the Split/Combine Region screen that appears, tap
one of the following buttons:

e Split: This splits the currently selected region into two equal slices.
e Combine: This combines the currently selected region with the one before it.

e Back: This closes the window.
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PLAY CUE SLICE +

When Link Slices is enabled, changing the start point of a slice will also change the end point of the previous slice.
Similarly, changing the end point of a slice will also change the start point of the next slice. Disable Link Slices if you
are trying to create slices that use non-contiguous parts of the sample.

To enable or disable this feature, tap the Link Slices button.

Important: Link Slices must be disabled to make slices non-sequential, noncontiguous, or overlapping.

To remove all slices from a sample, press and hold Shift and tap Clear All.

The cue playhead is useful when manually inserting slice markers. You can set its position and behavior to suit your
workflow.

To adjust the position of the Cue playhead, do any of the following:
e Use the Cue field.
e Tap and drag the translucent marker with the triangle (»).
e When the knobs are in screen mode, turn knob 5.
To play the sample from the cue playhead, tap Play Cue at the bottom of the screen.
To create a slice marker at the cue playhead position, tap Slice+ at the bottom of the screen.

To set how the cue playhead behaves, use the Settings window (described earlier).

0 Snap forces start points and end points to occur only at the waveform’s “zero-crossings.” This can help to avoid
clicks and glitches when playing a sample.

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom of the screen.
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Converting or Assigning Slices

You can assign your new sample directly to a pad from Chop Mode. You can also convert it into a new track or patched
phrase.

To convert or assign a sample, press and hold Shift, and then tap Convert at the bottom of the screen to open the
Convert or Assign Slices window.

If you set the Convert To field to New drum track using slices, this

will create a new track and assign the sample’s slices to its pads. The i CONVERT OR ASSIGN SLICES
pads will simply refer to the slices in this sample instead of creating new
samples. This is useful for reducing clutter in your project. The new New drum track using slices

track will be named after the sample and appended with ch.

Non-destructive slice

Use the Slice Type field to select how each pad’s layer settings will
be set when the slices are assigned to them (see Track Edit Mode
to learn more about the parameters mentioned below):

¢ Non-Destructive Slice: Each pad’s Slice setting will be set to
the slice number.

e Pad Parameters: Each pad’s Slice setting will be set to Pad.
The Pad Start and Pad End parameters will be set to the
slice’s start point and end point values, and the Loop Pos
parameter will be set to the slice’s start point but with Pad
Loop deactivated.

Check the Create Events box to automatically create a new clip
in which each pad plays its corresponding slice in ascending
sequence by pad number.

If Create Events is checked, use the Bars field to set how many
bars the slices’ events will occupy.

VELOTITY

To convert the sample, tap Do It.

To cancel the operation, tap Close. oo eor T L T
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If you set the Convert To field to New track with new samples, this
will create a new sample from each slice and assign them to pads in a
new track.

The new track will be named after the sample and appended with ch.
The new samples will be appended with SI-# (where # is a consecutive
number).
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Check the Crop Samples box to delete the unused parts from the
sample when they are created and assigned. This feature is
destructive, though the project will still contain your original
sample.

Leave this box unchecked to keep the unused parts of the
samples when they’re created and assigned. This way, you will
still be able to edit the entire samples further even though you are
using only part of them at the moment.

By default, this option already will create a new track. You can
uncheck the Create new track box to convert each slice into a
sample that is placed in the project’s sample pool but not
assigned to a track or pad.

If Create new track is checked, check the Create Events box to
automatically create a new clip in the new track in which each pad
plays its corresponding slice in ascending sequence by pad
number.

If Create Events is checked, use the Bars field to set how many
bars the slices’ events will occupy.

To convert the sample, tap Do It.
To cancel the operation, tap Close.

VELOTITY

DONT SNAP

#i CONVERT OR ASSIGN SLICES

New track with new samples

EDIT START

EDITEND

TRANSPOSE

VELOCITY




If you set the Convert To field to Assign slice to a pad, the pad will
simply refer to the slice in this sample instead of creating a new
sample. This is useful for reducing clutter in your project.

Important: Assigning a sample to a pad in this way will replace the
sample on the first layer of the pad.

Use the Pad field to select the desired pad. Alternatively, press the
desired pad.

Use the Slice Type field to select how the pad’s layer settings will
be set when the slice is assigned to it (see Track Edit Mode to
learn more about the parameters mentioned below):

¢ Non-Destructive Slice: The pad’s Slice setting will be set to
the slice number.

o Pad Parameters: The pad’s Slice setting will be set to Pad.
The Pad Start and Pad End will be set to the slice’s start
point and end point values, and the Loop Position will be set
to the slice’s start point but with Pad Loop deactivated.

Use the Track field to specify the track to which you want to add
the slice.

To convert the sample, tap Do It.

To cancel the operation, tap Close.

If you set the Convert To field to Make new sample, this will create a
new sample in your project. (The original sample will remain as it is.)

Important: Assigning a sample to a pad in this way will replace the
sample on the first layer of the pad.

Use the Pad field to select the desired pad. Alternatively, press the
desired pad.

Check the Crop Sample box to delete the unused parts from the
sample when it's created and assigned. This feature is
destructive, though the project will still contain your original
sample.

Leave this box unchecked to keep the unused parts of the sample
when it is created and assigned. This way, you will still be able to
edit the entire sample further even though you are using only part of
it at the moment.

Use the Track field to specify the track to which you want to add
the slice.

To convert the sample, tap Do It.

To cancel the operation, tap Close.

#i CONVERT OR ASSIGN SLICES

Assign slice to pad

A01

Non-destructive slice

#i CONVERT OR ASSIGN SLICES

Make new sample

A01

Top Loop
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If you set the Convert To field to Patched phrase, this will create a
new sample that will play based on the tempo of your project, and
places it in the current project. The patched phrase will have the same
name as the original sample but appended with pp and will use a Patched phrase
different icon when viewing your project information.

#i CONVERT OR ASSIGN SLICES

2

Use the Bars field to set how many bars long the patched phrase
is meant to be.

Processing Slices

Press and hold Shift, and then tap the Process button to open the Process window, where you can select an editing
option for the currently selected slice. (This has fewer options than Trim Mode. Unavailable ones are darkened.)

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the screen to open
the Function window, which displays an overview of all available editing processes.

Important: Chop Mode is non-destructive: You can choose the slice/edit behavior without destroying your original sample,
giving you more control over sample playback; you can save your sliced sample and but also reuse all of the slice data in
another project. See the Track Edit Mode chapter to learn more about setting a pad to play the entire sample, a specific
slice of a sample, or a specific region of the sample (independent of its slice markers).

< SELECT FUNCTION

Fily] - SLICE
g x £ [

SILENCE EXTRACT

il ~---II||| |||||-...
NORMALIZE REVERSE FADE IN FADE OUT

I~ ©
PITCH SHIFT GAIN CHANGE

A SAMPLE

You can use any of these functions as described below.
To return to Sample Edit Mode, tap Cancel.
To return to the Process window, tap the top of the screen.

Note: All processes here will affect only the currently selected slice.
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The Silence process replaces the region between the start point and
end point with silence.

The Extract process deletes the regions before the start point and
after the end point and saves it as a new sample (with a name you
enter) in your current project.

Tip: This is useful if you recorded a drum loop and wanted to remove
just a snare drum hit, a kick drum hit, etc. to use separately in the
project.

The Normalize process increases a sample’s level to the highest level
possible without distortion. This is essentially a kind of digital gain
optimization, so you do not have to worry about excessive level
settings when working with samples with a wide range of amplitudes.

The Reverse process reverses the region between the start point and
end point.

iy} PROCESS SLICE

Silence

Pressing 'Do It' will silence the section

FUNCTION

iy} PROCESS SLICE

Extract

NEW SAMPLE

BassHouse-Vocal-BH Vox 1

FUNCTION

iy} PROCESS SLICE

Normalize

FUNCTION

iy} PROCESS SLICE

Reverse

FUNCTION
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The Fade In process sets a fade-in between the start point and end
point. The following types are available:

Linear fades the audio in with a linear curve—a straight line
between the start and end.

Log fades the audio in with a logarithmic curve—quickly rising
at the start and flattening out towards the end.

Exp fades the audio in with an exponential curve—slowly
rising in the beginning and growing steeper towards the end.

The Fade Out process sets a fade-out between the start point and
end point. The following types are available:

Linear fades the audio out with a linear curve—a straight line
between the start and end.

Log fades the audio out with a logarithmic curve—quickly
falling at the start and flattening out towards the end.

Exp fades the audio out with an exponential curve—
slowly falling in the beginning and growing steeper
towards the end.

The Pitch Shift process changes the pitch of the sample without
changing its length. This lets you set the sample’s pitch to your
project without affecting the sample’s tempo or duration. You can
adjust it up to 12 semitones, up or down. Keep in mind that the audio
quality may decrease at more extreme settings.

The Gain Change process raises or lowers the volume of the sample.
You can adjust it up to 18 dB, higher or lower. This function is
different than Normalize because it will allow volumes beyond clipping
level. This may be a desired effect, but remember to watch your
output level!
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[ilm] - PROCESS SLICE

Fade In v

LINEAR

Pressing 'Do It' will put a fade in

FUNCTION

[ilm] - PROCESS SLICE

Fade Out

[

LINEAR

Pressing 'Do It' will put a fade out

FUNCTION

[ilm] - PROCESS SLICE

Pitch Shift

FUNCTION

[ilm] - PROCESS SLICE

Gain Change

FUNCTION



Pad Mode

Pad Mode lets you edit a sample in the context of the track in which you’ll use it. You can adjust the pad parameters as
though you were in Track Edit Mode, auditioning and hearing how it will sound in the program’s audio path.

To enter Pad Mode, tap the Pad button at the bottom of the screen. The pads will show their assighed samples in the
current Program.

IbizaHouse-FX-IH SFX 08

LINK
SLICES
LOOP LOCK

ASSIGN PROCESS

Use the Start and End fields to set the position of the start point and end point of the sample (respectively).
Alternatively, tap and drag the start (S) or end (E) marker left or right, or use Knobs 1 and 2 to adjust the start point or
Knobs 3 and 4 to adjust the end point when the knobs are in screen mode.

Program Mode includes a loop function. When on, the region of the sample between the loop point and end point will
repeat. This is useful when trying to find an ideal spot to begin the sample. The loop cannot be earlier than the start point.

To adjust the loop point, do any of the following:
e Use the Loop field.
e Tap and drag the start (S) marker (if Loop Lock is on) or the loop marker (if Loop Lock is off).

e When the knobs are in screen mode, use Knobs 5 and 6 to adjust the loop marker. Knob 5 provides fine
adjustment and Knob 6 provides coarse adjustment.

To turn Loop Lock on or off, tap the Loop Lock button. When on, the loop point is the same as the start point. When
off, the loop point is independent from the start point.

To turn the loop function on or off, tap the Loop button to cycle between the four modes:
Off: The sample will not loop.
Forward: When the loop reaches its end point, it will start playing again from the loop point.

Reverse: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will
return to the end point and continue playing in reverse.

Alternating: When the loop reaches its end point, it will play in reverse. When it reaches the loop point again, it will
start playing forward again from the loop point.

To switch between Forward and off, press and hold Shift, and then tap Loop at the bottom of the screen.

Tap each pad to hear its sample/samples. The sample on its first layer will automatically appear in the waveform display
for editing.
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Use the Tune field to transpose the sample up or down from its original pitch.

Tap From BPM to open the Edit Tuning window, which lets you tune a sample to the current sequence.

EX EDITTUNING

BassHouse-Vocal-BH Vox 4

-200 -~ 120,00

TO PROJECT

Use the Number of Beats field to match the number of beats in the sequence.

To tune the sample to the project, tap Match. The Tune field will adjust automatically and close the window. The
sample is now tuned to the sequence.

To tune the sample to the project and adjust the project tempo, tap To Project. This is the same as tapping
Match but it also changes the project's tempo to the BPM shown in the Tempo field on the right.

To close the window, tap Close.

Use the Root Note field to set the root note of the sample. This defines which note will play the sample at its original
pitch when in a keygroup program.

Use the Slice field to display either the sample as it has been edited (Pad) or the entire sample (All).

If the Slice field is set to All, you can display the sample as it has been edited but keep the start point and end point. To
do this, press and hold Shift, and then tap To Pad at the bottom of the screen. The Slice field will change to Pad, but
the start point and end point will remain in their current locations.



BassHouse-Vocal-BH Vox 4 e | ]
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LINK

LOOP LOCK

ASSIGN PROCESS

The Link Slices button does not have a function in Pad Mode.

0 Snap forces start points, end points, and loop points to occur only at the waveform’s “zero-crossings.” This can help
to avoid clicks and glitches when playing a sample.

To enable or disable 0 Snap, press and hold Shift, and then tap 0 Snap at the bottom of the screen.

To enable or disable the loop function, press and hold Shift, and then tap Loop at the bottom of the screen. This
switches the loop function between Forward and off. The loop function is described earlier.
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Assigning Samples

You can assign your new sample directly to a pad from Pad Mode.
To assign a sample, tap Assign at the bottom of the screen to open the Assign Sample window.
Important: Assigning a sample to a pad in this way will replace the sample on the first layer of the pad.

If you set the Assign To field to Assign slice to a pad, the
pad will simply refer to the slice in this sample instead of #Ii ASSIGN SAVIPLE
creating a new sample. This is useful for reducing clutter in
your project.

Assign slice to pad

Use the Pad field to select the desired pad. Alternatively, AO1
press the desired pad.

Non-destructive slice

Use the Slice Type field to select how the pad’s layer
settings will be set when the slice is assigned to it (see
Track Edit Mode to learn more about the parameters
mentioned below):

Top Loop

¢ Non-Destructive Slice: The pad’s Slice setting will
be set to the slice number.

e Pad Parameters: The pad’s Slice setting will be set
to Pad. The Pad Start and Pad End will be set to the
slice’s start point and end point values, and the Loop
Position will be set to the slice’s start point but with
Pad Loop deactivated.

Use the Program field to specify the program to which
you want to add the slice.

To assign the sample, tap Do It.
To cancel the operation, tap Close.

If you set the Assign To field to Make new sample, this will
create a new sample in your project. (The original sample will 1 ASSIGN SAMPLE
remain as it is.)

Make new sample
Use the Pad field to select the desired pad. Alternatively,
press the desired pad. RO

Check the Crop Sample box to delete the unused parts
from the sample when it's created and assigned. This
feature is destructive, though the project will still contain
your original sample.

Top Loop

Leave this box unchecked to keep the unused parts of the
sample when it is created and assigned. This way, you will
still be able to edit the entire sample further even though
you are using only part of it at the moment.

Use the Program field to specify the program to which
you want to add the slice.

To assign the sample, tap Do It.
To cancel the operation, tap Close.
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Processing Slices & Samples

Tap the Process button to open the Process window, where you can select an editing option for the sample.

Use the Function field to select an editing process. Double-tap it or tap Function at the bottom of the screen to open
the Function window, which displays an overview of all available editing processes.

& SELECT FUNCTION

Fim]  SLICE

g x
SCA SILENCE

il ""'"”
NORMALIZE REVERSE FADEIN

o «&> ©
PITCH SHIFT TIME STRETCH GAIN CHANGE
Al SAMPLE

| a»

BIT REDUCE STEREO -> MONO

You can use any of these functions as described below.
To return to Sample Edit Mode, tap Cancel.
To return to the Process window, tap the top of the screen.

Note: All Slice processes will affect only the part of the sample between the start point and the end point. The Sample
processes (Bit Reduce and Stereo -> Mono) will affect the entire sample regardless of its start point or end point.

The Discard process deletes the regions before the start point and
after the end point. N roms s

Discard

Pressing 'Do It' will discard the data

FUNCTION

The Delete process deletes the region between the start point and
end point and closes the gap between them. e fEnocs i

Delete

Pressing 'Do It' will delete the section

FUNCTION
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The Silence process replaces the region between the start point and
end point with silence.

[ilm] - PROCESS SLICE

Silence

Pressing 'Do It' will silence the section

FUNCTION

The Extract process deletes the regions before the start point and
after the end point and saves it as a new sample in your current i ie

project.
Extract

Use the Edit Name field (and the virtual keyboard that appears) to
name the new sample.

Tip: This is useful if you recorded a drum loop and wanted to remove e saveLe
just a snare drum hit, a kick drum hit, etc. to use separately in the
project.

BassHouse-Vocal-BH Vox 1

FUNCTION

The Normalize process increases a sample’s level to the highest level
possible without distortion. This is essentially a kind of digital gain b iree b
optimization, so you do not have to worry about excessive level

settings when working with samples with a wide range of amplitudes. gl

FUNCTION

The Reverse process reverses the region between the start point and
end pOint_ fil] PROCESS SLICE

Reverse

FUNCTION
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The Fade In process sets a fade-in between the start point and end
point. The following types are available:

[ilm] - PROCESS SLICE

e Linear fades the audio in with a linear curve—a straight line
between the start and end.

e Log fades the audio in with a logarithmic curve—quickly rising
at the start and flattening out towards the end.

e Exp fades the audio in with an exponential curve—slowly Pressing Dot will puta fade n
rising in the beginning and growing steeper towards the end.

FUNCTION

The Fade Out process sets a fade-out between the start point
and end point. The following types are available:

[ilm] - PROCESS SLICE

e Linear fades the audio out with a linear curve—a straight line Fade Out

between the start and end. mNWWV"W

e Log fades the audio out with a logarithmic curve—quickly
falling at the start and flattening out towards the end.

e Exp fades the audio out with an exponential curve—slowly Pressing Do It wil putafade out
falling in the beginning and growing steeper towards the end.

FUNCTION

The Pitch Shift process changes the pitch of the sample without
changing its length. This lets you set the sample’s pitch to your
project without affecting the sample’s tempo or duration. You can
adjust it up to 12 semitones, up or down. Keep in mind that the audio
quality may decrease at more extreme settings.

[ilm] - PROCESS SLICE

Pitch Shift

FUNCTION

The Time Stretch process lengthens or shortens the sample without
changing its pitch. This is useful for matching the durations of two
samples with different pitches. You can enter the original tempo of the
sample and the desired tempo after processing.

[ilm] - PROCESS SLICE

Time Stretch

Use the Beat field to set the desired value number of beats. 2

Use the New Tempo field to set the new tempo. The Ratio field
will then automatically show the time stretch factor.

Alternatively, to adjust the ratio instead, use the Ratio field to set Pressing Do I will change the length of the sample
the desired ratio. The New Tempo field will then change
automatically based on the new time stretch factor. RncroN
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The Gain Change process raises or lowers the volume of the sample.
You can adjust it up to 18 dB, higher or lower. This function is N roms s
different than Normalize because it will allow volumes beyond clipping
level. This may be a desired effect, but remember to watch your Gaini@hange
output level!

FUNCTION

The Copy process saves a copy of the sample.

name the new sample. Otherwise, the process will add a :

Use the Edit Name field (and the virtual keyboard that appears) to
consecutive number after the sample name.

BassHouse-Vocal-BH Vox 1

FUNCTION

The Bit Reduce process lowers the bit resolution of a sample,
effectively reducing its degree of faithful reproduction. You can reduce
it down to 1 bit. (The sound is similar to the Resampler effect, but Bit
Reduce will permanently alter the sample.)

“lie PROCESS SAMPLE

Bit Reduce
Tip: Use this on drum loops to get a dirty, “old-school” sizzle but with
a digital “edge.”

Note: This process affects the entire sample regardless of its start
point or end point.

FUNCTION

The Stereo -> Mono process converts a stereo sample to a new mono
sample and saves it as a new sample. e PROCESS SAUPLE

Use the Edit Name field (and the virtual keyboard that appears) to
name the new sample. Otherwise, the process will add a
consecutive number after the sample name.

Stereo > Mono

The following options are available:

o Left will convert the left channel only.

BassHouse-Vocal-BH Vox 1

¢ Right will convert the right channel only.

e Sum will combine the left and right audio channels to a AncToN
single mono channel.

Note: This process affects the entire sample regardless of its start
point or end point.
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Sampler

The Sampler lets you record audio samples to use in your projects.

Y,

To open the Sampler, press Menu and then tap Sampler.

Input 1,2

00:0/:49

SLICE +

To set up the Sampler before recording:

1. Make sure to reduce the volume levels of your audio source and speakers, headphones, and/or monitors before you
make any connections to avoid “pops” or feedback.

2. Connect your audio source to the input/inputs of your Force hardware.

For line-level devices such as a synthesizer, set the Line/Inst switch to Line; for instrument-level devices such as a
guitar, set the switch to Inst.

If you are using a microphone that requires phantom power, set the +48V switch to On.

3. Turn the Gain knob to set the input level while playing your audio source. You should now see the level in the meter.
Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).

4. Set the recording controls as desired (described in this chapter).

5. Tap the Arm button to record-arm the Sampler.
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The upper-left Input Source field defines whether you are going to record an external
audio signal, which you can set to the pair of inputs (Input 1,2) or a single input (Input 1-2).
You can also select an internal signal from within your Force hardware (Resample L,
Resample R, or Resample L+R).

Resampling does not require an audio connection because the source is internal and is
therefore recorded without any loss in audio quality. You can, for example, use Resample to
record two or more samples by pressing the corresponding pads simultaneously.

Use the second upper-left Mono/Stereo field to choose whether your recorded samples
will be monaural (Mono) or binaural (Stereo).

The Inserts field shows any enabled or disabled effects for the Sampler. Tap the area
under Inserts to open a window where you can load, change, and enable or disable the
effects.

Important: These effects are applied to the audio as you record it. This means that the
effects cannot be “removed” from the sound later. Learn more about how effects work in
General Features > Effects.

Tap the Monitor button to enable or disable input monitoring. When on, the audio you hear
in your headphones will be taken before it reaches the Sampler, ensuring zero latency.
When off, the audio you hear in your headphones will be taken after it is processed in the
Sampler, so there may be some latency, but you will hear the audio source as it sounds in
the recording.

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the
audio sources.

Use the threshold slider to adjust the threshold. Alternatively, turn Knob 1 when the
knobs are set to screen mode.

When the Sampler is record-armed, it automatically starts recording when the level of the
incoming source exceeds this setting. If you set it too high, the recording may not start
when you play the input source, or the start of the material you wanted to record may be
missing. If you set it too low, the recording may start too early, before you play the external
source. Set this parameter to an appropriate level using the level meter.

To reset the “peak hold,” which shows the highest level of your input signal in the level
meter, tap it.
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For reference, the Sample Length counter shows you the length of your sample during the
recording procedure.

00:00:00

Tap Arm to record-arm the Sampler. The button will then change to Record and show RECORD
Waiting for signal.

At that point, start recording by doing either of the following:

e Start performing so that the incoming audio level exceeds the level of the
threshold slider.

e Tap Record under the Sample Length counter.
To disarm the track instead, tap Cancel. OOOOOO

Use the Max Length field to define the maximum sampling time.

You can record up to 15 minutes and 59 seconds (15:59) per sample. We recommend
setting these to values that roughly match your estimated recording duration. The default
value is 20 seconds.
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After you stop your recording, the Keep or Discard Sample window will appear.

il KEEP OR DISCARD SAMPLE

New Sample

Top Loop

A12

DISCARD

Use the New Sample field to name the new sample. Tap it and use the virtual keyboard that appears.

Use the Track field to assign the new sample to a track. Select <none> if you want to save it to the project without
assigning it to a track.

Note: Newly recorded samples can only be assigned to Drum tracks.

Use the Assign to Pad field to assign the sample to a pad in the track.

Use the Root Note field to set where the sample’s original pitch will be on the keyboard.

To confirm your selections, tap Keep at the bottom of the screen.

To discard the recording and return to the Sampler, tap Discard at the bottom of the screen.
To play the recording, tap Play at the bottom of the screen.

To save the recording, tap Save at the bottom of the screen.

To edit the recording in Sample Edit Mode (recommended), tap Edit at the bottom of the screen. See Sample Edit
Mode for more information.
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Auto Sampler

The Sampler page also contains the Auto Sampler, which lets you capture and covert any plugin preset or external
instrument preset into a keygroup sampler patch.

To open the auto sampler, tap the keyboard icon next to the record button in Sampler View. The current +
track will be selected as the auto sample source.

Sample Source Information AUTO SAMPLER

Use the Track name field to select the target auto sampler JEAEIEEEINCIL

source. This is the current track, which determines what will be sampled.

Use the Record from field to select an input to record from. [EFSErTaes Input 1,2
Select one of the Input options to autosample an external

instrument, or select one of the Resample options to autosample

from an internal source.

Note Range

Note range

Use the Min Note and Max Note fields to set the range of notes

that will be created. =

Use the Note Stride field to set the number of semitones between
each new sample.

Check the Extend min/max notes box to sample all the way to
the lowest and highest notes, regardless of the Min Note and
Max Note settings.

Velocity Velocity

Tap the boxes next to Layers 1-4 to select how many layers will
be used to create the sampler patch.

Use the Velocity value sliders to set the velocity of each layer.

Sampling

Use the Note length slider to set the length of the sampled note =
in seconds.

3000ms

Use Tail slider to set the length of the Audio Tail in seconds. This
will add extra seconds to the end of the resulting audio file. This is | SEG—_E———_—Gr——
useful if you are capturing samples whose sounds exceed the
defined audio length (e.g., long reverb or delay, one-shot samples
with long decays, etc.). We recommend using an audio tail of at
least a couple of seconds.

Use Base name to set the naming convention for the samples
that will be created by the Auto Sampler.
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Looping

Use the Enable looping field to select how the resulting samples
can or cannot be looped:

o Off: The sample will not loop. Forwards

Looping

e Forward: You can hold down the pad to cause that
sample to repeat from the Loop Position to the end of the
sample. Release the pad to stop the repeating playback. Bl Fan

e Reverse: You can hold down the pad to cause that
sample to play in reverse, repeating from the end of the
sample to the Loop Position. Release the pad to stop the
repeating playback.

e Alternating: You can hold down the pad to cause that
sample to play from the Loop Position to the end of the
sample and then play in reverse until it reaches the Loop
Position again. This will repeat as long as you are holding
the pad down. Release the pad to stop the repeating
playback.

Use the Loop start and Loop end sliders to set the starting and ending points in the sample where the loop will
occur.

Use the Crossfade slider to set the amount of crossfade between the loop end and loop start in seconds.

Use the Crossfade Type field to select Equal Power or Linear crossfade.

Under On completion, check Make current program to load the
completed sampler patch as the current track.

On completion

Under Info, the Session Duration field provides an estimate of how
long the auto sampling process will take.
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Looper

¢

The Looper lets you record and overdub audio in real time—a great tool for live performance as well as
spontaneous moments in the studio. You can export the loop as a sample to use in your project.

To open the Looper, press Menu, and then tap Looper.

Input 1,2

OVERDUB

Stereo 0.00dB

| aF

EXPORT REVERSE REPLACE OVERDUB

Below is a brief step-by-step process so you can get started quickly. Continue reading the rest of this chapter to learn
how to use the Looper in different cases.

To get started using the Looper:

1.

N o o &

Make sure to reduce the volume levels of your audio source and speakers/headphones/monitors before you make
any connections to avoid “pops” or feedback.

Connect your audio source to the input/inputs of your Force hardware.

For line-level devices such as a synthesizer, set the Line/Inst switch to Line; for instrument-level devices such as a
guitar, set the switch to Inst.

If you are using a microphone that requires phantom power, set the +48V switch to On.

Turn the Gain knob to set the input level while playing your audio source. You should now see the level in the meter.
Make sure it does not exceed the maximum level (the meter should not be “peaking” constantly).

Set the recording controls as desired (described in this chapter).
Tap the Record To selector so Overdub is selected.
Tap the Rec/Record button in the lower-right corner to record-arm the Looper.

Play your audio source. The Looper will start recording immediately when the input level reaches the threshold
value. Alternatively, tap P>/Play at the bottom of the screen to manually start recording.

Each time the Looper repeats, its contents are being overdubbed—a new layer of audio will be added each time you
let the Looper repeat as it records.

Tip: You can record a loop while playing one or more clips in the background for reference.
To stop recording, tap P /Play at the bottom of the screen.
To export your loop as a sample, tap Export to open the Keep or Discard Sample window.

To clear the contents of the Looper, tap Clear.
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The upper-left Input Source field defines whether you are going to record an external
audio signal, which you can set to the pair of inputs (Input 1,2) or a single input (Input 1-2).
You can also select an internal signal from within your Force hardware (Resample L, [EESE™s
Resample R, or Resample L+R).

Resample L + R

Resampling does not require an audio connection because the source is internal and is
therefore recorded without any loss in audio quality. You can, for example, use Resample to
record two or more samples by pressing the corresponding pads simultaneously.

Use the second upper-left Mono/Stereo field to choose whether your recorded loop will be
monaural (Mono) or binaural (Stereo).

The Inserts field shows any enabled or disabled effects for the Looper. Tap the area under
Inserts to open a window where you can load, change, and enable or disable the effects.

Important: These effects are applied to the audio as you record it. This means that the
effects cannot be “removed” from the sound later. Learn more about how effects work in
General Features > Effects.

Tap the Monitor button to enable or disable input monitoring.

When on, the audio you hear in your headphones will be taken before it reaches the Looper, ensuring zero latency.
You can turn input monitoring on only if the Input Source field is set to an input, not to a Resample setting.

When off, the audio you hear in your headphones will be taken after it is processed in the Looper, so there may be
some latency, but you will hear the audio source as it sounds in the recording.

Tip: To avoid possible clicks or feedback while input monitoring, reduce the level of the audio sources.

Use the threshold slider to adjust the threshold. Alternatively, turn Knob 1 when the knobs are set to screen mode.
The threshold slider will work only when Sync is off (see below).

When the Looper is record-armed, it automatically starts recording when the level of the incoming source exceeds this
setting. If you set it too high, the recording may not start when you play the input source, or the start of the material you
wanted to record may be missing. If you set it too low, the recording may start too early, before you play the external
source. Set this parameter to an appropriate level using the level meter.

To reset the “peak hold,” which shows the highest level of your input signal in the level meter, tap it.

Use the Bars field to define the length of your loop. Regardless of
how much or how little audio you record, this is how long your loop 1 sme G

will be 0008

Use the Sync button to sync or un-sync the looper with transport playback. When on, the Looper will stay in step with
your project. When you play or record into the Looper, it will wait until the transport starts playing to start.

Use the Record To selector to determine the loop recording behavior:
e Play: Before recording, you must first tap the »/Play button on the screen, which will start playing the Looper.

e Overdub: Before recording, you must first tap the Rec/Record button in the lower-right corner to record-arm the
Looper.

Use the Output Gain slider to set the output signal level of the Looper.



To record with the Looper:
Important:
To record without erasing any audio you’ve already recorded in the loop, use the Overdub button.

To overwrite the audio you’ve already recorded, use the Replace button.

Input 1,2

OVERDUB

Stereo 0.00dB

| aF

EXPORT REVERSE REPLACE OVERDUB

If Record To is set to Play:

To start recording, tap the Replace or Overdub button as the loop is playing. The Looper will start recording
immediately.

To stop recording, tap the Replace or Overdub button. The Looper will stop recording but continue playing.
To stop playback and recording, tap the /Play button.
If Record To is set to Overdub:
To start recording, tap the »/Play button on the screen.
If Sync is off, you can also play your audio source so that the input level reaches the threshold value.

If Sync is on, you can also press the Play or Play Start button to start transport playback; recording will
start when the transport starts playing.

To stop recording, tap Overdub. The Looper will stop recording but continue playing.

To stop playback and recording, tap the P/Play button, or press Stop to stop transport playback.

To play or stop the loop (without recording), tap the »/Play button on the screen.

To reverse loop playback, tap Reverse. If Sync is on, playback will reverse once the Looper’s playhead reaches the
end of the loop. If Sync is off, playback will reverse immediately.

To erase the loop immediately, tap Clear.
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LOOPER EXPORT

EXPORT TO CLIP

To export the loop as a clip:

1.

2
3.
4

Tap Export to open the Looper Export window.

Use the Audio Track field to select the audio track you would like to export the clip to.
Use the Clip field to select the clip slot where you would like to place the loop.

Tap Export to Clip to confirm your choice, or Cancel to cancel.

When your loop is done exporting, it assigned to the track and clip slot you selected.



FORCE
XYFX Mode
x XYFX Mode turns the touchscreen into an XY pad where each axis represents the range of an effect

parameter. As you move your finger on the XY pad, the current position will determine the current value of the
two parameters. You can use this mode to create interesting effect automation on your tracks.

The effect you control in XYFX Mode acts like an insert effect on that track. In fact, XYFX is the name of the

insert effect you have to load to the track before you can use this mode. Learn more about this in General
Features > Effects.

To enter XYFX Mode, do either of the following:
e Press Menu, and then tap XYFX.
e Press and hold Shift and press Navigate.

Outputs 1/2

HPF Manual

When you first enter this mode in a project, you may be prompted to load XYFX to the track. Tap Insert XYFX to do this.

Note: If you already have four insert effects loaded, you will need to clear one of the insert effect slots before doing this.

Use the XYFX Location field to select the signal to which the effects will be applied: the current track (Track) or a
master output (a stereo pair of channels: Output 1/2 or Output 3/4).
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FORCE

Touch or move your finger on the gridded part of the screen. A marker will follow your finger to indicate the current
position. The X axis is the horizontal axis, increasing in value as you move right. The Y axis is the vertical axis, increasing
in value as you move up. Each axis is labeled with its assigned parameter.

When an effect has a beat division parameter, the current division will be highlighted as an entire column.

Effects are differently colored for easy visual distinction: beat-synchronized effects are blue, while manually controlled
effects are green.

Outputs 1/2

" Beat Repeat LPF

XY Mode with a beat-synchronized effect.

While touching the XY pad, tap Latch in the lower-left corner to keep the marker on the XY pad even after you release
it. The marker will remain there until you touch another part of the XY pad or until you tap Latch again.

Use the Setup button to show or hide the Setup panel, which controls how the XY pad behaves.

Use the Preset field to select the effect you want to use in XYFX Mode.
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FORCE

Outputs 1/2

HPF Manual

XY Mode with a manually controlled effect.

Use the Attack knob to set the length of the attack phase of the envelope, which is triggered when you touch the XY
pad. In other words, this determines how long it takes the effect to fully respond to your touch.

Use the Release knob to set the length of the release phase of the envelope, which is triggered when you release the
XY pad. In other words, this determines how long it takes the effect to fully deactivate after you stopping touching the
XY pad.

Use the Wet/Dry knob to set the blend the original signal (dry) and the effect signal (wet).

The X Axis and Y Axis fields show which parameters are controlled by each axis. This varies depending on the effect
you are using.
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Macros

Macros Mode (formerly Knobs mode) lets you determine what the various hardware controls can be used
for in other modes. You can use Macros Mode to set up controls for parameters that might not be shown in
a particular mode, or set up controls with multiple parameters across different modes for expressive
performances.

To enter Macros Mode, press Menu, and then tap Macros.

Hype Chords  Hype (Osc Mix) 50% &

+

PARAMETER RANGE |

CONTROL INPUT Linear

50%

CROSSFADER PAD GRID ENV FOLLOWER

Use the tabs at the bottom of the screen to select a control to assign parameters to:
Knobs
Crossfader
XY Pad
Pad Grid
Env Follower

Click on the links above to jump to that section.

The left side of the screen shows the selected control. Use the Mode field to switch between the different modes for
each control. Some Modes cannot be edited using Macros mode, but you can view their assignments here.

The right side of the screen shows the parameters assigned to the selected controls, and the tools for adding and
editing these parameters.
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Learning Macro Assignments

Hype (Osc Mix) MOMENTA w00

RANGE
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TRIGGER

PARAMETER RANGE
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CROSSFADER PAD GRID ENV FOLLOWER

To learn parameters to a Macro control in user assignable modes:

1. Select a macro control type by tapping one of the buttons at the bottom of the screen: Knob, Crossfader, XY
Pad, Pad Grid or Env Follower. See the following sections for more information on each control type.

2. Select the desired mode for the control by using the Mode field at the top of the screen. See each following
section for explanation of the available modes for each control in Macros mode.

3. When one of these editable modes is selected, the yellow Learn button and the learn add (+) button will appear
on the screen.

To learn a single parameter to the control, tap the yellow Learn button so it is highlighted. The OLED screen
above the selected knob will show LEARNING....

4. Next, navigate to the mode that displays the parameter you would like to learn, and then adjust that parameter.
The screen will show a message, "Learned [parameter] to [macro control]."

5. To lock in the assignment, return to Macros mode and tap the yellow Learn button again. The assigned
parameters will be shown when the macro control is selected.

To learn multiple parameters to a macro, simply navigate to more parameters while Learn is engaged (step 4).

To learn another parameter to a macro that replaces the previous parameter, tap the down arrow next to the
yellow Learn button, and then uncheck the Add box. Repeat the steps above to replace the previously learned
parameter with a new one.

To learn a new parameter while also setting it to a range of values, tap the down arrow next to the yellow Learn
button, and then check the Range box. While Learn is engaged (step 4 above), adjust the parameter to the low and high
points of the value range that you want to control. When the assignment is locked in, the macro will control the
parameter in the set value range.

To use a single macro to, for example, mute/unmute multiple tracks at the same time, tap the down arrow next to
the yellow Learn button, and then check the Toggle box. Repeat the steps above to learn a parameter, which will
toggle on/off when the control is touched or moved.

To use a macro to send the max value of a parameter, tap the down arrow next to the yellow Learn button, and
then check the Trigger box. Repeat the steps above to learn a parameter, which will send its maximum value when the
control is touched or moved.
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PARAMETER

None

Mixer

Edit

Insert 1

Copy Existing Macro

Alternatively, you can add parameters by tapping the learn add (+) button, and then using the menu that appears to
select a parameter from your project. The following parameters are available, depending on the selected Mode and the

tracks in your project:

When an Audio Track is selected:
Mixer: Volume, Pan, Mute, Solo, Send 1-4

Insert 1-4: Available parameters depending on the effect

When a Drum Track is selected, and Parameter is set to Track:
Mixer: Volume, Pan, Mute, Solo, Send 1-4
Edit: Master Semi Tune, Master Fine Tune

Insert 1-4: Off, other available parameters depending on the effect

When a Drum Track is selected, and Parameter is set to Pad:

Mixer: Pan, Level, Send 1-4, Pad Mute, Pad Solo

Edit:
Tuning Amp Env Sustain Layer Semi Tune (1-4) LFO to Amp Velocity to Pan
Filter Cutoff Filter Env Attack Layer Fine Tune (1-4)  LFO to Pan Layer Direction (1-4)
Filter Resonance Filter Env Hold Velocity to Start LFO Wave Layer Offset (1-4)
Filter Env Amount Filter Env Decay Vel to Filter Attack LFO Rate
Amp Env Attack  Filter Env Sustain Velocity to Env Amount LFO Sync
Amp Env Decay  Filter Env Release Velocity to Filter Velocity to Pitch
Amp Env Release Layer Level (1-4) LFO to Pitch Vel to Volume Attack
Amp Env Hold Layer Sample Pan (1-4) LFO to Filter Velocity to Amp

Insert 1-4: Off, other available parameters depend on the effect

When a Keygroup Track is selected, and Parameter is set to Track:
Mixer: Volume, Pan, Mute, Solo, Send 1-4
Edit: Master Semi Tune, Master Fine Tune

Insert 1-4: Available parameters depending on the effect
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When a Keygroup Track is selected, and Parameter is set to Keygroup:
Mixer: Pan, Level, Send 1-4, Pad Mute, Pad Solo

Insert 1-4: Available parameters depending on the effect

When a Plugin Track is selected:
Mixer: Volume, Pan, Mute, Solo, Send 1-4
Track: Available parameters depending on the plugin

Insert 1-4: Available parameters depending on the effect

When a MIDI Track is selected:
MIDI CC: Standard MIDI control change assignments

When a CV Track is selected:
Edit: CV Out 1-4

When a Return is selected, the following options are available:
Mixer: Volume, Pan, Mute

Insert 1-4: Available parameters depend on the effect

When a Submix is selected, the following options are available:
Mixer: Volume, Pan, Mute

Insert 1-4: Available parameters depend on the effect

When a Master is selected, the following options are available:
Mixer: Volume, Pan, Mute

Insert 1-4: Available parameters depend on the effect

To copy an existing macro assignment:
1. Tap the learn add (+) button to open the parameter menu.
2. Select Copy Existing Macro.
3. To replace the current macro settings with the copied macro settings, select Replace.
4. To merge the current macro settings with the copied macro settings, select Merge.
5. Use the menu to select the existing macro you would like to copy.

Note that you can copy between different macro control types, such as knobs and crossfader.
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Tap the Momentary button to turn momentary behavior on or off.

When on, moving the knob will adjust its parameter, but the parameter will immediately return to its original position
(when you turned Momentary on) when you release the knob.

When off, moving the knob will adjust its parameter, and the parameter will remain at its new setting when you release
the knob.

Tap the arrow next to the Momentary to adjust additional settings for when the macro control is released:
To revert the macro parameter(s) to its minimum value on release, check the Go to Minimum box.

To revert to the last value state before the macro was changed on release, check to Go to Previous box.

To rename a macro, tap the keyboard icon in the toolbar, and then use the keyboard to enter a new name.
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Editing Macro Assignments
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Above the Macro control tabs on the right side of the touchscreen, the collapsible parameter inspector displays the
settings for the currently selected learned parameter assignment. These settings can be edited for further customization
of the macro.

To edit the parameters assigned to a macro:
1. Tap the macro control on the left side of the screen, or touch or move the control on the Force, to select it.
2. Tap the learned parameter that you would like to adjust on the left side of the screen so it is highlighted gray.

3. Use the parameter inspector to view and adjust the settings for the assignment. Tap the arrow to view
additional settings.

To reverse the polarity of the knob, tap the Flip button.
To adjust the minimum and maximum values sent by the knob, use the two Parameter Range knobs.

To set the response curve of the macro, use the Control Input field to select Linear, Logarithmic or
Exponential. Use the knobs next to this field to set the percentage of the control that will be active.

To adjust the behavior of the macro, use the Toggle selector. When set to Off, moving the control sends
a continuous range of values. When set to Toggle, moving the control toggles between the minimum and
maximum values set above. When set to Trigger Max, moving the control always send the maximum value.

To remove a parameter assignment, tap the trash can icon. If all parameters are removed, the macro will no longer
appear.

You can also quickly edit macro controls using the hardware Edit Buttons:
To edit an existing macro, press and hold the Edit button and then select the macro.

To copy and existing macro to a new macro, press and hold Copy to copy the source macro. Then, tap or press
the control where you would like to paste the macro assignment.

To delete an existing macro, press and hold Delete and tap or press the macro control.
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Knobs

In this tab, you can view and/or edit Knob macro assignments, depending on the Mode selected.

Hype Oscin)
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To enter Knobs mode, do either of the following:
e In Macros Mode, tap the Knobs button at the bottom of the screen.
e Press and hold Edit and then tap a knob.

To select a mode for the knobs, use the Mode field at the top of the display to select one of the following options:

Volume: In this mode, the knobs are fixed to control track volume.

Volume Audio 001 (Volume)

Kick Loop Volume

-1085d8  -7.30d8

-293d8  -249d8  -218dB

CROSSFADER PAD GRID ENV FOLLOWER

Pan: In this mode, the knobs are fixed to control track panning.

Kick Loop (Pan)

Kick Loop

@

CROSSFADER PAD GRID ENV FOLLOWER
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Send 1-4: In these modes, the knobs are fixed to control track
send level.

Kick Loop (Send 1)

Kick Loop

-INF dB -INF dB -INF dB

-INF d8 -INF dB -INF dB

CROSSFADER PAD GRID ENV FOLLOWER

Project 1—2:_Iq these edit moc_:les, the knobs can control 16 o T | ]
parameters within the current project overall.

SFX c | |

To learn a project parameter to a knob, follow the
directions above. Any available parameter, including Track,
Pad, Keygroup, Insert, Return, Submix or Master parameters,
can be selected as part of a macro control.

To edit a learned parameter, follow the directions above.

PARAMETER RANGE

CROSSFADER XY PAD PAD GRID ENV FOLLOWER

Track: In this edit mode, the knobs can control 16 track = = 1 |
parameters.

Hype Chords  Hype (Osc Mix) 50% ]

To learn a track parameter to a knob, follow the directions
above. Only parameters for the current track, any Pads or
Keygroups on the current track, or any Inserts on the current
track can be selected as part of a macro control. This does
not include Return, Submix or Master parameters.

4

PARAMETER RANGE Fup

To edit a learned parameter, follow the directions above.

CONTROL INPUT Linear

50% C

CROSSFADER XY PAD PAD GRID ENV FOLLOWER

Track FX Rack: In this edit mode, the knobs can control 16 FX
Rack parameters. The assignments can be saved as part of an FX [EESsEs S (o B [ B
RaCk preset. ClassicBass  AIREnsemble (Depth)  6.00 ms ]

4

To learn a track FX rack parameter to a knob, follow the
directions above. Only parameters available in the currently
selected track's Insert effects can be selected as part of a
macro control.

To edit a learned parameter, follow the directions above.

PARAMETER RANGE

CROSSFADER XY PAD PAD GRID ENV FOLLOWER

MIDI: In this mode, the knobs are fixed to a selection of MIDI
performance controls, allowing you to control modulation, pitch
bend, sustain and other common MIDI messages as you play. lassicBass  Plchoend

Classic Bass (Pitchbend)

)

CROSSFADER PAD GRID ENV FOLLOWER
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Screen: In this mode, the knobs are fixed to control a parameter
or group of parameters in your currently selected mode (e.g., Pad
Mixer, Sample Edit Mode, etc.).

Screen

CROSSFADER PAD GRID ENV FOLLOWER

At any time, in any mode, you can show the Knobs window over the screen’s current contents. This lets you quickly
select between the knob modes.

To show the Knobs window, press and hold the Knobs button.

To select a knob mode, tap the respective icon: Volume, Pan, Sends 1-4, Project 1-2, Track, Track FX Rack,
MIDI or Screen.

To close the Knobs window, release the Knobs button.
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Crossfader

In the Crossfader tab, you can learn any automation parameter from within your project to Force's Crossfader.

Crossfader 1 vacro

AIR Delay (Feedback) 40%

Pan C

PARAMETER RANGE \
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CROSSFADER PAD GRID ENV FOLLOWER

To enter Crossfader mode, do either of the following:
e In Macros Mode, tap the Crossfader button at the bottom of the screen.

e Press and hold Edit and then press Assign A or Assign B.

There are 16 available crossfader scenes, which can be selected using the Mode field at the top left of the screen. Each
scene can be assigned to one or more parameters.

To change crossfader scenes directly from the hardware, press and hold Assign A and then press Assign B to
move to the next scene. To move to the previous scene, press and hold Assign B and then press Assign A.

To learn a parameter to the crossfader:
1. Make sure Force is not currently in playback.

2. Select the parameter you would like to assign to the crossfader. Any available parameter, including Track, Pad,
Keygroup, Insert, Return, Submix or Master parameters, can be selected as part of a macro control.

3. Hold down either the Assign A or Assign B buttons on Force, and then move any parameter on the touchscreen.
When holding Assign A, the parameter will be assigned to the crossfader with the minimum value to the left side
and the maximum value to the right side. When holding Assign B, the parameter will be reversed with the maximum
value on the left side and the minimum value on the right side.

To edit the crossfader assignment, press and hold Edit and then press Assign A or Assign B. This will take you to
the Crossfader tab of the Macros page, where you can use the instructions above to edit the assignment.
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XY Pad

In the XY Pad tab, you can learn any automation parameter from within your project to one of four assignable XY Pads.

To cycle between the four available XY Pad assignments, tap the XY Pad tab.
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Use the Mode field at the top left of the touchscreen to select the part of the XY Pad that you would like to assign
parameters to. This functions like a collection of different macros, allowing you to assign parameters to the X-Axis, Y-
Axis, Columns 1-8, Rows 1-8, or even different to the axes of the Quadrants in the XY Pad.

FULL SCREEN MOMENTARY v LEARN -

CROSSFADER PAD GRID ENV FOLLOWER

Use the Full Screen button to make the current XY Pad fill the entire screen.

To learn a parameter to the XY Pad, follow the directions above.
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Pad Grid

In the Pad Grid tab, you can learn any automation parameter from within your project to Force's pad matrix. Assigning
automation parameters to the pads gives you a more performative way of controlling effects and mixer parameters. For
example, you can assign a pad to mute a group of tracks, or to toggle insert effects on and off.
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Use the Mode field at the top left of the touchscreen to select the pad Bank to assign parameters to.

Use the Full Screen button to make the current pad Bank fill the entire screen.

To access the Pad Grid macros directly from the hardware, do any of the following:

¢ Press and hold the Knobs button, and then press the Launch/Config button to split the pad matrix between
launching clips and triggering the Pad Grid macros.

e Press and hold the Knobs button, and then press the Notes/Config button to split the pad matrix between
playing notes and triggering the Pad Grid macros.

¢ Press and hold the Knobs button, and then press the Launch/Config and Notes/Config buttons at the same
time to split the pad matrix between launching clips in the top quadrants and playing notes and triggering the
Pad Grid macros in the bottom quadrants.

When the Pad Grid macros are active in the pad matrix, you can use the Edit buttons to edit, copy and delete macros
from these controls directly from the hardware.

To learn a parameter to the pad grid, follow the directions above.
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Env Follower

In the Env Follower tab, you can use an audio signal (such as a kick drum) as a control signal to create side-chain or
modulation effects.

Envelope Follower 1 n Hype Chords (AIR D:

Kick Loop
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There are 16 available envelope followers, which can be selected using the Mode field at the top left of the touchscreen.

Tap the On button next to the Mode field to enable or disable the envelope.

Use the Envelope Source field to select the audio signal that will be used as the control signal for the envelope. This
can be audio from a track, or, if you choose a Drum track, audio from a specific pad. You can also select the Returns,
Submixes, and Master tracks, as well as dedicated LF